Products in object code format, but does not include, and this Agreement does not address, any third-party or free or open source software separately licensed to you ("Third Party Software"). If you do not agree to this Agreement, you shall promptly return the System with a dated receipt to the seller for a full refund.

2. LICENSE: Subject to the terms and conditions of this Agreement (including payment), we hereby grant you a nonexclusive, nontransferable license to use the object code version of the Software embedded into, provided solely for use with or loaded onto the Product, and the accompanying documentation ("Documentation") for your internal business purposes. The Software and any authorized copies are owned by us or our suppliers, and are protected by law, including without limitation the copyright laws and treaties of the U.S.A. and other countries. Evaluation versions of the Software may be subject to a time-limited license key.

3. RESTRICTIONS: You (and your employees and contractors) shall not attempt to reverse engineer, disassemble, modify, translate, create derivative works of, rent, lease (including use on a timesharing, applications service provider, service bureau or similar basis), loan, distribute, sublicense or otherwise transfer the System, in whole or part except to the extent otherwise permitted by law. The Software may be operated on a network only if and as permitted by its Documentation. You may make one (1) back up copy of the object code of the Software for archival purposes only. Evaluation Software will be run in a lab, nonproductive environment. Results of any benchmark or other performance tests may not be disclosed to any third party without our prior written consent. Title to and ownership of the Software and Documentation, and all copyright, patent, trade secret, trademark, and other intellectual property rights in the System, shall remain our or our licensors’ property. You shall not remove or alter any copyright or other proprietary rights notice on the System. We reserve all rights not expressly granted.

4. LIMITED WARRANTY: (a) Limited Warranty. We warrant to you that, commencing on your receipt of a Product and terminating 1 year thereafter, the System will perform substantially in accordance with its then-current appropriate Documentation. The Product (including replacement) may consist of new, used or previously-installed components. (b) Remedies. If the System fails to comply with such warranty during such period, as your sole remedy, you must return the same in compliance with our product return policy, and we shall, at our option, repair or replace the System, provide a workaround, or refund the fees you paid. Replacement Systems are warranted for the original System’s remaining warranty period. (c) Exclusions. EVALUATION SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND SUBJECT TO (i) without limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia and that you are not otherwise prohibited under the Export Laws from receiving the System; or (iv) required by law to be disclosed.

5. LIABILITY: WE AND OUR AFFILIATES, SUPPLIERS, LICENSORS, OR SALES CHANNELS (“REPRESENTATIVES”) SHALL NOT BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE, OR EXEMPLARY DAMAGES OF ANY KIND, INCLUDING BUT NOT LIMITED TO LOST REVENUES, PROFITS OR SAVINGS, OR THE COST OF SUBSTITUTE GOODS, HOWEVER CAUSED, UNDER CONTRACT, TORT, BREACH OF WARRANTY, NEGLIGENCE, OR OTHERWISE. EVEN IF WE WERE ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGES. NOTwithstanding ANY OTHER PROVISIONS OF THIS AGREEMENT, WE AND OUR REPRESENTATIVES’ TOTAL LIABILITY TO YOU ARISING FROM OR RELATING TO THIS AGREEMENT OR THE SYSTEM SHALL BE LIMITED TO THE TOTAL PAYMENTS TO US UNDER THIS AGREEMENT FOR THE SYSTEM. THE FOREGOING LIMITATIONS SHALL NOT APPLY TO DEATH OR PERSONAL INJURY TO PERSONS OR TANGIBLE PROPERTY IN ANY JURISDICTION WHERE APPLICABLE LAW PROHIBITS SUCH LIMITATION. YOU ARE SOLELY RESPONSIBLE FOR BACKING UP YOUR DATA AND FILES, AND HEREBY RELEASE US AND OUR REPRESENTATIVES FROM ANY LIABILITY OR DAMAGES DUE TO THE LOSS OF ANY SUCH DATA OR FILES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SUCH EXCLUSIONS MAY NOT APPLY TO YOU.

6. CONFIDENTIALITY: Information in the System and the associated media, as well as the structure, organization and code of the Software, are proprietary to us and contain valuable trade secrets developed or acquired at great expense to us or our suppliers. You shall not disclose to others or utilize any such information as expressly provided for herein, except for information (i) lawfully received by the user from a third party which is not subject to confidentiality obligations; (ii) generally available to the public without breach of this Agreement; (iii) lawfully known to the user prior to its receipt of the System; or (iv) required by law to be disclosed.

7. SUPPORT: Updates, upgrades, fixes, maintenance or support for the System (an “Upgrade”) after the limited warranty period may be available at separate terms and fees from us. Any Upgrades shall be subject to this Agreement, except for additional or inconsistent terms we specify. Upgrades do not extend the limited warranty period.

8. TERM; TERMINATION: The term of this Agreement shall continue unless terminated in accordance with this Section. We may terminate this Agreement at any time upon default by you of the license provisions of this Agreement, or any other material default by you of this Agreement not cured with thirty (30) days after written notice thereof. You may terminate this Agreement any time by terminating use of the System. Except for the first sentence of Section 2 (“License”) and for Section 4(a) (“Limited Warranty”), all provisions of this Agreement shall survive termination of this Agreement. Upon any such termination, you shall certify in writing such termination and non-use to us.

9. EXPORT CONTROL: You agree that the Products and Software will not be shipped, transferred, or exported into any country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions, or regulations (the “Export Laws”). You will indemnify, defend and hold us harmless from any claims arising out of or relating to Products or Software sold to you. The Software and all items under the Export Laws, you represent and warrant that you are not a citizen, or otherwise located within, an embargoed nation (including without limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia) and that you are not otherwise prohibited under the Export Laws from receiving the Software. All rights to the Products and Software are granted on condition that such rights are forfeited if you fail to comply with the terms of this Agreement.

10. U.S. GOVERNMENT RIGHTS: The Software and the documentation which accompanies the Software are “Commercial Items,” as that term is defined at 48 C.F.R. §2.101, consisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government as end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users pursuant to the terms and conditions herein. Harmonic, 4300 North First Street, San Jose, CA 95134 U.S.A.

11. GENERAL: You shall not assign, delegate or sublicense your rights or obligations under this Agreement, by operation of law or otherwise, without our prior written consent, and any attempt without such consent shall be void. Subject to the preceding sentence, this Agreement binds and benefits permitted successors and assigns. This Agreement is governed by California law, without regard to its conflicts of law principles. The U.N. Convention on Contracts for the International Sale of Goods is disclaimed. If any claim arises out of this Agreement, the parties hereby submit to the exclusive jurisdiction and venue of the federal and state courts located in Santa Clara County, California. In addition to any other rights or remedies, we shall be entitled to injunctive and other equitable relief, without posting bond or other security, to prevent any material breach of this Agreement. We may change the terms, conditions and pricing
relating to the future licensing of our Systems and other intellectual property rights, including this Agreement, from time to time. No waiver will be implied from conduct or failure to enforce rights nor effective unless in a writing signed on behalf of the party against whom the waiver is asserted. If any part of this Agreement is found unenforceable, the remaining parts will be enforced to the maximum extent permitted. There are no third-party beneficiaries to this Agreement. We are not bound by additional and/or conflicting provisions in any order, acceptance, or other correspondence unless we expressly agree in writing. This Agreement is the complete and exclusive statement of agreement between the parties as to its subject matter and supersedes all proposals or prior agreements, verbal or written, advertising, representations or communications concerning the System.

Every reasonable attempt has been made to comply with all licensing requirements for all components used in the system. Any oversight is unintentional and will be remedied if brought to the attention of Harmonic at support@harmonicinc.com.

Documentation Conventions

This guide may use some special symbols and fonts to call your attention to important information. The following symbols appear throughout this guide:

**DANGER:** The Danger symbol calls your attention to information that, if ignored, can cause physical harm to you.

**CAUTION:** The Caution symbol calls your attention to information that, if ignored, can adversely affect the performance of your Harmonic product, or that can make a procedure needlessly difficult.

**LASER DANGER:** The Laser symbol and the Danger alert call your attention to information about the lasers in this product that, if ignored, can cause physical harm to you.

**NOTE:** The Note symbol calls your attention to additional information that you will benefit from heeding. It may be used to call attention to an especially important piece of information you need, or it may provide additional information that applies in only some carefully delineated circumstances.

**IMPORTANT:** The Important symbol calls your attention to information that should stand out when you are reading product details and procedural information.

**TIP:** The Tip symbol calls your attention to parenthetical information that is not necessary for performing a given procedure, but which, if followed, might make the procedure or its subsequent steps easier, smoother, or more efficient.

In addition to these symbols, this guide may use the following text conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typed Command</td>
<td>Indicates the text that you type in at the keyboard prompt.</td>
</tr>
<tr>
<td><code>&lt;Ctrl&gt;</code>, <code>&lt;Ctrl&gt;+&lt;Shift&gt;</code></td>
<td>A key or key sequence to press.</td>
</tr>
<tr>
<td><strong>Links</strong></td>
<td>The <em>italics in blue</em> text to indicate Cross-references, and hyperlinked cross-references in online documents.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Indicates a button to click, or a menu item to select.</td>
</tr>
<tr>
<td><strong>ScreenOutput</strong></td>
<td>The text that is displayed on a computer screen.</td>
</tr>
<tr>
<td><strong>Emphasis</strong></td>
<td>The <em>italics</em> text used for emphasis and document references.</td>
</tr>
</tbody>
</table>

**NOTE:** You require Adobe Reader or Adobe Acrobat version 6.0 or later to open the PDF files. You can download Adobe Reader free of charge from www.adobe.com.
# Contents

**Introduction** .................................................................................................................. 9

Spectrum System Documentation Suite .............................................................................. 9
  Locating the Latest Documentation on the Harmonic Website .................................. 9
  Technical Support ........................................................................................................... 11
  Useful Information when Contacting Technical Support ............................................. 11

**Chapter 1: Spectrum MediaDeck 7000** ............................................................................ 13

  Replacing the Bezel .......................................................................................................... 13
  Replacing a Disk Drive ...................................................................................................... 14
    Removing the Disk Drive ................................................................................................. 17
    Installing the new Disk Drive ......................................................................................... 17
  Replacing a Power Supply ................................................................................................. 18
  Replacing a MediaPort Module or a ChannelPort Module .................................................. 20
    Stopping Players that Use the Module to be Replaced .................................................. 20
    Verifying Which Module to Remove ............................................................................. 20
    Removing the MediaPort Module .................................................................................. 21
    Installing the New Module ............................................................................................ 22
  Replacing the Chassis ........................................................................................................ 23
    Record Your MediaDeck Settings .................................................................................. 24
    Install the Replacement MediaDeck ............................................................................. 24
    Configure Your New MediaDeck .................................................................................. 29
    Verifying Functionality ................................................................................................. 29

**Chapter 2: Spectrum MediaDeck 7000 with MediaDeck 7000 Management** .................... 30

  Overview ......................................................................................................................... 30
  Replacing a Drive with MediaDeck 7000 Management .................................................... 30
    Gathering Information for Technical Support ............................................................... 30
    Checking SSD Life Expectancy ..................................................................................... 31
    Replacing a Drive ........................................................................................................... 31
    Removing the Drive ...................................................................................................... 32
    Installing the New Drive ............................................................................................... 32
  Replacing a MediaPort or ChannelPort Module with MediaDeck 7000 Management ....... 33
    Recording Player and Channel Settings ....................................................................... 34
    Deactivating Players ...................................................................................................... 34
    Verifying Which Module to Remove ............................................................................. 34
    Replacing the Module ................................................................................................. 35
    Configuring Players and Channel Settings on the New Module .................................. 36
  Replacing the Chassis Using MediaDeck 7000 Management ............................................ 36
    Record Your MediaDeck and Player Settings ............................................................... 36
    Install the Replacement MediaDeck ............................................................................. 37
    Configure the Replacement MediaDeck ...................................................................... 37
Chapter 3: Omneon MediaDeck .......................................................... 40

Replacing the Bezel ................................................................. 40
Replacing a Disk Drive ............................................................ 41
  Removing the Disk Drive ......................................................... 43
  Installing the New Disk Drive .................................................. 44
Replacing a Power Supply ......................................................... 45
Replacing the Drive Cage .......................................................... 46
  Powering Down the Omneon MediaDeck ................................. 47
  Removing the Drive Cage ......................................................... 48
  Installing the Drive Cage ......................................................... 49
Replacing an I/O Module ............................................................ 50
  Stopping Players that Use the I/O Module to be Replaced .......... 50
  Verifying Which I/O Module to Remove ................................... 51
  Removing the I/O Module ......................................................... 51
  Installing the New I/O Module .................................................. 53
Replacing the Processor Module .................................................. 54
  Powering Down the Omneon MediaDeck ................................. 54
  Removing the Processor Module .............................................. 54
  Installing the Replacement Processor Module ......................... 56
Moving Players to the New MediaDeck in SystemManager ............ 59
Removing the Original MediaDeck from SystemManager ............ 60
Changing vDHCP Settings .......................................................... 60
Clearing Alarms ...................................................................... 61
Replacing a Processor Module Using the Same IP Addresses ....... 61
Replacing the Chassis ............................................................... 62
  Powering Down the Omneon MediaDeck ................................. 62
  Removing the Omneon MediaDeck Chassis .............................. 62
  Installing the Omneon MediaDeck Chassis .............................. 62
  Verifying Functionality ............................................................ 63

Chapter 4: Spectrum MediaDirector 2252/2251............................... 64

Replacing the Bezel .................................................................. 64
Replacing a Power Supply ......................................................... 64
Replacing the Chassis ............................................................... 65
  Record Your MediaDirector Settings ........................................ 65
  Install the Replacement MediaDirector .................................... 65
  Verifying Functionality ............................................................ 70

Chapter 5: Spectrum MediaDirector 2202/2201............................... 71

Replacing the Bezel .................................................................. 71
Replacing a Power Supply ......................................................... 71
Replacing the Chassis ............................................................... 72
  Record Your MediaDirector Settings ........................................ 72
  Install the Replacement MediaDirector .................................... 72
  Verifying Functionality ............................................................ 77

Chapter 6: Spectrum MediaCenter ..................................................... 78
Contents

Replacing the Bezel .......................................................... 78
Replacing a Disk Drive .................................................... 79
  Removing the Disk Drive ................................................. 82
  Installing a New Disk Drive .......................................... 82
Replacing a Power Supply ................................................ 84
Replacing a Fan .............................................................. 85
  Removing the Top Cover of the MediaCenter ..................... 85
  Removing the Fan ........................................................ 86
  Installing the New Fan ................................................ 86
Replacing a MediaCenter .................................................. 87
  Record Your MediaCenter Settings ................................ 87
  Install the Replacement MediaCenter .............................. 88
  Configure Your New MediaCenter Settings ......................... 92
  Verifying Functionality ............................................... 92

Chapter 7: Spectrum MediaDirector 2100, 2101, 2102, 2101B ..... 93
Replacing a MediaDirector 2100, 2101, 2102 or 2102B .......... 93

Chapter 8: Spectrum MediaStore 5000 Series ......................... 100
Replacing the Power Cooling Module ................................ 100
Replacing an I/O Module .................................................. 101
Replacing a Disk Drive .................................................... 102
Replacing the Chassis ...................................................... 106
  Install the Replacement MediaStore 5000 Chassis .......... 106
  Verifying Functionality .............................................. 107

Chapter 9: Spectrum MediaStore 4000 Series ......................... 108
Replacing the Power Supply .............................................. 108
Replacing an LRC I/O Module .......................................... 109
Replacing a Disk Drive .................................................... 109
Replacing the Chassis ...................................................... 113
  Install the Replacement MediaStore 4000 Chassis .......... 113
  Verifying Functionality .............................................. 114

Chapter 10: Spectrum MediaPort 7000 ................................. 115
Replacing the Bezel ......................................................... 115
Replacing the Power Supply .............................................. 116
Replacing a MediaPort Module or a ChannelPort Module .... 117
  Stopping Players that Use the Module to be Replaced .... 118
  Verifying Which Module to Remove .............................. 118
Replacing the Chassis ...................................................... 121
  Stopping Players that Use the MediaPort to be Replaced ... 121
  Removing the MediaPort from SystemManager .............. 122
  Removing the MediaPort From the Rack ....................... 122
  Installing the Replacement MediaPort ......................... 122
  Changing the MediaPort Name in SystemManager .......... 123
  Upgrading MediaPort Firmware .................................. 123
  Attaching the MediaPort to the Existing Players .......... 123
Activating Players ................................................................. 124
Verifying Functionality ...................................................... 124

Chapter 11: Spectrum MediaPort 5000 ................................. 125
Replacing the MediaPort ...................................................... 125
Stopping Players that Use the MediaPort to be Replaced ....... 125
Verifying Which MediaPort to Remove ................................. 125
Removing the MediaPort from SystemManager .................. 126
Removing the MediaPort From the Rack ................... 127
Installing the Replacement MediaPort ................................. 127
Changing the MediaPort Name in SystemManager ............... 127
Upgrading MediaPort Firmware ........................................... 127
Attaching the MediaPort to the Existing Players ................. 127
Activating Players .............................................................. 128
Verifying Functionality ...................................................... 128

Chapter 12: Spectrum MediaPort 4010 ................................. 129
Replacing the MediaPort ...................................................... 129
Stopping Players that Use the MediaPort to be Replaced ....... 129
Verifying Which MediaPort to Remove ................................. 129
Removing the MediaPort from SystemManager .................. 130
Removing the MediaPort From the Rack ................... 130
Installing the Replacement MediaPort ................................. 131
Changing the MediaPort Name in SystemManager ............... 131
Upgrading MediaPort Firmware ........................................... 131
Attaching the MediaPort to the Existing Players ................. 131
Activating Players .............................................................. 132
Verifying Functionality ...................................................... 132

Appendix A: Contacting the Technical Assistance Center ......... 133
Appendix B: Safety and Regulatory Compliance Information ..... 135
Important Safety Instructions .............................................. 135
Introduction

This document provides component replacement instructions for the following devices:

- Spectrum MediaDeck 7000
- Spectrum MediaDeck 7000 with MediaDeck 7000 Management
- Omneon MediaDeck
- Spectrum MediaDirector 2252/2251
- Spectrum MediaDirector 2202/2201
- Spectrum MediaCenter
- Spectrum MediaStore 5000 Series
- Spectrum MediaStore 4000 Series
- Spectrum MediaPort 7000
- Spectrum MediaPort 5000
- Spectrum MediaPort 4010

Spectrum System Documentation Suite

The table below describes the documents which comprise the Spectrum System Documentation Suite.

<table>
<thead>
<tr>
<th>Spectrum (MediaDirector 2201/2202, MediaDirector 2251/2252, MediaCenter, MediaPort 5000, MediaPort 7000, ChannelPort)</th>
<th>This document...</th>
<th>Provides this information...</th>
</tr>
</thead>
</table>
| Spectrum System Installation and Hardware Reference Guide | | • System installation  
• Software installation and upgrade details  
• Orientation to system components including MediaDirectors, MediaCenters, MediaPorts, ChannelPorts, and MediaStores  
• Troubleshooting system components  
• Specifications for system components |
| Spectrum System Protocol Reference Guide | | • Command sets and preroll parameters for controlling MediaDirectors  
• The Harmonic implementation of FTP server |
| Spectrum Quick Reference Guides | | • Front and back panel views of Spectrum devices  
• LED assignments and legends |
| Spectrum ChannelPort Template Authoring Guide | | ChannelPort template authoring |
| Spectrum ChannelPort Tools User Guide | | Using ChannelPort tools |
| Spectrum Onboard Playout Control and PlayoutTool User Guide | | • Onboard Playout Control Overview  
• Using PlayoutTool |
<table>
<thead>
<tr>
<th>Spectrum Component Replacement Guide</th>
<th>Component replacement instructions for all Spectrum devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spectrum and MediaDeck Release Notes</td>
<td>Last minute information regarding a product release</td>
</tr>
</tbody>
</table>

### Spectrum MediaDeck 7000

<table>
<thead>
<tr>
<th>This document...</th>
<th>Provides this information...</th>
</tr>
</thead>
</table>
| Spectrum System Installation and Hardware Reference Guide | - System installation  
- Upgrade instructions  
- Orientation to system components |
| Spectrum MediaDeck 7000 Installation Guide | System installation |
| Spectrum and MediaDeck Release Notes | Last minute information regarding a product release |
| Spectrum MediaDeck 7000 Read Me First | - Passwords for downloading MediaDeck and SystemManager files  
- Instructions for obtaining and installing the license file for SystemManager  
- Installation overview |

### Spectrum (MediaDirector 2100, 2101, 2102, 2102B, MediaPort 1000, 3000, 4000, 6000 Series)

<table>
<thead>
<tr>
<th>This document...</th>
<th>Provides this information...</th>
</tr>
</thead>
</table>
| Omneon Spectrum System Getting Started Guide | - System installation  
- Software installation and upgrade details |
| Omneon Spectrum System Hardware Orientation Guide | - Orientation to system components including MediaPorts, and MediaStores  
- Troubleshooting system components  
- Specifications for system components |
| Omneon Spectrum System Protocol Reference Guide | - Command sets and preroll parameters for controlling MediaDirectors  
- The Harmonic implementation of FTP server |
| Spectrum Quick Reference Guides | - Front and back panel views of Spectrum devices  
- LED assignments and legends |

### Omneon MediaDeck

<table>
<thead>
<tr>
<th>This document...</th>
<th>Provides this information...</th>
</tr>
</thead>
</table>
| Omneon MediaDeck User Guide | - System installation  
- Upgrade instructions  
- Orientation to system components |
| Omneon MediaDeck Installation Guide | System installation |
| Spectrum and MediaDeck Release Notes | Last minute information regarding a product release |
| Omneon MediaDeck Read Me First | - Passwords for downloading MediaDeck and SystemManager files  
- Instructions for obtaining and installing the license file for SystemManager  
- Installation overview |
All items are packaged in self-extracting files and available for download from the Harmonic FTP site at the following location: ftp://ftp.omneon.com//updates/omneon/Current/Spectrum/

- **Release Notes**: Spectrum_v.x.x.x_ReleaseNotes.pdf
- **All other components of the Spectrum System Documentation Suite**: MediaDeckAndSpectrum-v.x.x.x-Documentation.exe
- **For ChannelPort templates, tools, and documentation, as well as Onboard Playout Control tools and documentation**: ChannelPortTemplatesAndTools-v.x.x.x-SWandDoc.exe.


For the SystemManager documentation, navigate to: ftp://ftp.omneon.com//updates/omneon/current/SystemManager

SystemManager documents are packaged SystemManager-v.x.x.x-Documentation.exe.

Acrobat® Reader® is needed to view the product documentation. Download this for free from: http://www.adobe.com

All files on the Support Server are password protected. Contact Harmonic Technical Support if you need assistance with unlocking the files.

**Locating the Latest Documentation on the Harmonic Website**

The latest documentation can be found at http://www.harmonicinc.com/documents-detail.

**Technical Support**

For information on contacting Harmonic Technical Support, refer to Appendix A, Contacting the Technical Assistance Center.

**Useful Information when Contacting Technical Support**

In order to assist Harmonic Technical Support, review the following information:

- **What version of firmware is installed on your system?**

  From the Home tab, click the Upgrade Firmware icon in the left-hand column to display the Upgrade Firmware page. The firmware version for each device is shown in the Current Firmware Version column.

- **What version of SystemManager software is installed?**

  From SystemManager, click the Help tab. The version is shown in the Server Software section of the page.

- **Which Windows operating system is running on the SystemManager client PC?**
  a. From Windows, click the Start button, and then click Run.
  b. In the Open field, type: winver, and then press Enter to open the About Windows dialog box, which shows the version number.

- **How much memory is installed on the SystemManager platform? (for example, 256 MB, 512 MB, or 1 GB)**
  a. From Windows, click the Start button, and then click Run.
b. In the **Open** field, type: winver and then press **Enter** to open the **About Windows** dialog box. Look for the line that reads, “Physical memory available to Windows.”

**Please provide the manager.oda file from the SystemManager platform or client PC**

Harmonic Technical Support may request that you email the manager.oda file, which contains configuration information for your system. This file is located on the SystemManager platform at D:\Omneon\Manager\omdb, or if you are using a client PC with a single C: partition, it will be in the same directory on the C: drive.

**What is the model and serial number of the hardware involved?**

- For Spectrum and MediaDeck devices: from the **Home** tab, click the **Upgrade Firmware** icon in the left-hand column to display the **Upgrade Firmware** page. Both MediaDirectors and MediaDecks are listed in the **MediaDirectors** section. Find the Model Numbers and Serial Numbers listed in their respective columns.
  
  Scroll down to the **MediaPorts** section to view the Model Numbers and Serial Numbers for MediaPorts and MediaDeck Modules.

- For Harmonic MediaGrid Devices: Click the **Servers & Switches** icon in the left-hand column. From the Servers and Switches page, in the **Name** column, click the link for the Harmonic MediaGrid device to open the **Properties** page for that device.

- For ProXchange devices: Click the ProXchange Servers icon in the left-hand column. From the **Servers** page, in the **Name** column, click the link for the ProXchange device to open the **Properties** page for that device.

- For ProBrowse devices: Click the ProBrowse Servers icon in the left-hand column. From the **Servers** page, in the **Name** column, click the link for the ProBrowse device to open the **Properties** page for that device.

- For MAS devices: Click the MAS Servers icon in the left-hand column. From the Servers page, in the **Name** column, click the link for the MAS device to open the **Properties** page for that device.

**For Spectrum Systems**

**What is the name of the Player that is being used?**

From SystemManager, click the **Player Configuration** link in the left-hand column, and then click the name of the MediaDirector or MediaDeck. The **Player List** page for that device appears. The names and status of all players are listed.

**What file format and bit rate is the Player configured for? (for example, MPEG, DV, or IMX?)**

- From SystemManager, click the **Player Configuration** link in the left-hand column, and then click the name of the MediaDirector or MediaDeck. The **Player List** page for that device appears.

- From the player list, click the **Properties** link to view all the details for a player.

**If the problem is related to Ingest or Playout of a clip, what is the Clip ID involved?**

The clip name or clip ID should be indicated by whatever software application you are using to play or record video. For ClipTool, clip names are displayed in the clip management area of the ClipTool main window.

**What brand of Automation, if any, is being used for control?**

**Is the Automation using VDCP or API for communication control?**
The following sections provide information to help you replace components on your MediaDeck 7000.

- Replacing the Bezel
- Replacing a Disk Drive
- Replacing a Power Supply
- Replacing a MediaPort Module or a ChannelPort Module
- Replacing the Chassis

**NOTE:** The procedures in this chapter apply to MediaDeck systems managed with SystemManager. If you are using MediaDeck 7000 Management instead of SystemManager, some steps may vary. For assistance in replacing components when using MediaDeck 7000 Management, contact Harmonic Technical Support. To view the MediaDeck 7000 Management help system at any time, click the Help button in the application.

### Replacing the Bezel

This section provides instructions for replacing the front bezel of the MediaDeck 7000.

**CAUTION:** Observe all conventional ESD precautions when handling MediaDeck components. Avoid contact with backplane components and connectors.

To remove the bezel:

1. Loosen the two captive thumb screws that secure the bezel to the chassis.

![Figure 1–1: Removing the Bezel](image)

2. Pull the bezel away from the chassis.
To install the new bezel:
1. Unpack the bezel.
2. Align the bezel in front of the chassis so that the front panel display appears in the top-right corner, and the metal corners of the bezel are level with the rack ears of the chassis.
3. Keeping the corners aligned, press the bezel straight onto the chassis.
4. Hand-tighten the two captive thumb screws to secure the bezel in place.

**NOTE:** Do not overtighten the thumb screws.

---

**Replacing a Disk Drive**

This section provides instructions for replacing a Spectrum MediaDeck 7000 disk drive. The MediaDeck contains high-performance SATA disk drives and SSD drives that can be hot-swapped during operation without interrupting the use of the system.

**NOTE:** The procedure in this section applies to SystemManager version 6.1. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

In the event of disk drive failure, replacement disk drives are available from Harmonic. Refer to Technical Support for information on how to request technical support.

If you wish to install a Harmonic-supplied drive model that is not supported by your current version of Spectrum firmware, you may need to install a “DDC” configuration file to your video server, which enables you to install and use the new drive. For details, see “Installing a DDC File” in the SystemManager 6.1 User Guide.

To assist in drive problem diagnosis and remediation, please gather the following information for use by Harmonic Technical Support before you remove the failing/failed disk drive:

- Site Location
- Server Name
- Date of Failure
To view **MediaDeck Properties**, from the **System Diagram** page of the **Configuration** tab, click the icon for your MediaDeck. Then, from the **Physical Configuration** page, click the icon for your MediaDeck.

- From the **Drive Properties** page for your MediaDeck on SystemManager:
  - Disk GUID
  - Disk Serial Number
  - Disk Size (GB)

To view **Drive Properties**, from the **Configuration** tab, click **Disk Utilities**, then click the icon for your MediaDeck. From the second **Disk Utilities** page, click the icon for the drive that has failed.

- From your SystemManager Platform or client PC running SystemManager, use Windows Explorer to navigate to: `\\IPADDR\FSNAME\omD11_NNNNN\logs`
  
  `IPADDR` = IP Address or host name if using DNS
  
  `FSNAME` = File System Name
  
  `D11` = MediaDeck model type
  
  `NNNNN` = Serial number of unit

  and locate the following:
  - Badblockhistory.txt
  - syslog_D11_NNNNN_YYYYY_MM_DD_hh_mm_ss.log

  `NNNNN` = Serial number of unit

  `YYYY` = Year of log start

  `MM` = Month of log start

  `DD` = Day of log start

  `hh` = Hour of log start

  `mm` = Minute of log start

  `ss` = Second of log start

Once you obtain a Return Authorization (RA) number from Harmonic Technical Support, email a copy of these files to `omneon.support@harmonicinc.com` and quote the RA number in your email.

### Checking SSD Life Expectancy

SystemManager displays the **SSD life expectancy** for any SSD installed in a MediaDeck 7000 as a percentage. Replace the SSD by the time the life expectancy reaches 1%.
To check the SSD life expectancy in SystemManager:

1. To view Drive Properties, from the Configuration tab, click Disk Utilities, then click the icon for your MediaCenter. From the second Disk Utilities page, click the icon for the drive that you want to check.

2. The Drive Properties page will appear. SSD life expectancy is listed under Disk Statistics, as shown in Figure 1–3.

![Figure 1–3: SSD Life Expectancy](image)

CAUTION: Drive spin-down. Damage can occur to a drive if it is removed while still spinning. We recommend that you perform all steps in the following procedure. Before removing a drive from an enclosure, wait 30 seconds to ensure that the drive has stopped spinning.

To replace (hot swap) a disk drive in the MediaDeck:

1. Ensure that you have a replacement drive from Harmonic on hand.

IMPORTANT: Use ONLY Harmonic-supplied replacement disk drives. Disk drives from any other source will be excluded from coverage under the Harmonic product limited warranty and maintenance services programs. In addition, any errors or damages caused by the use of disk drives provided from any other source will cause the entire product to be excluded from coverage under the Harmonic product limited warranty and maintenance services programs.

NOTE: The drive size (in GB) and form factor must match the other drives in the enclosure. Replacement drives should have the same or greater drive capacity as those they are replacing.

2. Remove the bezel. For instructions, refer to Replacing the Bezel.

3. In SystemManager, from the Drive Properties page for the drive, click Fail drive to fail the drive.

View the Disk Utilities page for the MediaDeck to verify that the drive state is reported as Dead, Failed.

4. From the Disk Utilities page, find the physical location of the drive and note the state of the LEDs for this drive as follows:
   a. The top Activity LED should be off, indicating that the drive is not being actively used. If it is blinking, this is the wrong drive to remove.
   b. The bottom Status LED should be blinking (4 blinks per second).
5. If you identify the same drive when performing steps 4a and 4b, proceed to the next step. If not, call Harmonic Technical Support and do not continue with this procedure.
6. Wait 30 seconds before unlatching the drive at the physical location indicated in Step 4.
7. Continue to Removing the Disk Drive.

Removing the Disk Drive

To remove the disk drive:
1. Press the red release button on the right side of the disk drive to release the handle.
2. The handle will spring open.
3. Grasp the handle and pull the disk drive firmly away from the chassis, as shown in Figure 1–4.

4. Compare the serial number found on the top of the drive with the serial number found on the Drive Properties page.
   - If the serial numbers match, continue to Installing the new Disk Drive.
   - If the serial numbers do not match, wait at least 15 seconds after removal, then reinsert the drive. Call Harmonic Technical Support immediately, and do not continue with this procedure.

NOTE: It is critical that you identify the correct disk drive. Comparing the serial number on the disk drive to the serial number displayed in SystemManager is the best way to do this.

Installing the new Disk Drive

To install the new disk drive:
1. Press the red release button on the right side of the disk drive to release the handle.
2. Push the drive into the chassis until the handle begins to close, and then press the handle until it closed.
3. The handle will click as it closes.
Figure 1–5: Installing a Disk Drive

4. Within three minutes, the new drive should appear on the Disk Utilities page on the SystemManager application. Verify that the drive is reported as Alive by the MediaDeck. Continue to Step 5.

If the drive is not reported as Alive by the MediaDeck, fail the drive (following the instructions in Step 3), remove the drive, and replace with another drive if available. Repeat this step and, if successful, continue to Step 5.

If you do not have another drive available, contact Harmonic Technical Support.

An automatic rebuild will commence on this drive. Continue to Step 5. If an automatic rebuild does not commence on this drive, contact Harmonic Technical Support.

5. On the RAID Utilities page, monitor the status for the RAID set.

The status should change from Compromised to Rebuilding immediately. If it does not, start the rebuild manually by clicking on Start Rebuild.

6. Periodically monitor the rebuild until complete. Once complete, RAID set status will change to Normal, Attached, Viable.

This completes the procedure.

NOTE: If you replaced a failed drive with a new drive from Harmonic, use the packaging materials (carton, cushion, and electrostatic sensitive bag) from the replacement disk drive to carefully repack the failed drive and return it promptly to Harmonic for analysis. Contact Harmonic Technical Support for a Return Authorization Number (RA) before shipping the drive back to Harmonic. Refer to Technical Support for contact information and a shipping address.

Replacing a Power Supply

This section provides instructions for replacing a power supply for the Spectrum MediaDeck 7000. The MediaDeck is equipped with two hot-swappable power supplies, each with an independent AC connector. If one supply fails, the load is transferred to the remaining supply without interruption to service. To take full advantage of the redundant supplies, Harmonic recommends that you use separate, isolated power sources for each AC input.
CAUTION:  Observe all conventional ESD precautions when handling MediaDeck components.

To remove a power supply:
1. Disconnect the AC power cable.
2. Press the release lever to the right and pull the handle to remove the power supply, as shown in Figure 1–6.

![Figure 1–6: Removing the Power Supply](image)

To install a new power supply:
1. Unpack the power supply.
2. Using the handle, slide the power supply into the empty chassis slot. The release lever will click to indicate that the unit is locked in place.

![Figure 1–7: Installing the Power Supply](image)

3. Connect the AC power cable.
Replacing a MediaPort Module or a ChannelPort Module

This section provides instructions for replacing a MediaPort module or a ChannelPort module.

**CAUTION:** Observe all conventional ESD precautions when handling MediaDeck components.

**NOTE:** The procedures in this section apply to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

**Stopping Players that Use the Module to be Replaced**

Before removing a module, you must stop all players that use the module you wish to replace.

**To stop players that use the module you wish to replace:**

1. From SystemManager, click the **Player Configuration** button in the left-hand column to view the **Player Configuration** window.
2. From the **Player Configuration** window, click the icon for the MediaDeck which contains the module you wish to replace. The **Player List** window appears showing a list of players that reside on the selected MediaDeck.
3. Click the check boxes next to the Players that use the module you wish to replace. Then click the **Deactivate Selected** button.
4. Verify which players use the module to be replaced by clicking the **Edit** link for each player, and then clicking **Attached Devices**. The **Device** column displays all attached devices.
5. Uncheck the **Attach** check box for the module to be replaced. Then click **Done**.
6. Repeat **Step 5** for all tracks of the Player associated with that respective module.

**NOTE:** Once the new module is installed, you must attach the new device to the players, and then re-activate the players.

**Verifying Which Module to Remove**

If you are using more than one MediaDeck, use the **Wink** function to identify the MediaDeck that contains the module to be replaced, and then wink the module to identify the correct one. If you have already identified the correct MediaDeck, continue to **Winking the Module**.

**Winking the MediaDeck**

**To wink the MediaDeck:**

1. From SystemManager, click the **Configuration** tab to display the **Configuration** page and **System Diagram**.
2. Click the icon for the MediaDeck you wish to wink. The **MediaDeck Properties** page appears.
3. Scroll down to the **General Properties** section of the page to view the **Wink State**.
4. Change the **Wink State** as desired:
   - If currently **Off**, click **Wink On** to start winking the light bar on the front panel of the MediaDeck and the status LED on the back of the processor module.
   - If currently **On**, click **Wink Off** to stop winking the MediaDeck.
Winking the Module

To wink the MediaPort module:
1. From SystemManager, click the Configuration tab to display the Configuration page and System Diagram.
2. Click the icon for the module you wish to wink. The Properties page appears.
3. From the General Information section of the page, view the Wink State.
   - If currently Off, click Wink On to start winking the status LED on the back of the module.
   - If currently On, click Wink Off to stop winking the status LED on the back of the module.

Removing the MediaPort Module

Removing the Module from the Chassis

To remove a module from the chassis:
1. Disconnect any cables from the module.
2. Using a screwdriver, loosen the two screws on the rear panel of the module as shown. The screws are captive and will not come out completely.
3. Using the handle, gently pull the module from the chassis, as shown in Figure 1–8.

Deleting the Removed Module from SystemManager

Once you have removed the module from the chassis, delete the removed module from SystemManager.

To remove an module from SystemManager:
1. Click the Diagnostics tab to display the Diagnostics page.
2. From the Device Maintenance section in the left-hand column, click the Remove Device icon to display the Remove Device page.

3. Scroll to the MediaPorts or ChannelPorts section of the page and locate the module you wish to remove.

4. From the Select column, click the check box for the module you wish to remove, and then click the Remove MediaPorts or Remove ChannelPorts button. When a confirmation message appears, click OK. After a brief pause, a message appears indicating that the device has been removed (it has also been removed from the System diagram).

5. Click OK to return to the Remove Device page.

Installing the New Module

To install a module:

1. Unpack the module.

2. Grasp the module handle and push firmly into the slot. Ensure the module is fully inserted by pressing on the connectors with the palm of your hand.

CAUTION: Drive spin–down. Damage can occur to a drive if it is removed while still spinning. We recommend that you perform all steps in the following procedure. Before removing a drive from an enclosure, wait 30 seconds to ensure that the drive has stopped spinning.

3. Tighten the two lock screws on the rear panel of the module to secure it to the chassis.

4. From the Configuration tab of SystemManager, view the System Diagram page and verify that the new module appears.


Attaching the Module to the Existing Players

Once you have installed the new module, use the Attach Devices feature in SystemManager to attach the module to the existing players.

To attach the new module to existing players:

1. Open the Player List for the MediaDeck, and then click the Edit link for any player that will use the new module.

TIP: To open the Player List, click the Player Configuration icon in the left-hand column, and then click the icon for your MediaDeck.

2. For each track, click the Attach Devices button (within each track section) to display the Attach Devices page as shown in Figure 1–9.
3. In the Attach column, click the check box for the device that you wish to connect, and then click Done.

The Edit Player page appears. The ID of the new module will appear (in the following format: MIP-7NNN_XXXXX or CPT-8NNN_XXXXX) next to the attached tracks.

**NOTE:** For help with modifying settings on either the Edit Player page or the Attach Devices page, refer to "Creating a Player" in the SystemManager User Guide.

4. Click Done to return to the Player List page.
5. Repeat steps 1-4 for each player that uses the new module.

**Activating Players**

Once you have completed the previous section, activate the players on your MediaDeck.

**To activate players:**

1. From SystemManager, click the Configuration tab, then click the Player Configuration button in the left-hand column to view the Player Configuration window.
2. From the Player Configuration window, click the icon for the MediaDeck. The Player List window appears, showing a list of players that reside on the selected MediaDeck.
3. Click the check boxes next to the Players you wish to activate and then click the Activate Selected button.

**Replacing the Chassis**

**IMPORTANT:** If your system is running 7.5 or later, contact Technical Support for assistance with replacing a MediaDeck 7000.
This section provides instructions for replacing the MediaDeck chassis.

The SystemManager uses IP addresses to uniquely identify a MediaDeck. If a MediaDeck is replaced (for example, because of unit failure), allow the new MediaDeck to assume different IP addresses from the replaced unit, if possible. This allows the SystemManager to simultaneously display both units, and allows you to move Players from the original unit to the new one, using the Move Player function. Make sure to follow the procedures in this section in the order provided.

CAUTION: Observe all conventional ESD precautions when handling MediaDeck components.

CAUTION: Before installing the new MediaDeck, make sure to record all the settings described in this section for the MediaDeck you wish to replace.

Record Your MediaDeck Settings

Record the following settings:

- **Host Name.** View the MediaDeck Properties page to identify the Host Name.
- **Network Settings.** From the Network Settings page, record all network settings for your MediaDeck, including any Additional Routes and Ethernet Failover settings. Refer to “Configuring Network Settings on the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your network settings.
- **Network/Filesystem Performance Settings.** Refer to “Changing Network/File System Performance Settings (for MediaDirector 2202/2201, MediaCenter or MediaDeck 7000)” in the SystemManager User Guide for information on viewing your Network/Filesystem Performance Settings.
- **Harmonic MediaGrid Accounts.** Refer to “Connecting to an Harmonic MediaGrid from the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your Harmonic MediaGrid Accounts.
- **Access Control Settings.** Refer to “Configuring Access Control Settings for MediaDirectors 2202/2201, MediaCenters, and MediaDecks 7000” in the SystemManager User Guide for information on viewing your Access Control Settings.

Install the Replacement MediaDeck

To install the replacement MediaDeck:

1. Rack mount the new MediaDeck according to the instructions in the Spectrum System Installation and Hardware Reference Guide.

   CAUTION: Make sure the original MediaDeck is powered down completely before replacing the chassis.

2. Power down the original MediaDeck. Before removing power to your MediaDeck, Harmonic recommends that you first stop the file system.
   a. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column. The Disk Utilities page displays all MediaDecks, MediaDirectors, or MediaCenters on the network and the status of their file systems.
   b. Click on the name of the MediaDeck you wish to power down. The Disk Utilities page for that MediaDeck appears. There are two columns displayed, the Physical View and
Logical View. At the top of the Logical View column, there is a link to the file system, as shown in Figure 1–10.

Figure 1–10: Opening the File System Utilities Page

c. Click on the link to the file system (fs0) to open the Filesystem utilities page (see Figure 1–11).

Figure 1–11: Stopping the File System

d. If the Status field in the Information section shows Started, click the Stop FS button to stop the file system (see Figure 1–11).
Chapter 1 Spectrum MediaDeck 7000

Replacing the Chassis

1. Verify that the status has changed to **Stopped**.

2. Remove power from the MediaDeck by disconnecting each of the attached AC cords from their power sources.

3. Remove the bezel from the original MediaDeck. For instructions, refer to *Replacing the Bezel*.

4. Remove the drives from the original MediaDeck and install each drive in the same order (with the same corresponding drive bay) into the new MediaDeck. For instructions on removing and installing drives, refer to *Replacing a Disk Drive*.

5. Install the bezel from the original MediaDeck on the new MediaDeck. For instructions, refer to *Replacing the Bezel*.

6. Remove the MediaPort module(s) from the original MediaDeck and install them in the new MediaDeck. Refer to *Replacing a MediaPort Module or a ChannelPort Module* for instructions.

7. Using a Gigabit Ethernet cable, connect the Ethernet ports on each MediaDeck to the switch you use to connect to the SystemManager. For detailed instructions, refer to “Connecting your Gigabit Ethernet Network” in the *Spectrum System Installation and Hardware Reference Guide*.

8. Attach any remaining cables to the new MediaDeck according to the instructions in the *Spectrum System Installation and Hardware Reference Guide*.

9. Power up the MediaDeck by plugging in both power cables.

10. Log on to SystemManager. Refer to “Logging on to the SystemManager Application” in the *SystemManager User Guide* for details.

11. From the **Configuration** tab of SystemManager, view the **System Diagram** page. The new MediaDeck should appear as **Connected**.

12. If you are using a DHCP server, the DHCP server will assign new IP addresses to the public Ethernet interfaces on the MediaDeck. You can use SystemManager to configure the MediaDeck to use either DHCP or static IP addresses. Once you have removed the original MediaDeck, you can configure the replacement MediaDeck to use the same IP addresses.

If you do not have a DHCP server, contact Harmonic Technical Support for assistance.

13. Since the new MediaDeck has just been connected, there will probably be Error Alarms in the system. To clear the alarms from the SystemManager, click on the word ALARM that is flashing in the top right corner of the web browser. This will take you to the **Alarms** page.

14. To acknowledge and delete the alarms, click the **Delete All** button. This will delete them from the SystemManager interface. However, the alarms will still be saved in a log file on the system.

15. Now that the new MediaDeck is connected and the alarms are cleared, make sure that all Spectrum devices (MediaCenters, MediaDirectors, MediaPorts, MediaStores, and MediaDecks) in your system are running the same version of firmware. If necessary, follow the instructions in “Upgrading Firmware” in the *Spectrum System Installation and Hardware Reference Guide* to upgrade your MediaDeck and MediaPort module firmware. After the upgrade, the new MediaDeck will require a reboot. Once you have verified that all the Spectrum devices in your system are running the same version of firmware, continue to the next step.

**IMPORTANT:** Do not deactivate any players on the original MediaDeck at this point.

16. Check the status of the file system on the new MediaDeck, by doing the following:

   a. From the Configuration tab in SystemManager, click the **Disk Utilities** icon in the left-hand column. The **Disk Utilities** page displays all video servers on the network and the status of their file systems.
b. Click on the name of the new MediaDeck. This will take you to the **Disk Utilities** page for the new MediaDeck. There are two columns displayed, the Physical View and Logical View. At the top of the Logical View column, there is a link to the file system, as shown in *Figure 1–12*.

![Disk utilities for MD2_MAS](image)

*Figure 1–12: Opening the File Systems Utilities*

c. Click on the link to the file system name to open the **File System Utilities** page (See *Figure 1–13*).

![Filesystem utilities for fs0 on MD2_MAS](image)

*Figure 1–13: Checking the File System*
d. Depending on the version of software, the **Status** field may appear as **Started** or **Not Started**. Even if the file system is **Started**, you must stop the file system and then start it again to ensure that the correct settings take effect.

- If the **Status** field shows **Started**, click the **Stop FS** button to stop the file system. Once the file system is stopped, click the **Start FS** button to start the file system.
- If the **Status** field shows **Not started**, click the **Start FS** button to start the file system.

e. When the **Start Filesystem** page appears, make sure that the first option, **Use NVRAM Journaling for this filesystem**, is checked, and that all other options are unchecked. Click the **Start** button.

On the **Filesystem utilities** page, the **Mode** field should now indicate **Read/Write**, and the **Mountpoint** field should indicate the default name, /fs0, or whatever name you have assigned to the file system.

---

**CAUTION:** Do not click “Initialize FS.” This will wipe out the entire file system.

f. From the **Configuration** tab, click the **Disk Utilities** icon and verify that the new MediaDeck is shown as **Started**.

17. Once you have checked the file system status, you must move your players from the original MediaDeck to the new MediaDeck. To move your players, do the following:

a. From the **Configuration** tab in SystemManager, click the **Player Configuration** icon on the left-hand column.

b. From the MediaDeck list provided, select the new MediaDeck, which should show 0 players configured. The **Player List** page appears.

c. From the **Player List** page, under **Move Players** from another MediaDirector, use the drop-down box to select the host of the original MediaDeck, which has the players you wish to move, and click **Select Players**. A list of those players appears (see **Figure 1–14**).

---

**Figure 1–14:** Move Players

d. Select the players that you wish to move by clicking the appropriate check boxes. You can also click **Select all Players** or **Clear Selection** as desired. Once the players are selected, click **Deactivate Selected**. This will deactivate the players.

e. Re-select the players you wish to move and then click the Move button to perform the move function between MediaDecks. The selected players will disappear from the list.
f. Click **Done**. The players are now located on the new MediaDeck.

g. Open the **Player List** page for the new MediaDeck and activate the players by selecting the associated check boxes and clicking **Activate Selected**.

h. Verify the players are usable by recording or playing material using those players.

18. Now that you have moved the players to the new MediaDeck, remove the virtual MediaDeck from SystemManager by doing the following:

a. In SystemManager, click the **Diagnostic** tab, and then from the left-hand column, click the **Remove Device** icon. The **Remove Devices** page appears.

b. In the section for **Not Responding**, the original MediaDeck hosts will be shown. Using the drop-down menu, select each host for that MediaDeck, and then click **Remove** until the MediaDeck hosts no longer appears.

### Configure Your New MediaDeck

Once the replacement MediaDeck is up and running, make sure to configure each of the settings described in the following steps using the information you recorded in **Record Your MediaDeck Settings**.

1. **Configure network settings for the new MediaDeck.** Refer to “Configuring Network Settings on the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the **SystemManager User Guide** for information on configuring network settings including additional routes and Ethernet Failover settings.

2. **Configure your Harmonic MediaGrid accounts.** Refer to “Connecting to an Harmonic MediaGrid from the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the **SystemManager User Guide** for information on configuring your Harmonic MediaGrid Accounts.

3. **Configure your Access Control settings.** Refer to “Configuring Access Control Settings for MediaDirectors 2202/2201, MediaCenters, and MediaDecks 7000” in the **SystemManager User Guide** for information on configuring your Access Control Settings.

4. **If you had modified the network/filesystem performance settings on the original MediaDeck, then configure the new MediaDeck to match.** Refer to “Changing Network/File System Performance Settings (for MediaDirector 2202/2201, MediaCenter or MediaDeck 7000)” in the **SystemManager User Guide** for information on configuring your Network/Filesystem Performance Settings.

5. **If you had modified the contents of the filetypes.conf file for the original MediaDeck, configure the new MediaDeck to match.** For information on editing the filetypes.conf file, refer to “Editing the Filetypes.conf File” in the **SystemManager User Guide**.

6. **Reboot the new MediaDeck according to the instructions in “Rebooting the Spectrum Video Server” in the **SystemManager User Guide**.** Once the MediaDeck has rebooted, verify that all changes, including the settings from steps 1 through 5 above, are correct.

### Verifying Functionality

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
Overview

This chapter includes replacement procedures for the MediaDeck 7000 drives, MediaPort/ChannelPort modules, and chassis using the MediaDeck 7000 Management application. For component replacement procedures using SystemManager, and for components that do not require a management application to replace, including the bezel and power supply, refer to Spectrum MediaDeck 7000.

The following sections provide information to help you replace components on your MediaDeck 7000 using MediaDeck 7000 Management.

- Replacing a Drive with MediaDeck 7000 Management
- Replacing a MediaPort or ChannelPort Module with MediaDeck 7000 Management
- Replacing the Chassis Using MediaDeck 7000 Management

Replacing a Drive with MediaDeck 7000 Management

The MediaDeck contains high-performance SATA disk drives and SSD drives that can be hot-swapped during operation without interrupting the use of the system.

TIP: Contact Technical Support for assistance with replacing a disk drive.

Gathering Information for Technical Support

To assist in drive problem diagnosis and remediation, please gather the following information for use by Harmonic Technical Support before you remove the failing/failed disk drive:

- Site Location
- Server Name
- Date of Failure
- Time of Failure
- Description of Failure
- MediaDeck Firmware Version
- MediaDeck Name
- MediaDeck Serial Number
- Drive Model
- Drive GUID
- Drive Serial Number
- Drive Size (GB)
To view MediaDeck Properties using MediaDeck 7000 Management, click **Monitor > Devices > MediaDeck**.

To view drive properties, click **Configure > Storage > Drives**, and click the Serial number of the failing/failed drive.

View the MediaDeck log file by clicking **Monitor > Logs > System Logs**. To access the complete system log file for your MediaDeck 7000, scroll to the bottom the System Logs page and click **Download**.

Note the naming of the log files:

- syslog_D11_NNNN_YYYY_MM_DD_hh_mm_ss
- NNNN = Serial number of unit
- YYYY = Year of log start
- MM = Month of log start
- DD = Day of log start
- hh = Hour of log start
- mm = Minute of log start
- ss = Second of log start

Once you obtain a Return Authorization (RA) number from Harmonic Technical Support, email the MediaDeck and drive information and a copy of the logs and Badblockhistory.txt to omneon.support@harmonicinc.com and quote the RA number in your email.

### Checking SSD Life Expectancy

MediaDeck 7000 Management displays the SSD life expectancy for any SSD installed in a MediaDeck 7000 as a percentage. Replace the SSD by the time the life expectancy reaches 1%.

To check the SSD life expectancy:

1. Click **Configure > Storage > Drives**, and click the Serial number of the SSD.
2. SSD life expectancy is listed under **Statistics**.

### Replacing a Drive

**CAUTION:** Damage can occur to a disk drive if it is removed while still spinning. Harmonic recommends that you perform all steps in the following procedure. Before removing a drive from an enclosure, wait 30 seconds to ensure that the drive has stopped spinning.

To replace (hot swap) a disk drive in the MediaDeck:

1. Ensure that you have a replacement drive from Harmonic on hand.
2. Remove the bezel. For instructions, refer to “Replacing the Bezel” in the Spectrum Component Replacement Guide.

**IMPORTANT:** Use ONLY Harmonic-supplied replacement disk drives. Disk drives from any other source will be excluded from coverage under the Harmonic product limited warranty and maintenance services programs. In addition, any errors or damages caused by the use of disk drives provided from any other source will cause the entire product to be excluded from coverage under the Harmonic product limited warranty and maintenance services programs.
Chapter 2 Spectrum MediaDeck 7000 with MediaDeck 7000 Management

Replacing a Drive with MediaDeck 7000 Management

IMPORTANTE: The drive size (in GB) and form factor must match the other drives in the enclosure. Replacement drives should have the same or greater drive capacity as those they are replacing.

3. From MediaDeck 7000 Management, click Configure > Storage > Drives and then click the icon for the drive you wish to replace.
4. Scroll to the bottom of the page and click Fail drive to fail the drive. Verify that the drive status changes to “Unavailable.”
5. Find the physical location of the drive and verify that the bottom Status LED is blinking (4 blinks per second) red to indicate the drive is failed.
6. Wait 30 seconds before unlatching the drive at the physical location indicated in the previous step.

Removing the Drive

To remove the failed drive:
1. Press the red release button on the right side of the disk drive to release the handle.
2. The handle will spring open.
3. Grasp the handle and pull the disk drive firmly away from the chassis, as shown in the following figure.

4. Compare the serial number found on the top of the drive with the serial number found on the Drive Properties page.
   - If the serial numbers match, continue to Installing the new Disk Drive.
   - If the serial numbers do not match, wait at least 15 seconds after removal, then reinsert the drive. Call Harmonic Technical Support immediately, and do not continue with this procedure.

NOTE: It is critical that you identify the correct disk drive. Comparing the serial number on the disk drive to the serial number displayed in MediaDeck 7000 Management is the best way to do this.

Installing the New Drive

To install the new drive:
1. Press the red release button on the right side of the disk drive to release the handle.
2. Push the drive into the chassis until the handle begins to close, and then press the handle until it closed.
3. The handle will click as it closes.

4. Within three minutes, the new drive should appear on the Drives page of the MediaDeck 7000 Management application.
5. Click the Unfail Drive button, and then verify that the drive status changes to Alive.
6. If the drive is not reported as Alive by the MediaDeck, fail the drive (described in “Replacing a Drive,” step 4), remove the drive, and replace with another drive if available. Repeat this step and, if successful, continue to Step 5. If you do not have another drive available, contact Harmonic Technical Support.
7. Click Configure > Storage > RAID set, and then click Start Rebuild to rebuild the RAID set. The status should change from Compromised to Rebuilding immediately.
8. Periodically monitor the rebuild until complete; you must reload the RAID set properties page in your browser to check the state. Once complete, the state of the RAID set will change to Normal/Viable.
9. The removed drive will still be displayed until you restart the MediaDeck. To restart, click Monitor > Devices > MediaDeck > Restart.

NOTE: If you replaced a failed drive with a new drive from Harmonic, use the packaging materials (carton, cushion, and electrostatic sensitive bag) from the replacement disk drive to carefully repackage the failed drive and return it promptly to Harmonic for analysis. Contact Harmonic Technical Support for a Return Authorization Number (RA) before shipping the drive back to Harmonic. Refer to “Contacting the Technical Assistance Center” in the Spectrum Component Replacement Guide for contact information and a shipping address.

Replacing a MediaPort or ChannelPort Module with MediaDeck 7000 Management

This section provides instructions for replacing a MediaPort module or a ChannelPort module.
CAUTION: Observe all conventional ESD precautions when handling MediaDeck components.

IMPORTANT: At this time, there is no way to preserve players created with MediaDeck 7000 Management and attached to a MediaPort or ChannelPort when that device is replaced. Any players attached to the original MediaPort or ChannelPort must be re-configured separately on the replacement component. Before replacing a MediaPort or ChannelPort, make sure to record all settings for the players attached to that device, as described in the following section.

Recording Player and Channel Settings

Record the following settings for the MediaPort or ChannelPort to be replaced:

- **All Player Settings.** Click Configure > Channels to view the Channels page. For each player, deactivate the player, and then record the player settings.

- **All Channel Settings.** From the Channels page, you can access the EAS, MCS, Graphics, and OPC settings for each MediaPort or ChannelPort channel. Make sure to record all channel settings.

- **All GPIO triggers.** Click Configure > Services > GPIO and then click the tab for the MediaPort or ChannelPort to be replaced. Record all GPIO settings.

Deactivating Players

To deactivate players and view their settings:

1. From MediaDeck 7000 Management, click Configure > Channels, and then click the Deactivate icon for the player you wish to deactivate.
2. Click the Edit Player icon to view the player settings.
3. Record all the settings for the player.
4. Repeat the previous steps for all players attached to the module you wish to replace.

Verifying Which Module to Remove

If you are using more than one MediaDeck, use the Wink function to identify the MediaDeck that contains the module to be replaced, and then wink the module to identify the correct one. If you have already identified the correct MediaDeck, continue to Winking the Module.

Winking the MediaDeck

When the MediaDeck wink state is on, the light bar on the front panel of the MediaDeck, and the status LED on the back of the processor module will wink.

To wink the MediaDeck:

1. Click Monitor > Devices > MediaDeck.
2. Click the Wink On button at the bottom of the page.
Winking the Module

When the MediaPort or ChannelPort wink state is on, the status LED on the rear panel of the module will wink.

To wink the MediaPort or ChannelPort module:
1. Click **Monitor > Devices > MediaDeck**.
2. Click the **Wink On** button at the bottom of the page.

Replacing the Module

Removing the Module from the Chassis

To remove a module from the chassis:
1. Disconnect any cables from the module.
2. Using a screwdriver, loosen the two screws on the rear panel of the module as shown. The screws are captive and will not come out completely.
3. Using the handle, gently pull the module from the chassis, as shown in the following figure.

Installing the New Module

To install a module:
1. Unpack the module.
2. Grasp the module handle and push firmly into the slot. Ensure the module is fully inserted by pressing on the connectors with the palm of your hand.
3. Tighten the two lock screws on the rear panel of the module to secure it to the chassis.
4. In MediaDeck 7000 Management, verify that the new module appears.
Chapter 2 Spectrum MediaDeck 7000 with MediaDeck 7000 Management

Replacing the Chassis Using MediaDeck 7000 Management

This section provides instructions for replacing the MediaDeck chassis.

![IMPORTANT: Contact Technical Support for assistance with replacing a MediaDeck 7000.](image)

**CAUTION:** Observe all conventional ESD precautions when handling MediaDeck components.

![IMPORTANT: At this time, there is no way to preserve players created with MediaDeck 7000 Management when replacing a MediaDeck 7000. Any players on the original MediaDeck must be re-configured separately on the replacement MediaDeck. Before installing the new MediaDeck, make sure to record all player and MediaDeck settings described in this section for the MediaDeck you wish to replace.](image)

Record Your MediaDeck and Player Settings

Record the following settings:

- **Network Settings.** Click **Configure > Network Settings > IP settings** to view the Network Settings. Record all IP settings for your MediaDeck, including any Additional Routes and Ethernet Failover settings.
  - Click **Configure > Network Settings > Access Control Settings** to view the Access Control Settings. Record all Access Control settings.

- **Player Settings.** Click **Configure > Channels** to view the Channels page. For each player, deactivate the player, then click the **Edit Player** icon to view the player settings.

- **Channel Settings:** From the Channels page, you can access the **EAS, MCS, Graphics,** and **OPC** settings for each channel in your MediaDeck. Make sure to record all channel settings.

- **Name.** Click **Monitor** to view the MediaDeck Properties page and identify the name of the MediaDeck.

- **Audio Profile Groups.** Click **Configure > Services > Audio Profile Groups** to view a list of your audio profiles. For each audio profile group, click the Export button to export an .XML file, which contains the audio profile group settings. This file can be imported into the replacement MediaDeck.
Chapter 2 Spectrum MediaDeck 7000 with MediaDeck 7000 Management

Replacing the Chassis Using MediaDeck 7000 Management

- **GPIO triggers.** Click Configure > Services > GPIO to view all configured GPIO triggers.
- **Media Fetch.** Click Configure > Services > Media Fetch to view Media Fetch settings.
- **Watch Folder.** Click Configure > Services > Watch Folder to view all Watch Folders.
- **File Types.conf.** Click Configure > Services > FileTypes.conf to access the FileTypes.conf file.
- **MediaDeck Settings.** Click Configure > Services > MediaDeck Settings to access the some settings that affect all channels in the MediaDeck.

### Install the Replacement MediaDeck

**CAUTION:** Make sure the original MediaDeck is powered down completely before replacing the chassis.

To install the replacement MediaDeck:

1. Rack mount the new MediaDeck according to the instructions in the Spectrum System Installation and Hardware Reference Guide.
2. Power down the original MediaDeck. Before removing power to your MediaDeck, Harmonic recommends that you first stop the file system. Click Configure > File System > Stop File System.
3. Verify that the status has changed to Stopped.
4. Remove power from the MediaDeck by disconnecting each of the attached AC cords from their power sources.
5. Remove the bezel from the original MediaDeck. For instructions, refer to “Replacing the Bezel” in the Spectrum Component Replacement Guide.
6. Remove the drives from the original MediaDeck and install each drive in the same order (with the same corresponding drive bay) into the new MediaDeck. For instructions on removing and installing drives, refer to Replacing a Disk Drive.
7. Install the bezel from the original MediaDeck on the new MediaDeck. For instructions, refer to “Replacing the Bezel” in the Spectrum Component Replacement Guide.
8. Remove the MediaPort module(s) from the original MediaDeck and install them in the new MediaDeck. Refer to Replacing a MediaPort Module or a ChannelPort Module for instructions.
9. Using a Gigabit Ethernet cable, connect the Ethernet ports on each MediaDeck to the switch you use to connect to the SystemManager. For detailed instructions, refer to “Connecting your Gigabit Ethernet Network” in the Spectrum System Installation and Hardware Reference Guide.
10. Attach any remaining cables to the new MediaDeck according to the instructions in the Spectrum System Installation and Hardware Reference Guide.
11. Power up the MediaDeck by plugging in both power cables.

### Configure the Replacement MediaDeck

**NOTE:** If for help with configuring the MediaDeck, click the Help button to view the MediaDeck 7000 Management Help system.

To configure the replacement MediaDeck:

1. Open MediaDeck 7000 Management for the replacement MediaDeck. To access MediaDeck 7000 Management:
a. Make sure you have connected a client computer to your Ethernet network as described in “Connecting to your Gigabit Ethernet Network” in the MediaDeck 7000 Installation Guide.

b. Using the port status display on the front panel of the MediaDeck, identify the IP address of a MediaPort or ChannelPort module installed in your MediaDeck 7000. See “Reading the Port Status Display” in the MediaDeck 7000 Installation Guide for details.

c. Open a web browser on your client computer, and then type the MediaDeck 7000 IP address in the address bar to open the MediaDeck 7000 Management interface.

2. Click Monitor > Devices > MediaDeck and verify that the Ethernet Interfaces show “Connected.” If you are using a DHCP server, the DHCP server will assign new IP addresses to the public Ethernet interfaces on the MediaDeck. You can configure the MediaDeck to use either DHCP or static IP addresses. Once you have removed the original MediaDeck, you can configure the replacement MediaDeck to use the same IP addresses. To configure network settings, click Configure > Networking > IP Settings.

3. Since the new MediaDeck has just been connected, there will probably be error alarms in the system. From the main menu, click Notifications to open the Notifications page, where you can view and clear any alarms.

4. Now that the new MediaDeck is connected and the alarms are cleared, make sure that all MediaPorts and ChannelPorts in your system are running the same version of firmware.

   a. Click Maintain > Update Firmware, and check the “Current Firmware” column.

   b. If necessary, follow the instructions in the “Updating Firmware” topic of the Help system to update your MediaDeck, MediaPort, and ChannelPort module firmware. After updating, the new MediaDeck will require a reboot.

   c. Once you have verified that all the Spectrum devices in your system are running the same version of firmware, continue to the next step.

5. Check the status of the file system on the new MediaDeck, by clicking Configure > Storage > File System.

   a. Depending on the version of software, the Status field may appear as Started or Not Started. Even if the file system is Started, you must stop the file system and then start it again to ensure that the correct settings take effect.

   b. If the Status field shows Started, click the Stop File System button to stop the file system. Once the file system is stopped, click the Start File System button to start the file system. If the Status field shows Not started, click the Start File System button to start the file system.

   c. The File System Start Options dialog box appears, and provides the following options:

      - **Read-only file system**: if selected, the file system will be read-only. If empty, the file system will be read-write.

      - **Use previous start options**: select to use the previous file system start options.

      - **Do not save these options for next startup**: select to clear the file system start options the next time the file system is started.

   d. Click Start. The file system status will change to “started.”

6. Once the replacement MediaDeck is up and running, make sure to configure each of the settings described in the following steps using the information you recorded earlier in “Record Your MediaDeck and Player Settings.”

   - Configure network settings. Refer to “Configuring Network Settings” in the Help system.
   - Configure GPIO triggers. Refer to “Configuring GPIO” in the Help system.
   - Configure player settings. Refer to “Creating a Player” in the Help system.
   - Configure channel settings: Refer to “Configuring a Channel” in the Help system.
Configure the MediaDeck name. Refer to “Renaming the MediaDeck 7000” in the Help system.

Import Audio Profile Groups from the original MediaDeck. Refer to “Importing an Audio Profile Group” in the Help system.

Configure Watch folders. Refer to “Configuring a Watch Folder” in the Help system.

Configure FileTypes.conf. If you had modified the contents of the filetypes.conf file for the original MediaDeck, configure the new MediaDeck to match. Refer to “Configuring FileTypes.conf” in the Help system.

Configure Media Fetch. Refer to “Configuring Media Fetch” in the Help system.

7. Restart the new MediaDeck by clicking **Monitor > Devices > MediaDeck > Restart**. The complete restart process takes approximately three minutes. Once the MediaDeck has restarted, verify that all settings from steps 1 through 7 above, are correct.

8. Verify functionality. Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
Chapter 3
Omneon MediaDeck

The following sections provide information to help you replace components on your MediaDeck system.

- Replacing the Bezel
- Replacing a Disk Drive
- Replacing a Power Supply
- Replacing the Drive Cage
- Replacing an I/O Module
- Replacing the Processor Module
- Replacing the Chassis

Replacing the Bezel

This section provides instruction for replacing the front bezel of the MediaDeck.

⚠️ CAUTION: Observe all conventional ESD precautions when handling MediaDeck components. Avoid contact with backplane components and connectors.

To remove the front bezel:
1. Loosen the four captive thumb screws that secure the bezel to the chassis.
2. Pull the bezel directly away from the chassis.

![Figure 3–1: Removing the Bezel](image)

To install the new bezel:
1. Unpack the bezel.
2. Align the bezel in front of the chassis so that the logo appears in the top-left corner, and the metal corners of the bezel are level with the rack ears of the chassis.
3. Keeping the corners aligned, press the bezel straight onto the chassis. The top and bottom edges of the bezel should slide over the top and bottom edges of the chassis. The LED connector inside the bottom right-hand corner of the bezel should connect to the LED card inside the chassis.
4. Hand-tighten the four captive thumb screws to secure the bezel in place.

NOTE: Do not overtighten the thumb screws.

Figure 3–2: Installing the Bezel

Replacing a Disk Drive

This section provides instructions for replacing a MediaDeck disk drive. The Omneon MediaDeck contains high-performance SATA disk drives that can be hot-swapped during operation without interrupting the use of the system.

NOTE: To avoid potential audio/video disruption stemming from hot-swapping a disk, the disk in question should be removed from the RAID set using SystemManager prior to removing it from the disk enclosure.

NOTE: The procedure in this section applies to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

In the event of disk drive failure, replacement disk drives are available from Harmonic. Refer to the Technical Support section for information on how to request technical support.

To assist in drive problem diagnosis and remediation, please gather the following information for use by Harmonic Technical Support before you remove the failing/failed disk drive:

- Site Location
- Server Name
- Date of Failure
- Time of Failure
- Description of Failure
- From the MediaDeck Properties page for your Omneon MediaDeck on SystemManager:
  - Firmware Version
  - Host Name
  - Serial Number
TIP: To view MediaDeck Properties, from the System Diagram page of the Configuration tab, click the icon for your Omneon MediaDeck. Then, from the Physical Configuration page, click the icon for your Omneon MediaDeck.

- From the Drive Properties page for your Omneon MediaDeck on SystemManager:
  - Disk GUID
  - Disk Serial Number
  - Disk Size (GB)

TIP: To view Drive Properties, from the Configuration tab, click Disk Utilities, then click the icon for your Omneon MediaDeck. From the second Disk Utilities page, click the icon for the drive that has failed.

- From your SystemManager Platform or client PC running SystemManager, use Windows Explorer to navigate to: `\IPADDR\FSNAME\omD7NNNNN\logs`
  
  IPADDR = IP Address or host name if using DNS
  
  FSNAME = File System Name
  
  D7 = Omneon MediaDeck model type
  
  NNNNN = Serial number of unit
  
  and locate the following:
  
  - Badblockhistory.txt
  - syslog_D7_NNNNH0_YYYY_MM_DD_hh_mm_ss.log
  
  NNNN = Serial number of unit
  
  YYYY = Year of log start
  
  MM = Month of log start
  
  DD = Day of log start
  
  hh = Hour of log start
  
  mm = Minute of log start
  
  ss = Second of log start

Once you obtain a Return Authorization (RA) number from Harmonic Technical Support, email a copy of these files to omneon.support@harmonicinc.com and quote the RA number in your email.

CAUTION: Observe all conventional ESD precautions when handling MediaDeck components.

CAUTION: Drive spin-down. Damage can occur to a drive if it is removed while still spinning. We recommend that you perform all steps in the following procedure. Before removing a drive from an enclosure, wait 30 seconds to ensure that the drive has stopped spinning.

To replace (hot swap) a disk drive in the Omneon MediaDeck:

1. Ensure that you have a replacement drive from Harmonic on hand.
**IMPORTANT:** Use ONLY Harmonic-supplied replacement disk drives. Disk drives from any other source will be excluded from coverage under the product limited warranty and maintenance services programs. In addition, any errors or damages caused by the use of disk drives provided from any other source will cause the entire product to be excluded from coverage under the product limited warranty and maintenance services programs.

**NOTE:** The drive size (in GB) and form factor must match the other drives in the enclosure. Replacement drives should have the same or greater drive capacity as those they are replacing.

2. Remove the bezel. For instructions, refer to *Replacing the Bezel*.

3. In SystemManager, from the **Drive Properties** page for the drive, click **Fail drive** to fail the drive.

View the **Disk Utilities** page for the Omneon MediaDeck to verify that the drive state is reported as **Dead, Failed**.

4. From the **Disk Utilities** page, find the physical location of the drive and note the state of the LEDs for this drive as follows:
   a. The top Activity LED should be steady green, indicating that the drive is not being actively used. If it is blinking, this is the wrong drive to remove.
   b. The bottom Status LED should be off.

5. If you identify the same drive when performing steps 4a and 4b, proceed to **Removing the Disk Drive**. If not, call Harmonic **Technical Support** and do not continue with this procedure.

### Removing the Disk Drive

**To remove the disk drive:**

1. Wait 30 seconds before unlatching the drive at the physical location indicated in **Step 4** above. Wait an additional 30 seconds before removing the drive from the Omneon MediaDeck enclosure.

2. Open the latch on the front of the disk drive by pressing the tab to the right while pulling the lever back as shown in **Figure 3–3**.

3. Slide the disk drive out of the drive bay.

4. Open the **Add/Remove Drives** page, and then click the **Remove** button next to the drive you wish to remove. This will “hide” the drive from view on the **Disk Utilities** page.
Chapter 3 Omneon MediaDeck

Replacing a Disk Drive

TIP: To open the Add/Remove Drives page, click Disk Utilities in the left-hand column, and then click the icon for the Omneon MediaDeck with the required disk drive(s) to display the associated drive views. Click the link that begins with RaidSet to open the RAID Utilities page. Scroll to the bottom and click ADD/Remove Drives.

5. Compare the serial number found on the top of the drive with the serial number found on the Drive Properties page.

If the serial numbers match, continue to Installing the New Disk Drive.

If the serial numbers do not match, wait at least 15 seconds after removal, then reinsert the drive. Call Harmonic Technical Support immediately, and do not continue with this procedure.

NOTE: It is critical that you identify the correct disk drive. Comparing the serial number on the disk drive to the serial number displayed in SystemManager is the best way to do this.

Installing the New Disk Drive

To install the new disk drive:

1. Open the latch on the front of the disk drive by pressing the tab to the right while pulling the lever back, as shown in Figure 14a.

NOTE: Keep in mind that the lever should always open from the right.

2. Using the slot guides in the enclosure to guide the drive, insert the disk drive all the way into the drive bay until the camming lever on the left side of the carrier stops it.

3. Gently push the camming lever towards the enclosure until it clicks into a closed position.

Figure 3–4: Installing a Disk Drive

4. Within three minutes, the new drive should appear on the Disk Utilities page on the SystemManager application. Verify that the drive is reported as Alive by the Omneon MediaDeck. Continue to Step 5.

If the drive is not reported as Alive by the Omneon MediaDeck, bypass the drive (following the instructions in Step 3), remove the drive, and replace with another drive if available. Repeat this step and, if successful, continue to Step 5.

If you do not have another drive available, contact Harmonic Technical Support.

An automatic rebuild will commence on this drive. Continue to Step 5. If an automatic rebuild does not commence on this drive, contact Harmonic Technical Support.
5. On the RAID Utilities page, monitor the status for the RAID set.
   The status should change from Compro\text{\textit{mised}} to Rebuilding immediately. If it does not, start the rebuild manually by clicking on Start Rebuild.

6. Periodically monitor the rebuild until complete. Once complete, RAID set status will change to Normal, Attached, Viable.

This completes the procedure.

\textbf{NOTE:} If you replaced a failed drive with a new drive from Harmonic, use the packaging materials (carton, cushion, and electrostatic sensitive bag) from the replacement disk drive to carefully repackage the failed drive and return it promptly to Harmonic for analysis. Contact Harmonic Technical Support for a Return Authorization Number (RA) before shipping the drive back to Harmonic. Refer to Technical Support for contact information and a shipping address.

\section*{Replacing a Power Supply}

This section provides instructions for replacing a power supply for the Omneon MediaDeck. The Omneon MediaDeck is equipped with two hot-swappable power supplies, each with an independent AC connector. If one supply fails, the load is transferred to the remaining supply without interruption to service. To take full advantage of the redundant supplies, Harmonic recommends that you use separate, isolated power sources for each AC input.

\textbf{CAUTION:} Observe all conventional ESD precautions when handling MediaDeck components.

\textbf{To remove a power supply:}

1. Disconnect the AC power cable.

\begin{figure}
  \centering
  \includegraphics[width=\textwidth]{Figure_3-5.png}
  \caption{Disconnecting the Power Cable}
  \end{figure}

2. Press the release lever to the right and pull the handle to remove the power supply as shown in Figure 3–6.
Figure 3–6: Removing the Power Supply

To install a new power supply:
1. Unpack the power supply.
2. Using the handle, slide the power supply into the empty chassis slot.
3. The release lever will click to indicate that the unit is locked in place.

Figure 3–7: Installing the Power Supply

4. Connect the AC power cable.

Replacing the Drive Cage

This section provides instructions for replacing the drive cage for the Omneon MediaDeck.

WARNING: Observe all conventional ESD precautions when handling MediaDeck components.

WARNING: Make sure the Omneon MediaDeck is powered down completely before replacing the drive cage. Refer to Powering Down the Omneon MediaDeck for instructions on powering down.
Powering Down the Omneon MediaDeck

Before removing power to your Omneon MediaDeck, Harmonic recommends that you first stop the file system. Once you reconnect power to your MediaDeck, you must then start the file system again.

1. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column. The Disk Utilities page displays all MediaDecks or MediaDirectors on the network and the status of their file systems.

2. Click on the name of the MediaDeck you wish to power down. The Disk Utilities page for that MediaDeck appears. There are two columns displayed, the Physical View and Logical View. At the top of the Logical View column, there is a link to the file system, as shown in Figure 3–8.

![Logical View](image)

Figure 3–8: Opening the File System Utilities Page

3. Click on the link to the file system (fs0) to open the Filesystem Utilities page (see Figure 3–9).
4. If the **Status** field in the Information section shows **Started**, click the **Stop FS** button to stop the file system (see *Figure 3–9*).

5. Verify that the status has changed to **Stopped**.

6. Remove power from the Omneon MediaDeck by disconnecting each of the attached AC cords from their power sources.

**Removing the Drive Cage**

**To remove the drive cage:**

1. Remove the front bezel. Refer to *Replacing the Bezel* for instructions.
2. Remove each of the disk drives. Refer to *Replacing a Disk Drive* for instructions.
3. Using a screwdriver, loosen the left and right-hand captive screws located on the inside of the drive cage, as shown in *Figure 3–10*. 
Chapter 3 Omneon MediaDeck
Replacing the Drive Cage

Figure 3–10: Loosening the Drive Cage Screws

| CAUTION: Do not bend or damage the LED card located below the right-hand screw. |

4. Making sure the chassis is adequately braced, grip the captive screws inside the drive cage with each hand and slide it out of the chassis, as shown in Figure 3–11.

Figure 3–11: Removing the Drive Cage

Installing the Drive Cage

To install the drive cage:
1. Unpack the drive cage.
2. Making sure the chassis is adequately braced, grip the front of the drive cage with both hands and slide it into the chassis until the front of the drive cage is flush with the chassis.

| NOTE: Make sure the drive cage is aligned properly; the front panel LED card should be in the lower right-hand corner. |

3. Tighten the left and right-hand captive screws.

| NOTE: Do not over-tighten the captive screws. |
4. Install each of the disk drives. Refer to Replacing a Disk Drive for instructions.
5. Install the front bezel. Refer to Replacing the Bezel for instructions.
6. Apply power to the Omneon MediaDeck by connecting the AC power cords to the separate, isolated power sources.
7. Start the file system. To start the file system:
   a. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column to display the Disk Utilities page.
   b. Click the icon for the Omneon MediaDeck which contains the file system you want to start. The Disk Utilities page for that MediaDeck appears.
   c. Click the Filesystem hyperlink to display the Filesystem Utilities page.
   d. At the bottom of the page, click the Start FS button.
   **IMPORTANT:** Do not click ‘Initialize FS’. This will wipe out the entire file system.
   e. When the Start Filesystem page appears, make sure that the first option, Use NVRAM Journaling for this filesystem, is checked, and that all other options are unchecked. Click the Start button.
   f. On the Filesystem Utilities page, the Mode field should now indicate Read/Write, the Sharing with other Mediadirectors field should indicate Off, and the Mountpoint field should indicate /fs0. 
   g. From the Configuration tab, click the Disk Utilities icon and verify that the file system status for this MediaDeck is shown as Started.

Replacing an I/O Module

This section provides instructions for replacing an I/O module (MediaDeck Module).

**CAUTION:** Observe all conventional ESD precautions when handling MediaDeck components.

**NOTE:** The procedures in this section apply to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

### Stopping Players that Use the I/O Module to be Replaced

Before removing an I/O module, you must stop all players that use the I/O module you wish to replace.

**To stop players that use the I/O module you wish to replace:**

1. From SystemManager, click the Player Configuration button in the left-hand column to view the Player Configuration window.
2. From the Player Configuration window, click the icon for the Omneon MediaDeck which contains the I/O module you wish to replace. The Player List window appears showing a list of players that reside on the selected Omneon MediaDeck.
3. Click the check boxes next to the Players that use the I/O module you wish to replace. Then click the Deactivate Selected button.
4. Verify which players use the I/O module to be replaced by clicking the Edit link for each player, and then clicking Attached Devices. The Device column displays all attached devices.
5. Uncheck the Attach check box for the I/O module to be replaced. Then click Done.
6. Repeat Step 5 for all tracks of the Player associated with that respective I/O module.

**NOTE:** Once the new I/O module is installed, you must attach the new device to the players, and then re-activate the players.

### Verifying Which I/O Module to Remove

If you are using more than one Omneon MediaDeck, use the **Wink** function to identify the Omneon MediaDeck that contains the I/O module to be replaced, and then wink the I/O module to identify the correct one. If you have already identified the correct Omneon MediaDeck, continue to **Winking the I/O Module**.

#### Winking the Omneon MediaDeck

To wink the Omneon MediaDeck:

1. From SystemManager, click the **Configuration** tab to display the **Configuration** page and **System Diagram**.
2. Click the icon for the Omneon MediaDeck you wish to wink. The **MediaDeck Properties** page appears.
3. Scroll down to the **General Properties** section of the page to view the **Wink State**.
4. Change the **Wink State** as desired:
   - If currently **Off**, click **Wink On** to start winking the light bar on the front panel of the Omneon MediaDeck and the status LED on the back of the processor module.
   - If currently **On**, click **Wink Off** to stop winking the Omneon MediaDeck.

#### Winking the I/O Module

To wink the I/O module:

1. From SystemManager, click the **Configuration** tab to display the **Configuration** page and **System Diagram**.
2. Click the icon for the I/O module you wish to wink. The **Properties** page appears.
3. From the **General Information** section of the page, view the **Wink State**.
   - If currently **Off**, click **Wink On** to start winking the status LED on the back of the I/O module.
   - If currently **On**, click **Wink Off** to stop winking the status LED on the back of the I/O module.

### Removing the I/O Module

#### Removing the I/O Module from the Chassis

To remove an I/O module from the chassis:

1. Disconnect any cables from the I/O module.
2. Using a screwdriver, loosen the three screws on the rear panel of the I/O module as shown. The screws are captive and will not come out completely.
3. Using both hands to grip the screws, gently pull out the I/O module from the chassis as shown in Figure 3–13.

Deleting the Removed I/O Module from SystemManager

Once you have removed the I/O module from the chassis, delete the removed I/O module from SystemManager.

To remove an I/O module from SystemManager:

1. Click the Diagnostics tab to display the Diagnostics page.
2. From the Device Maintenance section in the left-hand column, click the Remove Device icon to display the Remove Device page.
3. Scroll to the MediaPorts section of the page and locate the I/O module you wish to remove.

NOTE: In SystemManager, MediaDeck Module information is sometimes displayed as MediaPort information.

4. From the Select column, click the check box for the I/O module you wish to remove, and then click the Remove MediaPorts button. When a confirmation message appears, click OK. After a brief pause, a message appears indicating that the device has been removed (it has also been removed from the System diagram).
5. Click OK to return to the Remove Device page.
Installing the New I/O Module

To install an I/O module:
1. Unpack the I/O module.
2. Using both hands to grip the rear panel of the I/O module, gently slide the module into the chassis until the rear panel is flush with the rear of the chassis.
3. Using a screwdriver, tighten the three screws on the rear panel of the I/O module.

**NOTE:** Do not over-tighten the screws.

4. From the **Configuration** tab of SystemManager, view the **System Diagram** page and verify that the new I/O module appears.
5. Connect any necessary cables to the I/O module. Refer to the *Omneon MediaDeck™ Installation Guide* for instructions.

Attaching the I/O Module to the Existing Players

Once you have installed the new I/O module, use the Attach Devices feature in SystemManager to attach the I/O module to the existing players.

**To attach the new I/O module to existing players:**
1. Open the **Player List** for the Omneon MediaDeck, and then click the **Edit** link for any player that will use the new I/O module.

**NOTE:** To open the **Player List**, click the **Player Configuration** icon in the left-hand column, and then click the icon for your Omneon MediaDeck.

2. For each track, click the **Attach Devices** button (within each track section) to display the **Attach Devices** page as shown in *Figure 3–14*.

![Attach devices to Track 1 (MPEG) on Player testGA7.](image)

*Figure 3–14: Attach Devices Page*

3. In the **Attach** column, click the check box for the device (Omneon MediaDeck Module) that you wish to connect, and then click **Done**.

The **Edit Player** page appears. The ID of the new I/O module will appear (in the following format: MDM-5001_XXXXX) next to the attached tracks.
NOTE: For help with modifying settings on either the Edit Player page or the Attach Devices page, refer to “Creating a Player” in the SystemManager User Guide.

4. Click Done to return to the Player List page.
5. Repeat steps 1-4 for each player that uses the new I/O module.

Activating Players

Once you have completed the previous section, activate the players on your Omneon MediaDeck.

To activate players:
1. From SystemManager, click the Configuration tab, then click the Player Configuration button in the left-hand column to view the Player Configuration window.
2. From the Player Configuration window, click the icon for the Omneon MediaDeck. The Player List window appears, showing a list of players that reside on the selected Omneon MediaDeck.
3. Click the check boxes next to the Players you wish to activate and then click the Activate Selected button.

Replacing the Processor Module

This section provides instructions for replacing the Omneon MediaDeck processor module.

The SystemManager uses IP addresses to uniquely identify an Omneon MediaDeck processor module. If you need to replace a processor module (for example, because of unit failure), SystemManager requires that the new processor module automatically assume different IP addresses from the replaced unit. This allows the SystemManager to simultaneously display both units, and allows you to move Players from the original unit to the new one, using the Move Player function. If you wish to use the same IP addresses on the new unit as on the original one, follow each of the procedures below in order. Then, once you have moved your players to the new processor module, continue to the instructions for replacing a processor module using the same IP addresses.

CAUTION: Observe all conventional ESD precautions when handling MediaDeck components.

CAUTION: Make sure the Omneon MediaDeck is powered down completely before replacing a processor module. Refer to Powering Down the Omneon MediaDeck for instructions on powering down.

NOTE: The procedures in this section apply to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

Powering Down the Omneon MediaDeck

For instructions on powering down the Omneon MediaDeck, please refer to Powering Down the Omneon MediaDeck.

Removing the Processor Module

To remove the Omneon MediaDeck processor module:
1. Disconnect any cables from the processor module.
2. Loosen the three screws on the rear panel of the processor module as shown. The screws are captive and will not come out completely.

![Figure 3–15: Loosening the Processor Module Screws](image)

3. Using both hands to grip the captive screws, gently pull out the processor module halfway from the chassis.

**IMPORTANT:** Do not attempt to pull the module out completely.

4. Locate the SAS (Serial Attached SCSI) connector on the processor module board. Refer to *Figure 3–16*.

![Figure 3–16: Locating the SAS Connector](image)

5. Press down on the top latch of the SAS connector and disconnect the SAS cable, as shown in *Figure 3–17*.
Figure 3–17: Disconnecting the SAS Cable

6. Once the SAS cable has been disconnected, continue removing the processor module from the chassis.

**IMPORTANT:** Be careful not to let the SAS cable catch on the processor module as it's being pulled out.

Installing the Replacement Processor Module

To install the Omneon MediaDeck processor module:

1. Unpack the processor module.
2. Gently slide the module halfway into the chassis. Make sure to keep the SAS cable above the processor board as you slide in the module.
3. Connect the SAS cable to the SAS connector. (Refer to Step 4 in the previous section to locate the SAS connector).

**NOTE:** The SAS connector will "click" when properly connected.

4. Continue sliding the processor module into the chassis, keeping the SAS cable clear, until the rear panel of the module is flush with the rear of the chassis.
5. Tighten the three screws on the rear panel of the processor module.

**NOTE:** Do not over-tighten the screws.

6. Reconnect all network and ethernet cables to the processor module. Refer to the Omneon MediaDeck™ Installation Guide for instructions.

7. Power up the Omneon MediaDeck.

8. If DHCP services are available, the processor module should allocate a new IP address. From the Configuration tab of SystemManager, view the System Diagram page. Verify that the new processor module appears, and is shown as Connected. To identify the new Omneon MediaDeck in your network, use the Wink function as described in the next section, Winking the Omneon MediaDeck.

**NOTE:** If there are no DHCP services, or the Omneon MediaDeck does not allocate a new IP address, or the Omneon MediaDeck does not appear in the System Diagram, please contact Technical Support for assistance.
Winking the Omneon MediaDeck

To wink the Omneon MediaDeck:
1. From SystemManager, click the Configuration tab to display the Configuration page and System Diagram.
2. Click the icon for the Omneon MediaDeck you wish to Wink. The MediaDeck Properties page appears.
3. Scroll down to the General Properties section to view the Wink State.
4. Change the Wink State as desired:
   - If currently Off, click Wink On to start winking the light bar on the front panel of the Omneon MediaDeck and the status LED on the back of the processor module.
   - If currently On, click Wink Off to stop winking the Omneon MediaDeck.

Upgrading the MediaDeck Firmware

Now that the new MediaDeck is connected, make sure that all the MediaDecks and MediaDeck Modules in your system are running the same version of firmware. If necessary, follow the instructions in “Upgrading Firmware” in the Omneon MediaDeck™ User Guide to upgrade your MediaDeck and MediaDeck Module firmware. After the upgrade, the new MediaDeck will need to be restarted. Once you have verified that all the MediaDecks and MediaDeck Modules in your system are running the same version of firmware, continue to the next step.

Checking the File System

Once you have powered up the new MediaDeck, check the status of the file system by doing the following:
1. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column. The Disk Utilities page displays all MediaDecks or MediaDirectors on the network and the status of their file systems.
2. Click on the name of the new MediaDeck. This will take you to the Disk Utilities page for the new MediaDeck. There are two columns displayed, the Physical View and Logical View. At the top of the Logical View column, there is a link to the file system, as shown in Figure 3–18.
Figure 3–18: Opening the File System Utilities Page

3. Click on the link to the file system name listed (fs0) to open the Filesystem Utilities page (see Figure 3–19).

Figure 3–19: Checking the File System
4. Depending on the version of software, the **Status field** may appear as **Started** or **Not Started**. Even if the file system is Started, you must stop the file system and then start it again to ensure that the correct settings take effect.
   - If the **Status field** shows **Started**, click the **Stop FS** button to stop the file system.
     Once the file system is stopped, click the **Start FS** button to start the file system.
   - If the **Status field** shows **Not Started**, click the **Start FS** button to start the file system.

**IMPORTANT:** Do not click 'Initialize FS'. This will wipe out the entire file system.

5. When the **Start Filesystem** page appears, make sure that the first option, **Use NVRAM Journaling for this filesystem**, is checked, and that all other options are unchecked. Click the **Start** button.

6. On the **Filesystem utilities** page, the **Mode** field should now indicate **Read/Write**, the **Sharing with other MediaDirectors** field should indicate **Off**, and the **Mountpoint** field should indicate **/fs0**.

7. From the **Configuration** tab, click the **Disk Utilities** icon and verify that the new MediadDeck is shown as **Started**.

**Moving Players to the New MediaDeck in SystemManager**

To move players from the previous MediaDeck to the new one in SystemManager:

1. Navigate to the **Player List** for the new destination Omneon MediaDeck.

   **TIP:** From the left-hand column, click Player Configuration, and then click the icon for your Omneon MediaDeck.

2. Scroll to the bottom of the window and select the source Omneon MediaDeck that is being replaced from the drop-down box. Then click **Select Players** to display the **Select Players** page, as shown in **Figure 3–20**.

**Figure 3–20: Selecting Players to Move**

Select the Players you wish to move from MediaDirector **D7-01294H0** to MediaDirector **D7-01501H0**. Then click the **Move** button.

Click the **Done** button when you have finished. If the Player being moved is already active, it will be deactivated before the move.

Current status of D7-01294H0: **Connected -- Warning Alarm**
Total number of active Players on D7-01294H0: 2.
Total number of inactive Players on D7-01294H0: 0.

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>recd</td>
<td>Active</td>
<td></td>
</tr>
<tr>
<td>recd</td>
<td>Active</td>
<td></td>
</tr>
</tbody>
</table>

Move

**Done**

To view the details of a Player, click on the icon to the left of the Player name.
3. Choose the Players that you wish to move between Omneon MediaDecks by clicking the appropriate check boxes, which should all be marked as Active. You can also click Select all Players or Clear Selection as desired.

4. Click Move to perform the Move function between Omneon MediaDecks. The selected Players will disappear from the list.

5. Click Done to complete and return to the new Omneon MediaDeck Player List.

6. From the Player List, select the recently moved player(s) and click Activate Selected.

7. Verify the players are usable by recording or playing material using those players.

**Removing the Original MediaDeck from SystemManager**

Now that you have moved the players to the new MediaDeck, remove the original MediaDeck from SystemManager by doing the following:

1. In SystemManager, click the Diagnostic tab, and then from the left-hand column, click the Remove Device icon. The Remove Devices page appears.

2. In the section for Not Responding, the original MediaDeck will be shown. Using the drop-down menu, select the host for that MediaDeck, and then click Remove until the MediaDeck no longer appears.

**Changing vDHCP Settings**

**NOTE:** If you wish to use the same IP addresses on the new processor module as on the original one, continue to Replacing a Processor Module Using the Same IP Addresses.

Once you have removed the original MediaDeck from SystemManager, the vDHCP settings must be changed to match the Ethernet (MAC) addresses of the new MediaDeck.

1. Determine the MediaDeck’s new IP and Ethernet (MAC) addresses by doing the following:
   a. From the System Diagram page in SystemManager, click the MediaDeck heading (or icon) to open the Physical Configuration page. Click the icon of the MediaDeck to display the MediaDeck Properties page.
   b. In the Host Properties section of the MediaDeck Properties page, make a note of both Host IP addresses and the corresponding Ethernet (MAC) addresses.

2. From your SystemManager Platform or client PC, launch the vDHCP application by double-clicking the small vDHCP icon located in the task bar.

3. From the vDHCP Settings dialog box, click the Reservations tab. The Host names and IP Addresses of the new MediaDeck will be shown in the main window. See Figure 3–21 for an example.
4. Click the first Host under HostName, select MAC Addr, and then type or copy and paste the new MAC address from the Host Properties page into the MAC Addr field.

5. Repeat step 4 for the second Host and then click Set.

6. Restart the MediaDeck.

Clearing Alarms

Since the new MediaDeck has just been connected, there will probably be Error Alarms in the system. To clear the alarms from the SystemManager, click on the word ALARM that is flashing in the top right corner of the web browser. This will take you to the Alarms page.

To acknowledge and delete the alarms, click the Delete All button. This will delete them from the SystemManager interface. However, the alarms will still be saved in a log file on the system.

Replacing a Processor Module Using the Same IP Addresses

IMPORTANT: Only follow this procedure if you wish to use the same IP addresses on the new processor module as on the original one.

CAUTION: Make sure you have completed each of the previous procedures in this section, except “Changing vDHCP Settings” before beginning this procedure.

To replace the processor module using the same IP addresses:

1. If you are using static IP addresses on the Omneon MediaDeck (not assigned by a DHCP server), contact Harmonic Technical Support for help with the replacement steps.

   If you are using DHCP, continue to Step 2.

2. From the Diagnostics tab of SystemManager, click Remove Device and remove both hosts (H0 and H1) for both the new and original Omneon MediaDecks.

3. On the DHCP server, allocate the original IP addresses to the new Omneon MediaDeck processor module’s Ethernet MAC addresses.

4. Power down the Omneon MediaDeck (refer to Powering Down the Omneon MediaDeck).

5. On the DHCP server, delete the current active leases for the new IP addresses.
6. Power up the Omneon MediaDeck processor module. It should receive the original IP addresses from the DHCP server.

7. The new Omneon MediaDeck processor module will appear on the System Diagram page of SystemManager. It should display the original IP addresses and the original Players. You may modify the host names to match those given to the original Omneon MediaDeck processor module. Verify that all the Players are Active.

**NOTE:** If the new processor module does not receive the original IP addresses, contact Harmonic Technical Support.

---

### Replacing the Chassis

**CAUTION:** Observe all conventional ESD precautions when handling MediaDeck components.

**CAUTION:** Make sure the Omneon MediaDeck is powered down completely before replacing a processor module. Refer to **Powering Down the Omneon MediaDeck** for instructions on powering down.

---

### Powering Down the Omneon MediaDeck

For instructions on powering down the Omneon MediaDeck, refer to **Powering Down the Omneon MediaDeck**.

---

### Removing the Omneon MediaDeck Chassis

**NOTE:** When replacing the chassis, Harmonic Customer Service may instruct you to leave certain components installed.

**To remove the chassis:**

1. Disconnect any cables from the Omneon MediaDeck.
2. Remove the bezel. Refer to **Replacing the Bezel** for instructions.
3. Remove the disk drives. Refer to **Replacing a Disk Drive** for instructions.
4. Remove the drive cage. Refer to **Replacing the Drive Cage** for instructions.
5. Remove the I/O module(s). Refer to **Replacing an I/O Module** for instructions.
6. Remove the processor module. Refer to **Replacing the Processor Module** for instructions.
7. Remove the power supplies. Refer to **Replacing a Power Supply** for instructions.
8. If your Omneon MediaDeck is currently rack mounted, remove the chassis from the rack. Refer to the instructions provided with the rack kit or the **Omneon MediaDeck™ User Guide**.

### Installing the Omneon MediaDeck Chassis

**NOTE:** Certain components may already be installed in the replacement chassis.

**To install the replacement chassis:**

1. Unpack the Omneon MediaDeck chassis.
2. Rack mount the Omneon MediaDeck chassis according to the instructions provided with the rack kit or the **Omneon MediaDeck™ User Guide**.
3. Install the drive cage. Refer to **Replacing the Drive Cage** for instructions.
4. Install the disk drives. Refer to **Replacing a Disk Drive** for instructions.
5. Install the bezel. Refer to Replacing the Bezel for instructions.
7. Install the processor module. Refer to Replacing the Processor Module for instructions.
8. Install the power supplies. Refer to Replacing a Power Supply for instructions.
9. Apply power to the Omneon MediaDeck by connecting the AC power cords to the separate, isolated power sources.
10. Start the file system. To start the file system:
   a. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column to display the Disk Utilities page.
   b. Click the icon for the Omneon MediaDeck which contains the file system you want to start. The Disk Utilities page for that MediaDeck appears.
   c. Click the Filesystem hyperlink to display the Filesystem Utilities page (see Figure 3–19).
   d. At the bottom of the page, click the Start FS button.
   
   **IMPORTANT:** Do not click ‘Initialize FS’. This will wipe out the entire file system.
   
   e. When the Start Filesystem page appears, make sure that the first option, Use NVRAM Journaling for this filesystem, is checked, and that all other options are unchecked. Click the Start button.
   f. On the Filesystem Utilities page, the Mode field should now indicate Read/Write, the Sharing with other MediaDirectors field should indicate Off, and the Mountpoint field should indicate /fs0.
   g. From the Configuration tab, click the Disk Utilities icon and verify that the file system status for this MediaDeck is shown as Started.

**Verifying Functionality**

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
Chapter 4
Spectrum MediaDirector 2252/2251

The following sections provide information to help you replace components on your MediaDirector 2252/2251.

- Replacing the Bezel
- Replacing a Power Supply
- Replacing the Chassis

Replacing the Bezel

This section provides instructions for replacing the front bezel of the MediaDirector.

**CAUTION:** Observe all conventional ESD precautions when handling MediaDirector components. Avoid contact with backplane components and connectors.

**To remove the bezel:**
1. Loosen the two captive screws on each side of the bezel that secure the bezel to the chassis.

**NOTE:** Keep the rack ears in place.

2. Pull the bezel away from the chassis.

**To install the new bezel:**
1. Gently press the bezel straight onto the chassis.

**TIP:** Ensure that the bezel is aligned correctly on the chassis. When the bezel is sitting correctly, the front panel LEDs will return to their previous state, before bezel removal.

2. Hand-tighten the two captive screws on each side of the bezel to secure the bezel to the chassis.

3. Do not overtighten the thumb screws.

Replacing a Power Supply

This section provides instructions for replacing a power supply for the Spectrum MediaDirector 2252/2251. The MediaDirector is equipped with two hot-swappable power supplies, each with an independent AC connector. If one supply fails, the load is transferred to the remaining supply without interruption to service. To take full advantage of the redundant supplies, Harmonic recommends that you use separate, isolated power sources for each AC input.

**To remove a power supply:**
1. Disconnect the AC power cable.
2. Press the release lever to the right and pull the handle to remove the power supply.

**To install a new power supply:**
1. Unpack the power supply.
2. Using the handle, slide the power supply into the empty chassis slot. The release lever will click to indicate that the unit is locked in place.
3. Connect the AC power cable.

**Replacing the Chassis**

**IMPORTANT:** Contact Technical Support for assistance with replacing a MediaDirector.

The SystemManager uses IP addresses to uniquely identify MediaDirectors. If a MediaDirector is replaced (for example, because of unit failure), allow the new MediaDirector to assume different IP addresses from the replaced unit, if possible. This allows the SystemManager to simultaneously display both units, and allows you to move Players from the original unit to the new one, using the Move Player function. Make sure to follow the procedures in this section in the order provided.

**Record Your MediaDirector Settings**

**CAUTION:** Before installing the new MediaDirector, make sure to record all the settings described in this section for the MediaDirector you wish to replace.

1. Record the following settings:
   - **Host Name.** View the MediaDirector Properties page to identify the Host Name.
   - **Network Settings.** From the Network Settings page, record all network settings for your MediaDirector, including any Additional Routes and Ethernet Failover settings. Refer to “Configuring Network Settings on MediaDirector 2252/2251, 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your network settings.
   - **Network/Filesystem Performance Settings.** Refer to “Changing Network/File System Performance Settings (for MediaDirector 2252/2251, 2202/2201, MediaCenter, or MediaDeck 7000)” in the SystemManager User Guide for information on viewing your Network/Filesystem Performance Settings.
   - **Harmonic MediaGrid Accounts.** Refer to “Connecting to Harmonic MediaGrids from the MediaDirector 2252/2251, 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your Harmonic MediaGrid Accounts.
   - **Access Control Settings.** Refer to “Configuring Access Control Settings for MediaDirector 2252/2251, 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your Access Control Settings.

2. Copy the contents of the filetypes.conf file for the MediaDirector you wish to replace and save them to a separate text file. For information on accessing the filetypes.conf file, refer to “Editing the Filetypes.conf File” in the SystemManager User Guide.

**Install the Replacement MediaDirector**

**To install the replacement MediaDirector:**

1. Rack mount the new MediaDirector according to the instructions in the Spectrum System Installation and Hardware Reference Guide, and then connect the Ethernet cables to the Network Switch used for the Spectrum system.

2. Power up the MediaDirector by plugging in both power cables.

**IMPORTANT:** Do not connect any MediaPorts at this point.
3. If you are using a DHCP server, the DHCP server will assign new IP addresses to the public Ethernet interfaces on the MediaDirector. Once you have logged on to SystemManager, you can configure the MediaDirector to use either DHCP or static IP addresses. Once you have removed the original MediaDirector, you can configure the replacement MediaDirector to use the same IP addresses. If you do not have a DHCP server, contact Harmonic Technical Support for assistance.

4. Log on to SystemManager. Refer to “Logging on to the SystemManager Application” in the SystemManager User Guide for details. From the Configuration tab of SystemManager, view the System Diagram page. The new MediaDirector should appear as Connected.

5. Since the new MediaDirector has just been connected, there will probably be Error Alarms in the system. To clear the alarms from the SystemManager, click on the word ALARM that is flashing in the top right corner of the web browser. This will take you to the Alarms page.

6. To acknowledge and delete the alarms, click the Delete All button. This will delete them from the SystemManager interface. However, the alarms will still be saved in a log file on the system.

7. Now that the new MediaDirector is connected and the alarms are cleared, make sure that all MediaDirectors, MediaPorts, and MediaStores in your Spectrum system are running the same version of firmware. If necessary, follow the instructions in “Upgrading Spectrum Firmware” in the Spectrum System Installation and Hardware Reference Guide to upgrade your MediaDirector firmware. This guide also includes instructions for upgrading other components of your Spectrum system as well. After the upgrade, the new MediaDirector will require a reboot. Once you have verified that all the Spectrum MediaDirectors, MediaPorts, and MediaStores in your system are running the same version of firmware, continue to the next step.

CAUTION: For EFS configurations, make sure each MediaDirector is running the same version of Spectrum software and each has an EFS license installed BEFORE continuing to the next step to connect EFS Ethernet or shared storage cables.

IMPORTANT: Do not deactivate any players on the original MediaDirector at this point.

8. Remove the cables from the original MediaDirector and connect them to the new MediaDirector by doing the following:
   a. Power down both the original and the new MediaDirectors, by following the steps in “Powering Down the MediaDirector 2252/2251, MediaCenter, or MediaDeck 7000” in the SystemManager User Guide.
   b. Remove each SAS cable from the original MediaDirector and re-connect to the new MediaDirector, using the exact same connection slots.
   c. Remove each EFS Ethernet cable from the original MediaDirector and re-connect to the new MediaDirector, using the exact same connection slots.
   d. Remove each Ethernet cable from the MediaPort Ethernet Array and re-connect to the new MediaDirector, using the exact same connection ports.
   e. Once all cables are connected to the new MediaDirector, plug in the power cables. Leave the original MediaDirector powered off. Once the new MediaDirector has powered on, if everything is connected correctly, all six LED lights on the front panel of the MediaDirector should be a solid light blue color. (Refer to “MediaDirector
NOTE: If there are multiple MediaDirectors connected to the file system, the bottom right LED will should be a Dark Blue, indicating a shared file system. If neither of the on-board Ethernet ports is connected (eth0 or eth1) then the top right LED will not light.

9. Once you have powered up the new MediaDirector, check the status of the file system by doing the following:
   a. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column. The Disk Utilities page displays all MediaDirectors on the network and the status of their file systems.
   b. Click on the name of the new MediaDirector. This will take you to the Disk Utilities page for the new MediaDirector. There are two columns displayed, the Physical View and Logical View. At the top of the Logical View column, there is a link to the file system, as shown in Figure 4–1.

   Figure 4–1: Opening the File System Utilities

   c. Click on the link to the file system name listed (efs) to open File System Utilities page (See Figure 4–2).
d. Depending on the version of software, the Status field may appear as Started or Not Started. Even if the file system is Started, you must stop the file system and then start it again to ensure that the correct settings take effect.

- If the Status field shows Started, click the Stop FS button to stop the file system. Once the file system is stopped, click the Start FS button to start the file system.
- If the Status field shows Not started, click the Start FS button to start the file system.

**CAUTION:** Do not click “Initialize FS.” This will wipe out the entire file system.

CAUTION: Do not click "Initialize FS." This will wipe out the entire file system.

e. When the Start Filesystem page appears, make sure that the first option, Use NVRAM Journaling for this filesystem, is checked, and that all other options are unchecked. Click the Start button.

On the Filesystem utilities page, the Mode field should now indicate Read/Write, the Sharing with other MediaDirectors field should indicate On (if it does not, the MediaDirector needs to be rebooted), and the Mountpoint field should indicate /fs0.

On the front panel of the MediaDirector, the bottom right light should now be a Dark Blue color to indicate that the EFS is working.

f. From the Configuration tab, click the Disk Utilities icon and verify that the new MediaDirector is shown as Started and Shared.

**NOTE:** It is recommended that all MediaDirectors sharing a File System (EFS) be rebooted after one MediaDirector has been replaced. This ensures that all the MediaDirectors are in sync.

10. Once you have checked the file system status, you must move your players from the original MediaDirector to the new MediaDirector. To move your players, do the following:
a. From the **Configuration** tab in SystemManager, click the **Player Configuration** icon on the left-hand column.

b. From the MediaDirector list provided, select the new MediaDirector, which should show 0 players configured. The **Player List** page appears.

c. From the **Player List** page, under **Move Players from another MediaDirector**, use the dropdown box to select the host of the original MediaDirector, which has the players you wish to move, and click **Select Players**. A list of those players appears (see Figure 4–3).

![Player List for MediaDirector: D12_01471](image)

Figure 4–3: Move Players

d. Select the players that you wish to move by clicking the appropriate check boxes. You can also click Select all Players or Clear Selection as desired. Once the players are selected, click **Deactivate Selected**. This will deactivate the players.

e. Re-select the players you wish to move and then click the **Move** button to perform the move function between MediaDirectors. The selected players will disappear from the list.

f. Click **Done**. The players are now located on the new MediaDirector.

g. Open the **Player List** page for the new MediaDirector and activate the players by selecting the associated check boxes and clicking **Activate Selected**.

h. Verify the players are usable by recording or playing material using those players.

11. Now that you have moved the players to the new MediaDirector, remove the virtual MediaDirector from SystemManager by doing the following:

a. In SystemManager, click the **Diagnostic** tab, and then from the left-hand column, click the **Remove Device** icon. The **Remove Devices** page appears.

b. In the section for **Not Responding**, the original MediaDirector hosts will be shown. Using the drop-down menu, select each host for that MediaDirector, and then click **Remove** until the MediaDirector hosts no longer appears.

12. Configure network settings for the new MediaDirector. Refer to “Configuring Network Settings on the MediaDirector 2252/2251, 2202/2201, MediaCenter, and MediaDeck 7000” in the **SystemManager User Guide** for information on configuring network settings including additional routes and Ethernet Failover settings. Refer to your record of the settings for the original MediaDirector.
13. Configure your Harmonic MediaGrid accounts. Refer to “Connecting to an Harmonic MediaGrid from the MediaDirector 2252/2251, 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on configuring your Harmonic MediaGrid Accounts. Refer to your record of the settings for the original MediaDirector.


15. If you had modified the network/filesystem performance settings on the original MediaDirector, then configure the new MediaDirector to match. Refer to “Changing Network/File System Performance Settings (for MediaDirector 2252/2251, 2202/2201, MediaCenter, or MediaDeck 7000)” in the SystemManager User Guide for information on configuring your Network/Filesystem Performance Settings. Refer to your record of the settings for the original MediaDirector.

16. If you had modified the contents of the filetypes.conf file for the original MediaDirector, configure the new MediaDirector to match. For information on editing the filetypes.conf file, refer to “Editing the Filetypes.conf File” in the SystemManager User Guide. Refer to your record of the settings for the original MediaDirector.

17. Reboot the new MediaDirector according to the instructions in “Rebooting the Spectrum Video Server” in the SystemManager User Guide. Once the MediaDirector has rebooted, verify that all changes, including the settings from steps 12 through 18 above, are correct.

Verifying Functionality

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
The following sections provide information to help you replace components on your MediaDirector 2202.

- Replacing the Bezel
- Replacing a Power Supply
- Replacing the Chassis

Replacing the Bezel

This section provides instructions for replacing the front bezel of the MediaDirector.

**CAUTION:** Observe all conventional ESD precautions when handling MediaDirector components. Avoid contact with backplane components and connectors.

To remove the bezel:
1. Loosen the two captive screws on each side of the bezel that secure the bezel to the chassis.

**NOTE:** Keep the rack ears in place.
2. Pull the bezel away from the chassis.

To install the new bezel:
1. Gently press the bezel straight onto the chassis.

**TIP:** Ensure that the bezel is sitting correctly on the chassis. When the bezel is sitting correctly, the front panel LEDs will return to their previous state, before bezel removal.
2. Hand-tighten the two captive screws on each side of the bezel to secure the bezel to the chassis.
3. Do not overtighten the thumb screws.

Replacing a Power Supply

This section provides instructions for replacing a power supply for the Spectrum MediaDirector 2202. The MediaDirector is equipped with two hot-swappable power supplies, each with an independent AC connector. If one supply fails, the load is transferred to the remaining supply without interruption to service. To take full advantage of the redundant supplies, Harmonic recommends that you use separate, isolated power sources for each AC input.

To remove a power supply:
1. Disconnect the AC power cable.
2. Press the release lever to the right and pull the handle to remove the power supply.

To install a new power supply:
1. Unpack the power supply.
2. Using the handle, slide the power supply into the empty chassis slot. The release lever will click to indicate that the unit is locked in place.
3. Connect the AC power cable.

Replacing the Chassis

The SystemManager uses IP addresses to uniquely identify MediaDirectors. If a MediaDirector is replaced (for example, because of unit failure), allow the new MediaDirector to assume different IP addresses from the replaced unit, if possible. This allows the SystemManager to simultaneously display both units, and allows you to move Players from the original unit to the new one, using the Move Player function. Make sure to follow the procedures in this section in the order provided.

Record Your MediaDirector Settings

CAUTION: Before installing the new MediaDirector, make sure to record all the settings described in this section for the MediaDirector you wish to replace.

1. Record the following settings:
   - **Host Name.** View the MediaDirector Properties page to identify the Host Name.
   - **Network Settings.** From the Network Settings page, record all network settings for your MediaDirector, including any Additional Routes and Ethernet Failover settings. Refer to “Configuring Network Settings on the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your network settings.
   - **Network/Filesystem Performance Settings.** Refer to “Changing Network/File System Performance Settings (for MediaDirector 2202/2201, MediaCenter, or MediaDeck 7000)” in the SystemManager User Guide for information on viewing your Network/Filesystem Performance Settings.
   - **Harmonic MediaGrid Accounts.** Refer to “Connecting to an Harmonic MediaGrid from the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your Harmonic MediaGrid Accounts.
   - **Access Control Settings.** Refer to “Configuring Access Control Settings for MediaDirectors 2202/2201, MediaCenters, and MediaDecks 7000” in the SystemManager User Guide for information on viewing your Access Control Settings.

2. Copy the contents of the filetypes.conf file for the MediaDirector you wish to replace and save them to a separate text file. For information on accessing the filetypes.conf file, refer to “Editing the Filetypes.conf File” in the SystemManager User Guide.

Install the Replacement MediaDirector

To install the replacement MediaDirector:

3. Rack mount the new MediaDirector according to the instructions in the Spectrum System Installation and Hardware Reference Guide, and then connect the Ethernet cables to the Network Switch used for the Spectrum system.

4. Power up the MediaDirector by plugging in both power cables.

   IMPORTANT: Do not connect any MediaPorts at this point.

5. If you are using a DHCP server, the DHCP server will assign new IP addresses to the public Ethernet interfaces on the MediaDirector. Once you have logged on to SystemManager, you can configure the MediaDirector to use either DHCP or static IP addresses. Once you have removed the original MediaDirector, you can configure the replacement MediaDirector to use the same IP addresses.
If you do not have a DHCP server, contact Harmonic Technical Support for assistance.

6. Log on to SystemManager. Refer to “Logging on to the SystemManager Application” in the SystemManager User Guide for details. From the Configuration tab of SystemManager, view the System Diagram page. The new MediaDirector should appear as Connected.

7. Since the new MediaDirector has just been connected, there will probably be Error Alarms in the system. To clear the alarms from the SystemManager, click on the word ALARM that is flashing in the top right corner of the web browser. This will take you to the Alarms page.

8. To acknowledge and delete the alarms, click the Delete All button. This will delete them from the SystemManager interface. However, the alarms will still be saved in a log file on the system.

9. Now that the new MediaDirector is connected and the alarms are cleared, make sure that all MediaDirectors, MediaPorts and MediaStores in your Spectrum system are running the same version of firmware. If necessary, follow the instructions in “Upgrading Spectrum Firmware” in the Spectrum System Installation and Hardware Reference Guide to upgrade your MediaDirector firmware. This guide also includes instructions for upgrading other components of your Spectrum system as well. After the upgrade, the new MediaDirector will require a reboot. Once you have verified that all the Spectrum MediaDirectors, MediaPorts, and MediaStores in your system are running the same version of firmware, continue to the next step.

**IMPORTANT:** Do not deactivate any players on the original MediaDirector at this point.

10. Remove the original MediaDirector by doing the following:

   a. Power down both the original and the new MediaDirectors, by following the steps in “Powering Down the MediaDirector 2202/2201, MediaCenter, or MediaDeck 7000” in the SystemManager User Guide.

   b. Remove each Fibre cable from the original MediaDirector and re-connect to the new MediaDirector, using the exact same connection slots.

**NOTE:** Do not re-connect the Fibre cables into different slots on the new MediaDirector. This will cause the system to be unstable and could cause the File System to become unusable. (A diagram provided by Harmonic should show the proper connections).

   c. Remove each Ethernet cable from the MediaPort Ethernet Array and re-connect to the new MediaDirector, using the exact same connection ports.

   d. Once all cables are connected to the new MediaDirector, plug in the power cables. Leave the original MediaDirector powered off. Once the new MediaDirector has powered on, if everything is connected correctly, all six LED lights on the front panel of the MediaDirector should be a solid light blue color. (Refer to “MediaDirector 2202 Front Panel Status LEDs” in the Spectrum System Installation and Hardware Reference Guide).

**NOTE:** If there are multiple MediaDirectors connected to the file system, the bottom right LED will should be a Dark Blue, indicating a shared file system. If neither of the on-board Ethernet ports is connected (eth0 or eth1) then the top right LED will not light.

11. Once you have powered up the new MediaDirector, check the status of the file system by doing the following:

   a. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column. The Disk Utilities page displays all MediaDirectors on the network and the status of their file systems.
b. Click on the name of the new MediaDirector. This will take you to the Disk Utilities page for the new MediaDirector. There are two columns displayed, the Physical View and Logical View. At the top of the Logical View column, there is a link to the file system, as shown in Figure 5–1.

Figure 5–1: Opening the File System Utilities

c. Click on the link to the file system name listed (efs) to open File System Utilities page (See Figure 5–2).
Figure 5–2: Checking the File System

d. Depending on the version of software, the Status field may appear as Started or Not Started. Even if the file system is Started, you must stop the file system and then start it again to ensure that the correct settings take effect.

- If the Status field shows **Started**, click the **Stop FS** button to stop the file system. Once the file system is stopped, click the **Start FS** button to start the file system.
- If the Status field shows **Not started**, click the **Start FS** button to start the file system.

**CAUTION:** Do not click “Initialize FS.” This will wipe out the entire file system.

e. When the **Start Filesystem** page appears, make sure that the first option, **Use NVRAM Journaling for this filesystem**, is checked, and that all other options are unchecked. Click the Start button.

On the **Filesystem utilities** page, the **Mode** field should now indicate **Read/Write**, the **Sharing with other MediaDirectors** field should indicate **On** (if it does not, the MediaDirector needs to be rebooted), and the **Mountpoint** field should indicate **/fs0**.

On the front panel of the MediaDirector, the bottom right light should now be a Dark Blue color to indicate that the EFS is working.

f. From the **Configuration** tab, click the **Disk Utilities** icon and verify that the new MediaDirector is shown as **Started** and **Shared**.
It is recommended that all MediaDirectors sharing a File System (EFS) be rebooted after one MediaDirector has been replaced. This ensures that all the MediaDirectors are in sync.

12. Once you have checked the file system status, you must move your players from the original MediaDirector to the new MediaDirector. To move your players, do the following:
   a. From the Configuration tab in SystemManager, click the Player Configuration icon on the left-hand column.
   b. From the MediaDirector list provided, select the new MediaDirector, which should show 0 players configured. The Player List page appears.
   c. From the Player List page, under Move Players from another MediaDirector, use the dropdown box to select the host of the original MediaDirector, which has the players you wish to move, and click Select Players. A list of those players appears (see Figure 5–3).
   d. Select the players that you wish to move by clicking the appropriate check boxes. You can also click Select all Players or Clear Selection as desired. Once the players are selected, click Deactivate Selected. This will deactivate the players.
   e. Re-select the players you wish to move and then click the Move button to perform the move function between MediaDirectors. The selected players will disappear from the list.
   f. Click Done. The players are now located on the new MediaDirector.
   g. Open the Player List page for the new MediaDirector and activate the players by selecting the associated check boxes and clicking Activate Selected.
   h. Verify the players are usable by recording or playing material using those players.

13. Now that you have moved the players to the new MediaDirector, remove the virtual MediaDirector from SystemManager by doing the following:
   a. In SystemManager, click the Diagnostic tab, and then from the left-hand column, click the Remove Device icon. The Remove Devices page appears.
   b. In the section for Not Responding, the original MediaDirector hosts will be shown. Using the drop-down menu, select each host for that MediaDirector, and then click Remove until the MediaDirector hosts no longer appears.
14. Configure network settings for the new MediaDirector. Refer to “Configuring Network Settings on the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on configuring network settings including additional routes and Ethernet Failover settings. Refer to your record of the settings for the original MediaDirector.

15. Configure your Harmonic MediaGrid accounts. Refer to “Connecting to a Harmonic MediaGrid from the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on configuring your Harmonic MediaGrid Accounts. Refer to your record of the settings for the original MediaDirector.


17. If you had modified the network/filesystem performance settings on the original MediaDirector, then configure the new MediaDirector to match. Refer to “Changing Network/File System Performance Settings (for MediaDirector 2202/2201, MediaCenter, or MediaDeck 7000)” in the SystemManager User Guide for information on configuring your Network/Filesystem Performance Settings. Refer to your record of the settings for the original MediaDirector.

18. If you had modified the contents of the filetypes.conf file for the original MediaDirector, configure the new MediaDirector to match. For information on editing the filetypes.conf file, refer to “Editing the Filetypes.conf File” in the SystemManager User Guide. Refer to your record of the settings for the original MediaDirector.

19. Reboot the new MediaDirector according to the instructions in “Rebooting the Spectrum Video Server” in the SystemManager User Guide. Once the MediaDirector has rebooted, verify that all changes, including the settings from steps 12 through 18 above, are correct.

Verifying Functionality

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
The following sections provide information to help you replace components on your MediaCenter.

- Replacing the Bezel
- Replacing a Disk Drive
- Replacing a Power Supply
- Replacing a Fan
- Replacing a MediaCenter

Repeating the Bezel

This section provides instructions for replacing the front bezel of the MediaCenter.

⚠️ CAUTION: Observe all conventional ESD precautions when handling MediaCenter components. Avoid contact with backplane components and connectors.

To remove the bezel:
1. Loosen the two captive screws on each side of the bezel that secure the bezel to the chassis.

   NOTE: Keep the rack ears in place.

2. Pull the bezel away from the chassis.

![Removing the Bezel](image)

To install the new bezel:
1. Attach the LED connector on the bezel to the LED connector on the chassis.
2. Gently press the bezel straight onto the chassis.

   TIP: Ensure that the bezel is sitting correctly on the chassis. When the bezel is sitting correctly, the front panel LEDs will return to their previous state, before bezel removal.
Replacing a Disk Drive

This section provides instructions for replacing a Spectrum MediaCenter disk drive. The MediaCenter contains high-performance SATA disk drives or solid-state (SSD) disk drives that can be hot-swapped during operation without interrupting the use of the system.

**NOTE:** The procedure in this section applies to SystemManager version 6.1. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

In the event of disk drive failure, replacement disk drives are available from Harmonic. Refer to the Technical Support section for information on how to request technical support.

If you wish to install a Harmonic-supplied drive model that is not supported by your current version of Spectrum firmware, you may need to install a “DDC” configuration file to your video server, which enables you to install and use the new drive. For details, see “Installing a DDC File” in the SystemManager 6.1 User Guide.

To assist in drive problem diagnosis and remediation, please gather the following information for use by Harmonic Technical Support before you remove the failing/failed disk drive:

- Site Location
- Server Name
- Date of Failure
- Time of Failure
- Description of Failure
- From the MediaCenter Properties page on SystemManager:
- Firmware Version
Chapter 6 Spectrum MediaCenter

Replacing a Disk Drive

- Host Name
- Serial Number

**TIP:** To view MediaCenter Properties, from the System Diagram page of the Configuration tab, click the icon for your MediaCenter Then, from the Physical Configuration page, click the icon for your MediaCenter.

- From the Drive Properties page for your MediaCenter on SystemManager:
  - Disk GUID
  - Disk Serial Number
  - Disk Size (GB)

**TIP:** To view Drive Properties, from the Configuration tab, click Disk Utilities, then click the icon for your MediaCenter. From the second Disk Utilities page, click the icon for the drive that has failed.

- From your SystemManager Platform or client PC running SystemManager, use Windows Explorer to navigate to: `\IPADDR\FSNAME\omD9_NNNNN\logs`
  - IPADDR = IP Address or host name if using DNS
  - FSNAME = File System Name
  - D9 = MediaCenter model type
  - NNNNN = Serial number of unit
  - and locate the following:
    - Badblockhistory.txt
    - syslog_D9_NNNN_YYYY_MM_DD_hh_mm_ss.log
      - NNNN = Serial number of unit
      - YYYY = Year of log start
      - MM = Month of log start
      - DD = Day of log start
      - hh = Hour of log start
      - mm = Minute of log start
      - ss = Second of log start

Once you obtain a Return Authorization (RA) number from Harmonic Technical Support, email a copy of these files to omneon.support@harmonicinc.com and quote the RA number in your email.

Checking SSD Life Expectancy

SystemManager displays the SSD life expectancy for any SSD installed in a MediaCenter as a percentage. Replace the SSD by the time the life expectancy reaches 1%.

**To check the SSD life expectancy in SystemManager:**

1. To view Drive Properties, from the Configuration tab, click Disk Utilities, then click the icon for your MediaCenter. From the second Disk Utilities page, click the icon for the drive that you want to check.
2. The Drive Properties page will appear. SSD life expectancy is listed under Disk Statistics, as shown in Figure 6–3.
CAUTION: Observe all conventional ESD precautions when handling MediaCenter components.

CAUTION: Drive spin-down. Damage can occur to a drive if it is removed while still spinning. We recommend that you perform all steps in the following procedure. Before removing a drive from an enclosure, wait 30 seconds to ensure that the drive has stopped spinning.

To replace (hot swap) a disk drive in the MediaCenter:

1. Ensure that you have a replacement drive from Harmonic on hand.

   IMPORTANT: Use ONLY Harmonic-supplied replacement disk drives. Disk drives from any other source will be excluded from coverage under the Harmonic product limited warranty and maintenance services programs. In addition, any errors or damages caused by the use of disk drives provided from any other source will cause the entire product to be excluded from coverage under the Harmonic product limited warranty and maintenance services programs.

   NOTE: The drive size (in GB) and form factor must match the other drives in the enclosure. Replacement drives should have the same or greater drive capacity as those they are replacing.

2. Remove the bezel. For instructions, refer to Replacing the Bezel.

3. In SystemManager, from the Drive Properties page for the drive, click Fail drive to fail the drive.

   View the Disk Utilities page for the MediaCenter to verify that the drive state is reported as Dead, Failed.

4. From the Disk Utilities page, find the physical location of the drive and note the state of the LEDs for this drive as follows:
   a. The top Activity LED should be off, indicating that the drive is not being actively used.
      If it is blinking, this is the wrong drive to remove.
   b. The bottom Status LED should be blinking (4 blinks per second).

5. If you identify the same drive when performing steps 4a and 4b, proceed to Removing the Disk Drive. If not, call Harmonic Technical Support and do not continue with this procedure.
Removing the Disk Drive

To remove the disk drive:

1. Wait 30 seconds before unlatching the drive at the physical location indicated in Step 4 above.
2. Press the red release button on the right side of the disk drive to release the handle.
3. The handle will spring open
4. Grasp the handle and firmly pull the disk drive from the chassis.

![Removing a Disk Drive](image)

Figure 6–4: Removing a Disk Drive

5. Compare the serial number found on the top of the drive with the serial number found on the Drive Properties page.

If the serial numbers match, continue to Installing a New Disk Drive.

If the serial numbers do not match, wait at least 15 seconds after removal, then reinsert the drive. Call Harmonic Technical Support immediately, and do not continue with this procedure.

**NOTE:** It is critical that you identify the correct disk drive. Comparing the serial number on the disk drive to the serial number displayed in SystemManager is the best way to do this.

Installing a New Disk Drive

To install a new disk drive:

1. Press the red release button on the right side of the disk drive to release the handle.
2. The handle will spring open.
3. Push the drive into the chassis until the handle begins to close, and then press the handle until closes. The handle will click as it closes.

4. Within three minutes, the new drive should appear on the Disk Utilities page on the SystemManager application. Verify that the drive is reported as Alive by the MediaCenter. Continue to Step 5.

   If the drive is not reported as Alive by the MediaCenter, fail the drive (following the instructions in Step 3), remove the drive, and replace with another drive if available. Repeat this step and, if successful, continue to Step 5.

   If you do not have another drive available, contact Harmonic Technical Support.

   An automatic rebuild will commence on this drive. Continue to Step 5. If an automatic rebuild does not commence on this drive, contact Harmonic Technical Support.

5. On the RAID Utilities page, monitor the status for the RAID set.

   The status should change from Compromised to Rebuilding immediately. If it does not, start the rebuild manually by clicking on Start Rebuild.

6. Periodically monitor the rebuild until complete. Once complete, RAID set status will change to Normal, Attached, Viable.

   This completes the procedure.

NOTE: If you replaced a failed drive with a new drive from Harmonic, use the packaging materials (carton, cushion, and electrostatic sensitive bag) from the replacement disk drive to carefully repackage the failed drive and return it promptly to Harmonic for analysis. Contact Harmonic Technical Support for a Return Authorization Number (RA) before shipping the drive back to Harmonic. Refer to Technical Support for contact information and a shipping address.
Replacing a Power Supply

This section provides instructions for replacing a power supply for the Spectrum MediaCenter. The MediaCenter is equipped with two hot-swappable power supplies, each with an independent AC connector. If one supply fails, the load is transferred to the remaining supply without interruption to service. To take full advantage of the redundant supplies, Harmonic recommends that you use separate, isolated power sources for each AC input.

**CAUTION:** Observe all conventional ESD precautions when handling MediaCenter components.

To remove a power supply:

1. Disconnect the AC power cable.
2. Push and depress the red plastic release, as shown in Figure 6–6.
3. With the release still depressed, firmly pull the handle to remove the power supply.

![Figure 6–6: Removing the Power Supply](image)

To install a new power supply:

1. Unpack the power supply.
2. Using the lever, slide the power supply into the empty chassis slot until the unit is locked in place.
Replacing a Fan

This section provides instructions for replacing a fan in the Spectrum MediaCenter.

CAUTION: Observe all conventional ESD precautions when handling MediaDeck components.

Removing the Top Cover of the MediaCenter

To remove the top cover of the MediaCenter:
1. Remove the screws on each side of the unit.
2. Press and hold down the release buttons on the top of the unit.
3. Slide the cover away from the front of the unit.
4. Lift the cover from the unit.
Removing the Fan

To remove the fan:
1. Depress and hold down the releases on each side of the fan, as shown in Figure 6–9.
2. Grasp the fan and firmly pull the fan from the unit.

Installing the New Fan

To install the new fan:
1. Depress and hold down the release on each side of the fan, as shown in Figure 6–10.
2. Push the fan firmly into the slot until you hear a click.

3. Replace the top cover.

Replacing a MediaCenter

The SystemManager uses IP addresses to uniquely identify MediaCenters. If a MediaCenter is replaced (for example, because of unit failure), allow the new MediaCenter to assume different IP addresses from the replaced unit, if possible. This allows the SystemManager to simultaneously display both units, and allows you to move Players from the original unit to the new one, using the Move Player function. Make sure to follow the procedures in this section in the order provided.

**IMPORTANT:** If your system is running 7.5 or later, contact Technical Support for assistance with replacing a MediaCenter.

Record Your MediaCenter Settings

**CAUTION:** Before installing the new MediaCenter, make sure to record all the settings described in this section for the MediaCenter you wish to replace.

1. Record the following settings:
   - **Host Name.** View the MediaCenter Properties page to identify the Host Name.
   - **Public Ethernet Interfaces.** From the MediaCenter Properties page, view the Public Ethernet Interfaces section to verify whether your MediaCenter is configured to use the MIP 4 and MIP 5 Ethernet ports for public networking. If so, they will appear as eth 2 and eth 3, and you must perform step 5 in this procedure.
   - **Network Settings.** From the Network Settings page, record all network settings for your MediaCenter, including any Additional Routes and Ethernet Failover settings. Refer to “Configuring Network Settings on the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000” in the SystemManager User Guide for information on viewing your network settings.
   - **Network/Filesystem Performance Settings.** Refer to “Changing Network/File System Performance Settings (for MediaDirector 2202/2201, MediaCenter, or MediaDeck..."
Install the Replacement MediaCenter

To install the replacement MediaCenter
1. Rack mount the new MediaCenter according to the instructions in the Spectrum System Installation and Hardware Reference Guide.

2. Power down the original MediaCenter. For instructions, refer to “Powering Down the MediaDirector 2202/2201, MediaCenter, or MediaDeck 7000” in the SystemManager User Guide.

3. Remove the drives from the original MediaCenter and install each drive in the same order (with the same corresponding drive bay) into the new MediaCenter. For details, refer to “Removing and Replacing a Disk Drive” in the Spectrum System Installation and Hardware Reference Guide.

4. Using a Gigabit Ethernet cable, connect the ETH 0 connector on your MediaCenter to the switch you use to connect to the SystemManager. For detailed instructions, refer to the Spectrum System Installation and Hardware Reference Guide.

**IMPORTANT:** Do not connect any MediaPorts at this time.

5. Power up the MediaCenter by plugging in both power cables.

6. Log on to SystemManager. Refer to “Logging on to the SystemManager Application” in the SystemManager User Guide for details. From the Configuration tab of SystemManager, view the System Diagram page. The new MediaCenter should appear as Connected.

**CAUTION:** If you have configured the MIP 4 and MIP 5 Ethernet ports on the original MediaCenter for public networking, do not connect either of the MIP 4 or MIP 5 Ethernet ports until you have performed Step 7. If you have left the default configuration for the MIP 4 and MIP 5 Ethernet ports on the original MediaCenter, continue to step 8.

7. If the original MediaCenter was configured to use the MIP 4 and MIP 5 ports for public networking, do the following:
   a. From the System Diagram page in SystemManager, click the icon for the replacement MediaCenter to open the MediaCenter Properties page and scroll to the Public Ethernet Interfaces section.
   b. Click Set 4 Public Ports.
   A confirmation message appears indicating that this change will require a reboot
   c. Reboot the MediaCenter by clicking the Reboot button.
   d. Once the MediaCenter has rebooted, verify that the eth 2 and eth 3 Ethernet interfaces appear in the Public Ethernet Interfaces section.
8. Connect any public Ethernet interfaces to your Ethernet network. For detailed instructions, refer to the *Spectrum System Installation and Hardware Reference Guide*.  

9. If you are using a DHCP server, the DHCP server will assign new IP addresses to the public Ethernet interfaces on the MediaCenter. You can use SystemManager to configure the MediaCenter to use either DHCP or static IP addresses. Once you have removed the original MediaCenter, you can configure the replacement MediaCenter to use the same IP addresses.  

If you do not have a DHCP server, contact Harmonic Technical Support for assistance.  

10. Since the new MediaCenter has just been connected, there will probably be Error Alarms in the system. To clear the alarms from the SystemManager, click on the word **ALARM** that is flashing in the top right corner of the web browser. This will take you to the Alarms page.  

11. To acknowledge and delete the alarms, click the **Delete All** button. This will delete them from the SystemManager interface. However, the alarms will still be saved in a log file on the system.  

12. Now that the new MediaCenter is connected and the alarms are cleared, make sure that all Spectrum devices (MediaCenters, MediaDirectors, MediaPorts, MediaStores, and MediaDecks) in your system are running the same version of firmware. If necessary, follow the instructions in “Upgrading Spectrum Firmware” in the *Spectrum System Installation and Hardware Reference Guide* to upgrade your MediaCenter firmware. This guide also includes instructions for upgrading other components of your Spectrum system as well. After the upgrade, the new MediaCenter will require a reboot. Once you have verified that all the Spectrum devices in your system are running the same version of firmware, continue to the next step.  

**IMPORTANT:** Do not deactivate any players on the original MediaCenter at this point.  

13. Remove each Ethernet cable from the MediaPort Ethernet Array on the original MediaCenter and re-connect to the new MediaCenter, using the exact same connection ports.  

14. Once all cables are connected to the new MediaCenter, if everything is connected correctly, all six LED lights on the front panel of the MediaCenter should be a solid light blue color. (Refer to “MediaCenter Front Panel Status LEDs” in the *Spectrum System Installation and Hardware Reference Guide*).  

15. Check the status of the file system on the new MediaCenter, by doing the following:  
   a. From the **Configuration** tab in SystemManager, click the **Disk Utilities** icon in the left-hand column. The **Disk Utilities** page displays all video servers on the network and the status of their file systems.  
   b. Click on the name of the new MediaCenter. This will take you to the **Disk Utilities** page for the new MediaCenter. There are two columns displayed, the Physical View and Logical View. At the top of the Logical View column, there is a link to the file system, as shown in Figure 6–11.
c. Click on the link to the file system name listed to open File System Utilities page (See Figure 6–12).

Figure 6–12: Checking the File System

There are 0 unattached RAID sets on D9_P203907.
d. Depending on the version of software, the Status field may appear as Started or Not Started. Even if the file system is Started, you must stop the file system and then start it again to ensure that the correct settings take effect.

- If the Status field shows **Started**, click the **Stop FS** button to stop the file system. Once the file system is stopped, click the **Start FS** button to start the file system.

- If the Status field shows **Not started**, click the **Start FS** button to start the file system.

**CAUTION:** Do not click “Initialize FS.” This will wipe out the entire file system.

e. When the **Start Filesystem** page appears, make sure that the first option, **Use NVRAM Journaling for this filesystem**, is checked, and that all other options are unchecked. Click the **Start** button.

On the **Filesystem utilities** page, the **Mode** field should now indicate **Read/Write**, the **Sharing with other MediaDirectors** field should indicate **On** (if it does not, the MediaDirector needs to be rebooted), and the **Mountpoint** field should indicate **/fs0**.

f. From the **Configuration** tab, click the **Disk Utilities** icon and verify that the new MediaCenter is shown as **Started** and **Shared**.

16. Once you have checked the file system status, you must move your players from the original MediaCenter to the new MediaCenter. To move your players, do the following:

a. From the **Configuration** tab in SystemManager, click the **Player Configuration** icon on the left-hand column.

b. From the MediaCenter list provided, select the new MediaCenter, which should show 0 players configured. The **Player List** page appears.

c. From the **Player List** page, under **Move Players from another MediaDirector**, use the dropdown box to select the host of the original MediaCenter, which has the players you wish to move, and click **Select Players**. A list of those players appears (see **Figure 6-13**).

![Player List for MediaCenter: CT_D9_00068](image)

**Figure 6–13: Move Players**

d. Select the players that you wish to move by clicking the appropriate check boxes. You can also click Select all Players or Clear Selection as desired. Once the players are selected, click **Deactivate Selected**. This will deactivate the players.
e. Re-select the players you wish to move and then click the **Move** button to perform the move function between MediaCenters. The selected players will disappear from the list.

f. Click **Done**. The players are now located on the new MediaCenter.

g. Open the **Player List** page for the new MediaCenter and activate the players by selecting the associated check boxes and clicking **Activate Selected**.

h. Verify the players are usable by recording or playing material using those players.

17. Now that you have moved the players to the new MediaCenter, remove the virtual MediaCenter from SystemManager by doing the following:

a. In SystemManager, click the **Diagnostic** tab, and then from the left-hand column, click the **Remove Device** icon. The **Remove Devices** page appears.

b. In the section for **Not Responding**, the original MediaCenter hosts will be shown. Using the drop-down menu, select each host for that MediaCenter, and then click **Remove** until the MediaCenter hosts no longer appears.

---

**Configure Your New MediaCenter Settings**

1. Configure network settings for the new MediaCenter. Refer to Configuring Network Settings on the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000 in the *SystemManager User Guide* for information on configuring network settings including additional routes and Ethernet Failover settings. Refer to your record of the settings for the original MediaCenter.

2. Configure your Harmonic MediaGrid accounts. Refer to Connecting to an Harmonic MediaGrid from the MediaDirector 2202/2201, MediaCenter, and MediaDeck 7000 in the *SystemManager User Guide* for information on configuring your Harmonic MediaGrid Accounts. Refer to your record of the settings for the original MediaCenter.

3. Configure your Access Control settings. Refer to Configuring Access Control Settings for MediaDirectors 2202/2201, MediaCenters, and MediaDecks 7000 in the *SystemManager User Guide* for information on configuring your Access Control Settings. Refer to your record of the settings for the original MediaCenter.

4. If you had modified the network/filesystem performance settings on the original MediaCenter, then configure the new MediaCenter to match. Refer to Changing Network/File System Performance Settings (for MediaDirector 2202/2201, MediaCenter, or MediaDeck 7000) in the *SystemManager User Guide* for information on configuring your Network/Filesystem Performance Settings. Refer to your record of the settings for the original MediaCenter.

5. If you had modified the contents of the filetypes.conf file for the original MediaCenter, configure the new MediaCenter to match. For information on editing the filetypes.conf file, refer to Editing the Filetypes.conf File in the *SystemManager User Guide*. Refer to your record of the settings for the original MediaCenter.

6. Reboot the new MediaCenter according to the instructions in Rebooting the Spectrum Video Server in the *SystemManager User Guide*. Once the MediaCenter has rebooted, verify that all changes, including the settings from **Step 1** through **Step 5** above, are correct.

---

**Verifying Functionality**

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
Replacing a MediaDirector 2100, 2101, 2102 or 2102B

The SystemManager uses IP addresses to uniquely identify MediaDirectors. If a MediaDirector is replaced (for example, because of unit failure), allow the new MediaDirector to assume different IP addresses from the replaced unit, if possible. This allows the SystemManager to simultaneously display both units, and allows you to move Players from the old unit to the new one, using the Move Player function.

To install a replacement MediaDirector:

1. Before you install the new MediaDirector, copy the contents of the filetypes.conf file for the MediaDirector you wish to replace and save them to a separate text file. For information on accessing the filetypes.conf file, refer to “Editing the Filetypes.conf File” in the Harmonic SystemManager User Guide.

2. Rack mount the new MediaDirector and then connect the Ethernet cables to the Network Switch used for the Spectrum system.

3. Power up the MediaDirector by plugging in both power cables.

**IMPORTANT:** Do not connect any MediaPorts or Fibre cables at this point.

4. If you are using a DHCP server, the DHCP server will assign new IP addresses. From the Configuration tab of SystemManager, view the System Diagram page. Verify that the new MediaDirector appears, and is shown as Connected. The new MediaDirector will appear with the new IP addresses. Continue to Step 5.

   If you are using DHCP and wish to use the same IP addresses on the new MediaDirector, continue to Step 5. The IP addresses can be changed at a later point in the replacement procedure.

To assign a static IP address, do the following:

a. From the SystemManager platform, start the Monitor.exe program.

b. From the Monitor application, select the View drop-down menu and select Serial Number List.

c. From the Serial Number List, you will see a list of all current MediaDirectors on the network, which are identified by their Serial Number. (See Figure 7–1)

**Figure 7–1: Opening the Serial Number List**
Notice in Figure 7–1 that the bottom MediaDirector (D4_B06FSS0) does not have an IP Address assigned to it. This is what you will see when a new MediaDirector is first connected.

d. To assign an IP address to the MediaDirector host, click and highlight the Serial Number, and then right-click and select Set IP Address. The Set IP address configuration box appears. (See Figure 7–2)

![Set IP address](image)

Figure 7–2: Setting the IP address

e. Type in the IP Address needed. In Figure 7–2, the IP Address, Net Mask and Gateway have been set. If an NTP server is used for the correct time of day, enter the IP address of the NTP server. If no NTP server is available, the SystemManager platform can be used for this. Once this information is entered, click OK.

NOTE: If the new MediaDirector must use the same IP Addresses as the original one, assign the new MediaDirector temporary IP Addresses so that it can be pre-configured. These settings can be changed at a later time.

f. Once you have set the IP addresses, power down the new MediaDirector by removing both power cables, wait for at least 15 seconds, and then power it back up by plugging the power cables back in.

g. Once the MediaDirector is powered back up, open the Monitor application again. From the View menu, select Serial Number List. You should now see that the new MediaDirector is reporting the IP Address that was assigned to it. (See Figure 7–3).
5. Once the MediaDirector is powered up with correct IP addresses, log on to SystemManager. Refer to “Logging on to the SystemManager Application” in the Harmonic SystemManager User Guide for details. On the System diagram page in SystemManager, the new MediaDirector should appear as Connected.

6. Since the new MediaDirector has just been connected, there will probably be Error Alarms in the system. To clear the alarms from the SystemManager, click on the word ALARM that is flashing in the top right corner of the web browser. This will take you to the Alarms page.

7. To acknowledge and delete the alarms, click the Delete All button. This will delete them from the SystemManager interface. However, the alarms will still be saved in a log file on the system.

8. Now that the new MediaDirector is connected and the alarms are cleared, make sure that all MediaDirectors, MediaPorts and MediaStores in your Spectrum system are running the same version of firmware. If necessary, follow the instructions in “Upgrading MediaDirector and MediaCenter Firmware” in the Spectrum System Installation and Hardware Reference Guide to upgrade your MediaDirector firmware. The Installation and Hardware Reference Guide also includes instructions for upgrading other components of your Spectrum system as well. After the upgrade, the new MediaDirector will require a reboot. Once you have verified that all the Spectrum MediaDirectors, MediaPorts, and MediaStores in your system are running the same version of firmware, continue to the next step.

**IMPORTANT:** Do not deactivate any players on the original MediaDirector at this point.

9. Remove the original MediaDirector by doing the following:
   a. Power down both the original and the new MediaDirectors, by removing both power cables on each unit.
   b. Remove each Fibre cable from the original MediaDirector and re-connect to the new MediaDirector, using the exact same connection slots.
   c. Remove each 1394 cable from the original MediaDirector and re-connect to the new MediaDirector, using the exact same connection slot.
   d. Once all cables are connected to the new MediaDirector, plug in the power cables. Leave the original MediaDirector powered off. Once the new MediaDirector has powered on, if everything is connected correctly, all six LED lights on the front panel.
of the MediaDirector should be a solid light blue color. (Refer to “Rules for System LEDs” in the Spectrum System Getting Started Guide). If there are multiple MediaDirectors connected to the file system, the bottom right LED will should be a Dark Blue, indicating a shared file system.

10. Once you have powered up the new MediaDirector, check the status of the file system by doing the following:

a. From the Configuration tab in SystemManager, click the Disk Utilities icon in the left-hand column. The Disk Utilities page displays all MediaDirectors on the network and the status of their file systems.

b. Click on the name of the new MediaDirector. This will take you to the Disk Utilities page for the new MediaDirector. There are two columns displayed, the Physical View and Logical View. At the top of the Logical View column, there is a link to the file system, as shown in Figure 7–4.

[Image: Figure 7–4: Opening the File System Utilities]

c. Click on the link to the file system name listed (fs0) to open File System Utilities page (See Figure 7–5).
d. Depending on the version of software, the Status field may appear as Started or Not Started. Even if the file system is Started, you must stop the file system and then start it again to ensure that the correct settings take effect.

- If the Status field shows **Started**, click the **Stop FS** button to stop the file system. Once the file system is stopped, click the **Start FS** button to start the file system.
- If the Status field shows **Not started**, click the **Start FS** button to start the file system.

**CAUTION:** Do not click “Initialize FS.” This will wipe out the entire file system.

e. When the **Start Filesystem** page appears, make sure that the first option, **Use NVRAM Journaling for this filesystem**, is checked, and that all other options are unchecked. Click the **Start** button.

On the **Filesystem utilities** page, the **Mode** field should now indicate **Read/Write**, the **Sharing with other MediaDirectors** field should indicate **On** (if it does not, the MediaDirector needs to be rebooted), and the **Mountpoint** field should indicate `/fs0`.

On the front panel of the MediaDirector, the bottom right light should now be a Dark Blue color to indicate that the EFS is working.

f. From the **Configuration** tab, click the **Disk Utilities** icon and verify that the new MediaDirector is shown as **Started** and **Shared**.

**NOTE:** It is recommended that all MediaDirectors sharing a File System (EFS) be rebooted after one MediaDirector has been replaced. This ensures that all the MediaDirectors are in sync.
11. Once you have checked the file system status, you must move your players from the original MediaDirector to the new MediaDirector. To move your players, do the following:
   a. From the Configuration tab in SystemManager, click the Player Configuration icon on the left-hand column.
   b. From the MediaDirector list provided, select the new MediaDirector, which should show 0 players configured. The Player List page appears.
   c. From the Player List page, under Move Players from another MediaDirector, use the dropdown box to select the host of the original MediaDirector, which has the players you wish to move, and click Select Players. A list of those players appears (see Figure 7–6).
   d. Select the players that you wish to move by clicking the appropriate check boxes. You can also click Select all Players or Clear Selection as desired. Once the players are selected, click Deactivate Selected. This will deactivate the players.
   e. Re-select the players you wish to move and then click the Move button to perform the move function between MediaDirectors. The selected players will disappear from the list.
   f. Click Done. The players are now located on the new MediaDirector.
   g. Open the Player List page for the new MediaDirector and activate the players by selecting the associated check boxes and clicking Activate Selected.
   h. Verify the players are usable by recording or playing material using those players.

   **NOTE:** You must perform steps d-h above for each host respectively.

12. Now that you have moved the players to the new MediaDirector, remove the virtual MediaDirector from SystemManager by doing the following:
   a. In SystemManager, click the Diagnostic tab, and then from the left-hand column, click the Remove Device icon. The Remove Devices page appears.
   b. In the section for Not Responding, the original MediaDirector hosts will be shown. Using the drop-down menu, select each host for that MediaDirector, and then click Remove until the MediaDirector hosts no longer appears.

   Once you have removed the original MediaDirector, you can change the IP address and name of the new MediaDirector.
13. Change the IP settings of the new MediaDirector to use those of the previous MediaDirector.

**IMPORTANT:** Make sure you have followed all the previous replacement steps before performing the following steps.

- a. From the Configuration tab, click the icon for the new MediaDirector, and then click it again on the following page to display the MediaDirector Properties page.
- b. From the MediaDirector Properties page, under Change Settings, click the IP Settings button. The IP Settings page appears.
- c. From the IP Settings page, change each MediaDirector host to reflect the new addresses and then click Done. Once you have changed the IP settings, reboot the MediaDirector using the Reboot button on the MediaDirector Properties page.
- d. Once the MediaDirector has rebooted, verify that the changes to the IP settings are correct.
- e. If you had modified the contents of the filetypes.conf file for the original MediaDirector, configure the new MediaDirector to match. For information on editing the filetypes.conf file, refer to “Editing the Filetypes.conf File” in the Harmonic SystemManager User Guide. Refer to your record of the settings for the original MediaDirector.
Chapter 8
Spectrum MediaStore 5000 Series

The following sections provide information to help you replace components on your MediaStore 5000 Series.

- Replacing the Power Cooling Module
- Replacing an I/O Module
- Replacing a Disk Drive
- Replacing the Chassis

Replacing the Power Cooling Module

This section provides instructions for replacing a Power Cooling Module (PCM) for a MediaStore 5000 Series. The MediaStore is equipped with two hot-swappable PCMs, each with an independent AC connector. If one supply fails, the load is transferred to the remaining PCM without interruption to service. To take full advantage of the redundant PCMs, Harmonic recommends that you use separate, isolated power sources for each AC input.

CAUTION: Observe all conventional ESD precautions when handling MediaStore components.

CAUTION: Do not remove the faulty power supply unless you have a replacement of the correct type ready for installation. Do not leave a PCM slot empty for more than ten minutes. Doing so will cause the MediaStore to overheat, which will result in component failure.

CAUTION: Handle the module carefully and avoid damaging the connector pins. Do not install the module if any pins appear to be bent.

To remove a power supply module:

1. Make sure that you correctly identify the faulty PCM.
2. Switch off and disconnect the power supply cord.
3. To remove the PCM:
   a. Squeeze the latch and the side of the PCM handle between thumb and forefinger to release the PCM.
   b. Gently pull the module from the chassis, as shown in Figure 8–1.
To install a new power supply module:
1. Inspect the new module for damage, especially for damage to the rear power supply connector.
2. With the PCM handle in the open position, slide the new PCM into the chassis until the latches engage and secure the module.
3. Connect the AC power cable.

Replacing an I/O Module

This section provides instructions for replacing a MediaStore 5000 Series I/O module.

**IMPORTANT:** When replacing an I/O module, the entire Spectrum system must be shut down. Please read each of the following sections and perform their steps in the order given.

To remove an I/O module:
2. Remove the Serial-attached SCSI (SAS) cables.

**NOTE:** Harmonic suggests that you label the SAS cables as you remove them from the I/O module. This will ensure the cables are correctly assigned in the new module.

3. Grip the module latch between thumb and forefinger, and squeeze them together to release the latch.
4. Pull the latch out to release the module from the MediaStore chassis, as shown in Figure 8–2.
5. Grip the latch handles, and gently remove the module, as shown in Figure 8–3.

6. Pull the I/O module from the slot.

To install an I/O module:
1. Ensure the latch on the replacement module is open, and slide the module into the slot until the latch engages.
2. Close the latch to secure the module.
3. Replace the SAS cables.

Replacing a Disk Drive

This section provides instructions for replacing a MediaStore 5000 Series disk drive. The MediaStore contains high-performance disk drives that can be hot-swapped during operation.

Note that the disk to be replaced must be removed from the RAID set before removing it from the enclosure. Failure to do so may result in audio/video disruption.
NOTE: The procedure in this section applies to SystemManager version 6.1. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

In the event of disk drive failure, replacement disk drives are available from Harmonic. Refer to the Technical Support section for information on how to request technical support.

If you wish to install a Harmonic-supplied drive model that is not supported by your current version of Spectrum firmware, you may need to install a “DDC” configuration file to your video server, which enables you to install and use the new drive. For details, see “Installing a DDC File” in the SystemManager 6.1 User Guide.

To assist in drive problem diagnosis and remediation, please gather the following information for use by Harmonic Technical Support before you remove the failing/failed disk drive:

- Site Location
- Server Name
- Date of Failure
- Time of Failure
- Description of Failure
- From the MediaDirector Properties page on SystemManager:
  - Firmware Version
  - Host Name
  - Serial Number

TIP: To view MediaDirector Properties, from the System Diagram page of the Configuration tab, click the icon for your MediaDirector. Then, from the Physical Configuration page, click the icon for your MediaDirector.

- From the Drive Properties page on SystemManager:
  - Disk GUID
  - Disk Serial Number
  - Disk Size (GB)

TIP: To view Drive Properties, from the Configuration tab, click Disk Utilities, then click the icon for your MediaDirector. From the second Disk Utilities page, click the icon for the drive that has failed.

- From your SystemManager Platform or client PC running SystemManager, use Windows Explorer to navigate to: \...fs\om(serial number of director)\logs to locate the following:
  - Badblockhistory.TXT (for all directors if EFS system)

Once you obtain a Return Authorization Number (RA) from Harmonic Technical Support, email a copy of this file to quoting the RA number.

CAUTION: Observe all conventional ESD precautions when handling MediaStore components.

CAUTION: Drive spin-down. Damage can occur to a drive if it is removed while still spinning. We recommend that you perform all steps in the following procedure. Before removing a drive from an enclosure, wait 30 seconds to ensure that the drive has stopped spinning.
It is critical that you identify the correct disk drive. There are certain disk failures that prevent system software from correctly determining the physical location of a drive. The only means of ensuring that the drive is the correct one is by comparing the serial number on the disk drive to the serial number displayed in the SystemManager application. Winking a drive and following physical (enclosure, slot) information is not always reliable.

**To replace (hot swap) a disk drive in the MediaStore:**

1. Ensure that you have a replacement drive from Harmonic on hand.

**IMPORTANT:** Use ONLY Harmonic-supplied replacement disk drives. Disk drives from any other source will be excluded from coverage under the Harmonic product limited warranty and maintenance services programs. In addition, any errors or damages caused by the use of disk drives provided from any other source will cause the entire product to be excluded from coverage under the Harmonic product limited warranty and maintenance services programs.

**NOTE:** The drive size (in GB) and form factor must match the other drives in the enclosure. Replacement drives should have the same or greater drive capacity as those they are replacing.

2. View the **Disk Utilities** page for the MediaStore to verify that the drive state is reported as **Dead, Failed**.

3. From the **Disk Utilities** page, find the physical location of the drive and note the state of the LEDs for this drive as follows:
   a. The Drive Activity LED should be off, indicating that the drive is not being actively used. If it is blinking, this is the **wrong** drive to remove.
   b. The Drive Status LED should be in Fast Flash Mode (refer to the “MediaStore 5000 Series Reference” chapter in the **Spectrum Installation and Hardware Reference Guide** for information on LED states).

4. Compare the serial number found on the top of the drive with the serial number found on the **Drive Properties** page.

   If the serial numbers match, continue to the next step.

   If the serial numbers **do not** match, wait at least 15 seconds after removal, then reinsert the drive. Call Harmonic **Technical Support** immediately, and do not continue with this procedure.

**NOTE:** It is critical that you identify the correct disk drive. Comparing the serial number on the disk drive to the serial number displayed in SystemManager is the best way to do this.

5. Wait 30 seconds before unlatching the drive at the physical location indicated in **Step 3**. Note that on 5000 Series units, the latch is located on the top of the drive carrier, as shown in **Figure 8–4**.
6. Wait an additional 30 seconds before removing the drive from the MediaStore enclosure. On the Add/Remove Drives screen, click Remove next to the drive to “hide” the drive from view on the Disk Utilities screen in the future.

**TIP:** To find each drive view: From the Configuration tab, click the Disk Utilities icon on the left to access the Disk Utilities screen. Click on the MediaDirector with the required disk drive(s) to display the associated drive views.

**NOTE:** You must click the Remove button associated with the disk for each of the directors in an EFS.

7. Insert a replacement drive by gently sliding the carrier all the way into the enclosure, until the camming lever on the bottom of the carrier stops it.

8. Gently push the camming lever towards the enclosure until it clicks into a closed position.

**NOTE:** Keep in mind that the handle should always open from the bottom.

9. Within three minutes, the new drive should appear on the Disk Utilities screen on the SystemManager application. Verify that the drive is reported as Alive by all MediaDirectors. Continue to Step 10.

If the drive is not reported as Alive by all MediaDirectors, bypass the drive (following the instructions in Step 3), remove the drive, and replace it with another drive if available, or contact Harmonic Technical Support for assistance. Repeat this step (Step 9) and if successful, continue to Step 10.

If the system does not recognize the drive, the Drive Status LED blinks at a slow rate — one second on, three seconds off. Contact Harmonic Technical Support in this event.

If you do not have another drive available, contact Harmonic Technical Support.

If you have a hot spare available, an automatic rebuild commences on this drive. Skip to Step 11.

10. If there is another drive that is available to configure as a hot spare, decide which drive should be used as the RAID rebuild target. Configure this drive as a Local Hot Spare for the RAID set.

**NOTE:** Before configuring a drive as a hot spare, ensure that the drive has the correct firmware version as determined by the SystemManager and displayed on the Upgrade Firmware screen. If the drive does not have the correct version, contact Harmonic Technical Support for assistance.
Refer to “Making a Local Hot Spare Drive” in the SystemManager User Guide for instructions.

Once a drive is configured as a Local Hot Spare, an automatic rebuild commences on this drive.

11. On the RAID Utilities screen, monitor the status for the RAID set.
12. The status should change from Compromised to Rebuilding immediately. If it does not, start the rebuild manually by clicking on Start Rebuild.
13. Reconfigure all other hot spare drives as desired.
14. Periodically monitor the rebuild until complete. Once complete, RAID set status will change to Normal, Attached, Viable.

This completes the procedure.

NOTE: If you replaced a failed drive with a new drive from Harmonic, use the packaging materials (carton, cushion, and electrostatic sensitive bag) from the replacement disk drive to carefully repackage the failed drive and return it promptly to Harmonic, Now Part of Harmonic for analysis. Contact Harmonic Technical Support for a Return Authorization Number (RA) before shipping the drive back to Harmonic. Refer to Technical Support for contact information and a shipping address.

Replacing the Chassis

This section provides instructions for replacing a MediaStore 5000 Series chassis.

IMPORTANT: When replacing a MediaStore, the entire Spectrum system must be shut down. Please read each of the following sections and perform their steps in the order given.

CAUTION: Observe all conventional ESD precautions when handling MediaStore components.

Install the Replacement MediaStore 5000 Chassis

To install the replacement MediaStore chassis:
2. Remove the cables and disk drives from the MediaStore that is being replaced.

NOTE: Harmonic suggests that you label the SAS cables as you remove them from the MediaStore. This will ensure the cables are correctly assigned in the new MediaStore.

IMPORTANT: Note the drive bay assignments of the drives when you remove them. You must install each drive in the same corresponding drive bay in the replacement MediaStore.

3. Remove the original MediaStore from the rack.
4. Remove the I/O modules from the original MediaStore and install them in the new MediaStore. Refer to Replacing an I/O Module for instructions.

IMPORTANT: Note the slot assignments of the I/O modules as you remove them. You must install each module in the same corresponding drive bay in the replacement MediaStore.

5. Remove the Power Cooling Modules from the original MediaStore and install them in the new MediaStore. Refer to Replacing the Power Cooling Module for instructions.

7. Install the disk drives in the new MediaStore in the same order and drive bay slot assignments as they had in the original MediaStore. For details, refer to *Replacing a Disk Drive* for instructions.

8. Cable the new MediaStore to the MediaDirector. Refer to “Connecting MediaDirectors and MediaStores Using SAS and EFS Ethernet” in the *Spectrum System Installation and Hardware Reference Guide* for complete instructions.


**Verifying Functionality**

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
Replacing the Power Supply

This section provides instructions for replacing a power supply for the Spectrum MediaStore 4000. The MediaStore is equipped with two hot-swappable power supplies, each with an independent AC connector. If one supply fails, the load is transferred to the remaining supply without interruption to service. To take full advantage of the redundant supplies, Harmonic recommends that you use separate, isolated power sources for each AC input.

**CAUTION:** Observe all conventional ESD precautions when handling MediaStore components.

**CAUTION:** Do not remove the faulty power supply unless you have a replacement of the correct type ready for installation.

**CAUTION:** Handle the module carefully and avoid damaging the connector pins. Do not install the module if any pins appear to be bent.

To remove a power supply module:
1. Make sure that you correctly identify the faulty power supply module.
2. Switch off and disconnect the power supply cord.
3. To remove the power supply module:
   a. Squeeze the two latches on the ends of the module towards each other to release the power supply module, as shown in Figure 9–1.
   b. Gently pull the module from the chassis.

**Figure 9–1: Removing the Power Supply Module**

To install a new power supply module:
1. Inspect the new module for damage, especially for damage to the rear power supply connector.
2. Slide the new power supply module into the chassis until the latches engage and secure the module.
3. Connect the AC power cable.

**Replacing an LRC I/O Module**

This section provides instructions for replacing a Spectrum MediaStore 4000 LRC I/O module.

**IMPORTANT:** When replacing an LRC I/O module, the entire Spectrum system must be shut down. Please read each of the following sections and perform their steps in the order given.

**To remove an LRC I/O module:**

2. Remove the fiber channel cables.

**NOTE:** Harmonic suggests that you label the fiber channel cables as you remove them from the LRC module. This will ensure the cables are correctly assigned in the new module.

3. Remove the SFPs (small form-factor pluggables).
4. Push on the tabs to release the top and bottom latches, as shown in *Figure 9–2*.

**Figure 9–2: Removing an LRC Module**

5. Pull the LRC from the slot.

**To replace an LRC I/O module:**

1. Ensure the latches on the replacement module are open, and slide the module into the slot.
2. Close the latches to secure the module.
3. Replace the SFPs.
4. Replace the fiber channel cables.

**Replacing a Disk Drive**

This section provides instructions for replacing a Spectrum MediaStore 4000 disk drive. The MediaStore contains high-performance Fibre Channel FC-AL disk drives that can be hot-swapped during operation.
Note the following important points:

- The disk to be replaced must be removed from the RAID set before removing it from the enclosure. Failure to do so may result in audio/video disruption.

- Before a replacement disk can be accessed by a MediaDirector, it must be identified as a spare disk using the SystemManager — either as a global spare (meaning it can be assigned as a spare for any RAID set), or as a designated “Local” spare for a specific RAID set.

**NOTE:** The procedure in this section applies to SystemManager version 6.1. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

In the event of disk drive failure, replacement disk drives are available from Harmonic. Refer to the Technical Support section for information on how to request technical support.

If you wish to install a Harmonic-supplied drive model that is not supported by your current version of Spectrum firmware, you may need to install a “DDC” configuration file to your video server, which enables you to install and use the new drive. For details, see “Installing a DDC File” in the SystemManager 6.1 User Guide.

To assist in drive problem diagnosis and remediation, please gather the following information for use by Harmonic Technical Support before you remove the failing/failed disk drive:

- Site Location
- Server Name
- Date of Failure
- Time of Failure
- Description of Failure

**NOTE:** The procedure in this section applies to SystemManager version 6.1. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

- From the MediaDirector Properties page on SystemManager:
  - Firmware Version
  - Host Name
  - Serial Number

**TIP:** To view MediaDirector Properties, from the System Diagram page of the Configuration tab, click the icon for your MediaDirector. Then, from the Physical Configuration page, click the icon for your MediaDirector.

- From the Drive Properties page on SystemManager:
  - Disk GUID
  - Disk Serial Number
  - Disk Size (GB)

**TIP:** To view Drive Properties, from the Configuration tab, click Disk Utilities, then click the icon for your MediaDirector. From the second Disk Utilities page, click the icon for the drive that has failed.

- From your SystemManager Platform or client PC running SystemManager, use Windows Explorer to navigate to: ```\...\som\serial number of director\logs``` to locate the following:
  - Badblockhistory.TXT (for all directors if EFS system)

Once you obtain a Return Authorization Number (RA) from Harmonic Technical Support, email a copy of this file to quoting the RA number.
**CAUTION:** Observe all conventional ESD precautions when handling MediaStore components.

**CAUTION:** Drive spin-down. Damage can occur to a drive if it is removed while still spinning. We recommend that you perform all steps in the following procedure. Before removing a drive from an enclosure, wait 30 seconds to ensure that the drive has stopped spinning.

Note the following important points:

- It is critical that you identify the correct disk drive. There are certain disk failures that prevent system software from correctly determining the physical location of a drive. The only means of ensuring that the drive is the correct one is by comparing the serial number on the disk drive to the serial number displayed in the SystemManager application. Winking a drive and following physical (enclosure, slot) information is not always reliable.

- With Spectrum 7.7 and later, if a drive fails, Spectrum will automatically bypass the drive so there is no need to do this manually. Note that once a drive is bypassed, the status LED on the front of the drive blinks slowly while the activity LED remains constant. The drive should then be removed promptly to maintain correct SES functionality. If you are not planning on removing the bypassed drive promptly, enable **Fail Drive** on the **Drive Properties** screen instead.

To replace (hot swap) a disk drive in the MediaStore:

1. Ensure that you have a replacement drive from Harmonic on hand.

   **IMPORTANT:** Use ONLY Harmonic-supplied replacement disk drives. Disk drives from any other source will be excluded from coverage under the Harmonic product limited warranty and maintenance services programs. In addition, any errors or damages caused by the use of disk drives provided from any other source will cause the entire product to be excluded from coverage under the Harmonic product limited warranty and maintenance services programs.

2. View the **Disk Utilities** page for the MediaStore to verify that the drive state is reported as **Dead, Failed**.

3. From the **Disk Utilities** page, find the physical location of the drive and note the state of the LEDs for this drive as follows:
   - a. The top Activity LED should be off, indicating that the drive is not being actively used. If it is blinking, this is the wrong drive to remove.
   - b. The bottom Status LED should be in Fast Flash Mode (refer to the **4000 Series Quick Reference Guides** for information on LED states).

4. Compare the serial number found on the top of the drive with the serial number found on the **Drive Properties** page.

If the serial numbers match, continue to the next step.

If the serial numbers **do not** match, wait at least 15 seconds after removal, then reinstall the drive. Call Harmonic **Technical Support** immediately, and do not continue with this procedure.

   **NOTE:** It is critical that you identify the correct disk drive. Comparing the serial number on the disk drive to the serial number displayed in SystemManager is the best way to do this.
5. Wait 30 seconds before unlatching the drive at the physical location indicated in Step 3. Note that on 4000 Series units, the latch is located on the left side of the drive, whereas a label, if present is on the right side.

6. Wait an additional 30 seconds before removing the drive from the MediaStore enclosure. On the **Add/Remove Drives** screen, click **Remove** next to the drive to “hide” the drive from view on the **Disk Utilities** screen in the future.

**TIP:** To find each drive view: From the Configuration tab, click the Disk Utilities icon on the left to access the Disk Utilities screen. Click on the MediaDirector with the required disk drive(s) to display the associated drive views.

**NOTE:** You must click the Remove button associated with the disk for each of the directors in an EFS.

7. Insert a replacement drive by gently sliding the carrier all the way into the enclosure, until the camming lever on the right side of the carrier stops it.

8. Gently push the camming lever towards the enclosure until it clicks into a closed position.

**NOTE:** Keep in mind that the handle should always open from the left.

9. Within three minutes, the new drive should appear on the **Disk Utilities** screen on the SystemManager application. Verify that the drive is reported as **Alive** by all MediaDirectors. Continue to **Step 10**.

   If the drive is not reported as **Alive** by all MediaDirectors, bypass the drive (following the instructions in **Step 3**), remove the drive, and replace it with another drive if available, or contact Harmonic Technical Support for assistance. Repeat this step (**Step 9**) and if successful, continue to **Step 10**.

   If the system does not recognize the drive, the drive’s status LED blinks at a slow rate — one second on, three seconds off. Contact Harmonic Technical Support in this event.

   If you do not have another drive available, contact Harmonic Technical Support.

   If you have a hot spare available, an automatic rebuild commences on this drive. Skip to **Step 11**.

10. If there is another drive that is available to configure as a hot spare, decide which drive should be used as the RAID rebuild target. Configure this drive as a Local Hot Spare for the RAID set.

   **NOTE:** Before configuring a drive as a hot spare, ensure that the drive has the correct firmware version as determined by the SystemManager and displayed on the Upgrade Firmware screen. If the drive does not have the correct version, contact Harmonic Technical Support for assistance.

   Refer to “Making a Local Hot Spare Drive” in the **SystemManager User Guide** for instructions.

   Once a drive is configured as a Local Hot Spare, an automatic rebuild commences on this drive.

11. On the **RAID Utilities** screen, monitor the status for the RAID set.

12. The status should change from **Compromised** to **Rebuilding** immediately. If it does not, start the rebuild manually by clicking on **Start Rebuild**.

13. Reconfigure all other hot spare drives as desired.

14. Periodically monitor the rebuild until complete. Once complete, RAID set status will change to:

   **Normal, Attached, Viable.**
Replacing the Chassis

This section provides instructions for replacing a MediaStore 4000.

**IMPORTANT:** When replacing a MediaStore 4000, the entire Spectrum system must be shut down. Please read each of the following sections and perform their steps in the order given.

**CAUTION:** Observe all conventional ESD precautions when handling MediaStore components.

Install the Replacement MediaStore 4000 Chassis

To install the replacement MediaStore chassis:

2. Remove the cables and disk drives from the MediaStore that is being replaced.

**NOTE:** Harmonic suggests that you label the fiber channel cables as you remove them from the MediaStore. This will ensure the cables are correctly assigned in the new MediaStore.

**IMPORTANT:** Note the drive bay assignments of the drives when you remove them. You must install each drive in the same corresponding drive bay in the replacement MediaStore.

3. Remove the original MediaStore from the rack.
4. Remove the LRCs from the original MediaStore and install them in the new MediaStore. Refer to Replacing an LRC I/O Module for instructions.

**IMPORTANT:** Note the slot assignments of the LRCs as you remove them. You must install each module in the same corresponding drive bay in the replacement MediaStore.

5. Remove the power supplies from the original MediaStore and install them in the new MediaStore. Refer to Replacing the Power Supply for instructions.
7. Install the disk drives in the new MediaStore in the same order and drive bay slot assignments as they had in the original MediaStore. For details, refer to “Removing and Replacing a Disk Drive” in the Spectrum System Installation and Hardware Reference Guide.
8. Cable the new MediaStore to the MediaDirector. Refer to “Connecting a MediaStore and a MediaDirector Using Fibre Channel” in the Spectrum System Installation and Hardware Reference Guide for complete instructions.

This completes the procedure.

**NOTE:** If you replaced a failed drive with a new drive from Harmonic, use the packaging materials (carton, cushion, and electrostatic sensitive bag) from the replacement disk drive to carefully repackage the failed drive and return it promptly to Harmonic, Now Part of Harmonic for analysis. Contact Harmonic Technical Support for a Return Authorization Number (RA) before shipping the drive back to Harmonic. Refer to Technical Support for contact information and a shipping address.
Verifying Functionality

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
The following sections provide information to help you replace components on your MediaPort 7000.

- Replacing the Bezel
- Replacing the Power Supply
- Replacing a MediaPort Module or a ChannelPort Module
- Replacing the Chassis

Replacing the Bezel

This section provides instruction for replacing the front bezel of the MediaPort 7000.

**CAUTION:** Observe all conventional ESD precautions when handling MediaDeck components. Avoid contact with backplane components and connectors.

To remove the bezel:
1. Remove the center screws on each side of the chassis that secure the bezel to the chassis.

![Figure 10–1: Removing the Bezel](image)

**NOTE:** Keep the rack ear in place.

2. Unplug the bezel power/data connector.
3. Pull the bezel away from the chassis.

To install the new bezel:
1. Unpack the bezel.
2. Attach the bezel power/data connector.
3. Align the bezel in front of the chassis so that the logo appears in the top-left corner, and the metal corners of the bezel are level with the rack ears of the chassis.
4. Keeping the corners aligned, press the bezel straight onto the chassis.
5. Attach the two center screws on each side of the chassis to secure the bezel to the chassis.

Figure 10–2: Installing the Bezel

Replacing the Power Supply

This section provides instructions for replacing a power supply for the Spectrum MediaPort 7000 chassis. The MediaPort 7000 chassis is equipped with two hot-swappable power supplies, each with an independent AC connector. If one supply fails, the load is transferred to the remaining supply without interruption to service. To take full advantage of the redundant supplies, Harmonic recommends that you use separate, isolated power sources for each AC input.

CAUTION: Observe all conventional ESD precautions when handling MediaDeck components.

To remove a power supply:
1. Disconnect the AC power cable.
2. Press the release lever to the right and pull the handle to remove the power supply as shown in Figure 10–3.
Figure 10–3: Removing a Power Supply

To install a new power supply:
1. Unpack the power supply.
2. Using the handle, slide the power supply into the empty chassis slot. The release lever will click to indicate that the unit is locked in place.
3. Connect the AC power cable.

Figure 10–4: Installing a Power Supply

Replacing a MediaPort Module or a ChannelPort Module

This section provides instructions for replacing a MediaPort Module or a ChannelPort Module.

CAUTION: Observe all conventional ESD precautions when handling MediaPort components.
NOTE: The procedures in this section apply to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

Stopping Players that Use the Module to be Replaced

Before removing a module, you must stop all players that use the module you wish to replace.

To stop players that use the module you wish to replace:
1. From SystemManager, click the Player Configuration button in the left-hand column to view the Player Configuration window.
2. From the Player Configuration window, click the icon for the MediaPort 7000 that contains the module you wish to replace. The Player List window appears showing a list of players that reside on the selected MediaPort 7000.
3. Click the check boxes next to the Players that use the module you wish to replace. Then click the Deactivate Selected button.
4. Verify which players use the module to be replaced by clicking the Edit link for each player, and then clicking Attached Devices. The Device column displays all attached devices.
5. Uncheck the Attach check box for the module to be replaced. Then click Done.
6. Repeat Step 6 for all tracks of the Player associated with that respective module.

NOTE: Once the new module is installed, you must attach the new device to the players, and then reactivate the players.

Verifying Which Module to Remove

If you are using more than one MediaPort 7000, use the Wink function to identify the MediaPort 7000 that contains the module to be replaced, and then wink the module to identify the correct one. If you have already identified the correct MediaPort 7000, continue to Winking the Module.

Winking the MediaPort 7000

To wink the MediaPort 7000:
1. From SystemManager, click the Configuration tab to display the Configuration page and System Diagram.
2. Click the icon for the MediaPort 7000 you wish to wink. The MediaPort 7000 Properties page appears.
3. Scroll down to the General Properties section of the page to view the Wink State.
4. Change the Wink State as desired:
   - If currently Off, click Wink On to start winking the light bar on the front panel of the MediaPort 7000 and the status LED on the back of the processor module.
   - If currently On, click Wink Off to stop winking the MediaPort 7000.

Winking the Module

To wink the module:
1. From SystemManager, click the Configuration tab to display the Configuration page and System Diagram.
2. Click the icon for the module you wish to wink. The Properties page appears.
3. From the General Information section of the page, view the Wink State.
   - If currently Off, click Wink On to start winking the status LED on the back of the module.
   - If currently On, click Wink Off to stop winking the status LED on the back of the module.

To remove a module from the chassis:
1. Disconnect any cables from the module.

Figure 10–5: Removing the Module

2. Using a screwdriver, loosen the two screws on the rear panel of the module as shown. The screws are captive and will not come out completely.
3. Using both hands to grip the screws, gently pull out the module from the chassis as shown in Figure 10–5.

Deleting the Removed Module from SystemManager

Once you have removed the module from the chassis, delete the removed module from SystemManager.

To remove a module from SystemManager:
1. Click the Diagnostics tab to display the Diagnostics page.
2. From the Device Maintenance section in the left-hand column, click the Remove Device icon to display the Remove Device page.
3. Scroll to the MediaPorts or ChannelPorts section of the page and locate the module you wish to remove.
4. From the Select column, click the check box for the module you wish to remove, and then click the Remove MediaPorts or Remove ChannelPorts button. When a confirmation message appears, click OK. After a brief pause, a message appears indicating that the device has been removed (it has also been removed from the System diagram).
5. Click OK to return to the Remove Device page.
Installing the New Module

To install a module:
1. Unpack the module.
2. Grasp the module handle and push firmly into the slot. Ensure the module is fully inserted by pressing on the connectors with the palm of your hand.
3. Tighten the two lock screws on the rear panel of the module to secure it to the chassis.
4. From the Configuration tab of SystemManager, view the System Diagram page and verify that the new module appears.

Attaching the Module to the Existing Players

Once you have installed the new module, use the Attach Devices feature in SystemManager to attach the module to the existing players.

To attach the new module to existing players:
1. Open the Player List for the MediaPort 7000, and then click the Edit link for any player that will use the new module.

TIP: To open the Player List, click the Player Configuration icon in the left-hand column, and then click the icon for your MediaPort.

Figure 10–6: Attach Devices

2. For each track, click the Attach Devices button (within each track section) to display the Attach Devices page as shown in Figure 10–6.
3. In the Attach column, click the check box for the device that you wish to connect, and then click Done.
4. The Edit Player page appears. The ID of the new module will appear (in the following format: MIP-7NNN_XXXXX or CPT-8NNN_XXXXX) next to the attached tracks.

NOTE: For help with modifying settings on either the Edit Player page or the Attach Devices page, refer to “Creating a Player” in the SystemManager User Guide.

5. Click Done to return to the Player List page.
6. Repeat steps 1-5 for each player that uses the new module.

Activating Players

Once you have completed the previous section, activate the players on your MediaPort 7000.

To activate players:
1. From SystemManager, click the Configuration tab, then click the Player Configuration button in the left-hand column to view the Player Configuration window.
2. From the Player Configuration window, click the icon for the MediaPort 7000. The Player List window appears, showing a list of players that reside on the selected MediaPort 7000.
3. Click the check boxes next to the Players you wish to activate and then click the Activate Selected button.

Replacing the Chassis

This section provides instructions for replacing a MediaPort 7000 chassis. Make sure to follow the procedures in this section in the order provided.

CAUTION: Observe all conventional ESD precautions when handling MediaPort components.

NOTE: The procedures in this section apply to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

Stopping Players that Use the MediaPort to be Replaced

Before removing a MediaPort, you must stop all players that use the MediaPort you wish to replace.

NOTE: In SystemManager, all MediaPort 7XXX series appear as two separate MIP-7XXX devices.

To stop players that use the MediaPort you wish to replace:
1. From SystemManager, click the Player Configuration button in the left-hand column to view the Player Configuration window.
2. From the Player Configuration window, click the icon for the MediaDeck which contains the MediaPort you wish to replace. The Player List window appears showing a list of players that reside on the selected MediaPort.
3. Click the check boxes next to the Players that use the MediaPort you wish to replace. Then click the Deactivate Selected button.
4. Verify which players use the MediaPort to be replaced by clicking the Edit link for each player, and then clicking Attached Devices. The Device column displays all attached devices.
5. Uncheck the Attach check box for the MediaPort to be replaced. Then click Done.
6. Repeat Step 5 for all tracks of the Player associated with that respective MediaPort.

**NOTE:** Once the new MediaPort module is installed, you must attach the new device to the players, and then re-activate the players.

---

### Removing the MediaPort from SystemManager

To remove the MediaPort 7000 from SystemManager:

1. Click the **Diagnostics** tab in SystemManager to display the **Diagnostics** page.

   In the left-hand column, click the **Remove Device** icon to display the **Remove Devices** page (*Figure 10–7*).

   ![Figure 10–7: Remove Device](image)

2. Click **Stop Monitoring** to stop device monitoring. Once the “Current state of Device Monitoring” field displays **NOT monitoring**, continue to the next step. Note this may take a few minutes depending on the number of devices in your system.

3. Select one or more devices from one of the menus on the page.

4. Click the **Remove** button at the bottom of the menu, and then click **OK** to confirm. After a brief pause, a message appears indicating that the device has been removed (it has also been removed from the System Diagram).

5. Click **Start Monitoring** to resume device monitoring. Make sure the “Current state of Device Monitoring” field changes to monitoring.

   **NOTE:** Device status may show **Not Responding** for a brief interval after monitoring has been turned back on.

---

### Removing the MediaPort From the Rack

To remove the MediaPort from the rack:

1. Disconnect any cables from the MediaPort.
2. Remove the MediaPort from the rack.

### Installing the Replacement MediaPort

To install the replacement MediaPort:

1. Refer to “Rack Mounting a MediaPort 7000 Series Chassis” in the *Spectrum System Installation and Hardware Reference Guide* for complete instructions.
2. Connect any necessary cables to the MediaPort. Refer to the *Spectrum System Installation and Hardware Reference Guide* for complete instructions.

**IMPORTANT:** Before connecting a device to SystemManager, make sure that device monitoring is on. To check device monitoring, click the **Home** tab to open the **Options** page, and view the "Current state of Device Monitoring" field at the top of the page. If the "Current state of Device Monitoring" field displays **NOT monitoring**, then click **Start Monitoring** and wait for the state to change to monitoring before continuing to connect the device. This may take a few minutes depending on the number of devices in your system. Also, note the status of devices may show **Not Responding** for a brief interval after monitoring has been turned on.

### Changing the MediaPort Name in SystemManager

The replacement MediaPort will appear in SystemManager with the default name. To change the MediaPort name, follow the instructions in “Changing the MediaPort Name” in the *SystemManager User Guide*.

### Upgrading MediaPort Firmware

Make sure that the replacement MediaPort is running the same version of firmware as the rest of your Spectrum system. For instructions on upgrading the MediaPort refer to “Upgrading the MediaPort Firmware” in the *Spectrum System Installation and Hardware Reference Guide*.

### Attaching the MediaPort to the Existing Players

Once you have installed the new MediaPort, use the Attach Devices feature in SystemManager to attach the MediaPort to the existing players.

**To attach the new MediaPort module to existing players:**

1. Open the **Player List** for the MediaPort, and then click the **Edit** link for any player that will use the new MediaPort.

**TIP:** To open the **Player List**, click the **Player Configuration** icon in the left-hand column, and then click the icon for your MediaPort.

2. For each track, click the **Attach Devices** button (within each track section) to display the **Attach Devices** page as shown in *Figure 10–8*.

   ![Attach devices to Track 1 (MPEG) on Player test.](image)

   **Figure 10–8: Attach Devices Page**

3. In the **Attach** column, click the check box for the device (MediaPort) that you wish to connect, and then click **Done**.

© 2014 Harmonic Inc. All rights reserved.
The **Edit Player** page appears. The ID of the new MediaPort will appear (in the following format: MIP-7NNN_XXXXX) next to the attached tracks.

**NOTE:** For help with modifying settings on either the Edit Player page or the Attach Devices page, refer to “Creating a Player” in the SystemManager User Guide.

4. Click **Done** to return to the **Player List** page.

Repeat steps 1-4 for each player that uses the new MediaPort.

**Activating Players**

Once you have completed the previous section, activate the players on your MediaPort.

To activate players:

1. From SystemManager, click the **Configuration** tab, then click the **Player Configuration** button in the left-hand column to view the **Player Configuration** window.
2. From the **Player Configuration** window, click the icon for the **MediaPort**. The **Player List** window appears, showing a list of players that reside on the selected MediaDeck.
3. Click the check boxes next to the Players you wish to activate and then click the **Activate Selected** button.

**Verifying Functionality**

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
Chapter 11
Spectrum MediaPort 5000

The following sections provide information to help you replace the MediaPort 5000 series.

Replacing the MediaPort

This section provides instructions for replacing a MediaPort chassis. Make sure to follow the procedures in this section in the order provided.

**CAUTION:** Observe all conventional ESD precautions when handling MediaPort components.

**NOTE:** The procedures in this section apply to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

Stopping Players that Use the MediaPort to be Replaced

Before removing a MediaPort, you must stop all players that use the MediaPort you wish to replace.

**NOTE:** In SystemManager, all MediaPort 5XX2 series appear as two separate MIP-5XX1 devices.

To stop players that use the MediaPort you wish to replace:

1. From SystemManager, click the **Player Configuration** button in the left-hand column to view the **Player Configuration** window.
2. From the **Player Configuration** window, click the icon for the MediaDirector connected to the MediaPort you wish to replace. The **Player List** window appears showing a list of players that reside on the selected MediaPort.
3. Click the check boxes next to the Players that use the MediaPort you wish to replace. Then click the **Deactivate Selected** button.
4. Verify which players use the MediaPort to be replaced by clicking the **Edit** link for each player, and then clicking **Attached Devices**. The **Device** column displays all attached devices.
5. Uncheck the **Attach** check box for the MediaPort to be replaced. Then click **Done**.
6. Repeat Step 5 for all tracks of the Player associated with that respective MediaPort.

**NOTE:** Once the new MediaPort is installed, you must attach the new device to the players, and then re-activate the players.

Verifying Which MediaPort to Remove

Use the Wink function to verify which MediaPort to remove.
Winking the MediaPort Module

To wink the MediaPort module:

1. From SystemManager, click the Configuration tab to display the Configuration page and System Diagram.
2. Click the icon for the MediaPort module you wish to wink. The Properties page appears.
3. From the General Information section of the page, view the Wink State.
   - If currently Off, click Wink On to start winking the status LED on the back of the MediaPort module.
   - If currently On, click Wink Off to stop winking the status LED on the back of the MediaPort module.

Removing the MediaPort from SystemManager

To remove the MediaPort from SystemManager:

1. Click the Diagnostics tab in SystemManager to display the Diagnostics page.
2. In the left-hand column, click the Remove Device icon to display the Remove Devices page (Figure 11–1).

   ![Figure 11–1: Remove Device](image)

3. Click Stop Monitoring to stop device monitoring. Once the “Current state of Device Monitoring” field displays NOT monitoring, continue to the next step. Note this may take a few minutes depending on the number of devices in your system.
4. Select one or more devices from one of the menus on the page.
5. Click the Remove button at the bottom of the menu, and then click OK to confirm. After a brief pause, a message appears indicating that the device has been removed (it has also been removed from the System Diagram).
6. Click Start Monitoring to resume device monitoring. Make sure the “Current state of Device Monitoring” field changes to monitoring.
NOTE: Device status may show Not Responding for a brief interval after monitoring has been turned back on.

Removing the MediaPort From the Rack

To remove the MediaPort from the rack:
1. Disconnect any cables from the MediaPort.
2. Remove the MediaPort from the rack.

Installing the Replacement MediaPort

To install the replacement MediaPort:
2. Connect any necessary cables to the MediaPort. Refer to the Spectrum System Installation and Hardware Reference Guide for complete instructions.

Changing the MediaPort Name in SystemManager

The replacement MediaPort will appear in SystemManager with the default name. To change the MediaPort name, follow the instructions in “Changing the MediaPort Name” in the SystemManager User Guide.

Upgrading MediaPort Firmware

Make sure that the replacement MediaPort is running the same version of firmware as the rest of your Spectrum system. For instructions on upgrading the MediaPort refer to “Upgrading the MediaPort Firmware” in the Spectrum System Installation and Hardware Reference Guide.

Attaching the MediaPort to the Existing Players

Once you have installed the new MediaPort module, use the Attach Devices feature in SystemManager to attach the MediaPort to the existing players.

To attach the new MediaPort module to existing players:
1. Open the Player List for the MediaPort, and then click the Edit link for any player that will use the new MediaPort.

TIP: To open the Player List, click the Player Configuration icon in the left-hand column, and then click the icon for your MediaPort.

2. For each track, click the Attach Devices button (within each track section) to display the Attach Devices page as shown in Figure 11–2.
3. In the **Attach** column, click the check box for the device (MediaPort) that you wish to connect, and then click **Done**.

   The **Edit Player** page appears. The ID of the new MediaPort will appear (in the following format: MIP-5NNN_XXXXX) next to the attached tracks.

   **NOTE:** For help with modifying settings on either the Edit Player page or the Attach Devices page, refer to “Creating a Player” in the SystemManager User Guide.

4. Click **Done** to return to the **Player List** page.
5. Repeat steps 1-4 for each player that uses the new MediaPort.

### Activating Players

Once you have completed the previous section, activate the players on your MediaPort.

**To activate players:**

1. From SystemManager, click the **Configuration** tab, then click the **Player Configuration** button in the left-hand column to view the **Player Configuration** window.
2. From the **Player Configuration** window, click the icon for the **MediaPort**. The **Player List** window appears, showing a list of players that reside on the selected MediaDeck.
3. Click the check boxes next to the Players you wish to activate, and then click the **Activate Selected** button.

### Verifying Functionality

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
The following sections provide information to help you replace the MediaPort 4010.

- Replacing the MediaPort

### Replacing the MediaPort

This section provides instructions for replacing a MediaPort.

**CAUTION:** Observe all conventional ESD precautions when handling MediaPort components.

**NOTE:** The procedures in this section apply to SystemManager version 5.30. If you are running a different version of SystemManager, some steps may vary. Refer to the SystemManager Release Notes for instructions on upgrading SystemManager.

### Stopping Players that Use the MediaPort to be Replaced

Before removing a MediaPort, you must stop all players that use the MediaPort you wish to replace.

**To stop players that use the MediaPort you wish to replace:**

1. From SystemManager, click the **Player Configuration** button in the left-hand column to view the **Player Configuration** window.
2. From the **Player Configuration** window, click the icon for the MediaDirector connected to the MediaPort you wish to replace. The **Player List** window appears showing a list of players that reside on the selected MediaPort.
3. Click the check boxes next to the Players that use the MediaPort you wish to replace. Then click the **Deactivate Selected** button.
4. Verify which players use the MediaPort to be replaced by clicking the **Edit** link for each player, and then clicking **Attached Devices**. The **Device** column displays all attached devices.
5. Uncheck the **Attach** check box for the MediaPort to be replaced. Then click **Done**.
6. Repeat **Step 5** for all tracks of the Player associated with that respective MediaPort.

**NOTE:** Once the new MediaPort is installed, you must attach the new device to the players, and then re-activate the players.

### Verifying Which MediaPort to Remove

Use the Wink function to verify which MediaPort to remove.

**Winking the MediaPort**

**To wink the MediaPort module:**

1. From SystemManager, click the **Configuration** tab to display the **Configuration** page and **System Diagram**.
2. Click the icon for the MediaPort you wish to wink. The **Properties** page appears.
3. From the General Information section of the page, view the Wink State.
4. From the General Information section of the page, view the Wink State.
   - If currently Off, click Wink On to start winking the status LED on the back of the MediaPort.
   - If currently On, click Wink Off to stop winking the status LED on the back of the MediaPort.

Removing the MediaPort from SystemManager

To remove the MediaPort from SystemManager:
1. Click the Diagnostics tab in SystemManager to display the Diagnostics page.
2. In the left-hand column, click the Remove Device icon to display the Remove Devices page (see Figure 12–1).

![Remove Device](image)

**Figure 12–1: Remove Devices**

3. Click Stop Monitoring to stop device monitoring. Once the “Current state of Device Monitoring” field displays NOT monitoring, continue to the next step. Note this may take a few minutes depending on the number of devices in your system.
4. Select one or more devices from one of the menus on the page.
5. Click the Remove button at the bottom of the menu, and then click OK to confirm. After a brief pause, a message appears indicating that the device has been removed (it has also been removed from the System Diagram).
6. Click Start Monitoring to resume device monitoring. Make sure the “Current state of Device Monitoring” field changes to monitoring.

**NOTE:** Device status may show Not Responding for a brief interval after monitoring has been turned back on.

Removing the MediaPort From the Rack

To remove the MediaPort from the rack:
1. Disconnect any cables from the MediaPort.
2. Remove the MediaPort from the rack.
Installing the Replacement MediaPort

To install the replacement MediaPort:
2. Connect any necessary cables to the MediaPort. Refer to the Spectrum Getting Started Guide for complete instructions.

Changing the MediaPort Name in SystemManager

Once you have installed it, the replacement MediaPort will appear in SystemManager with the default name. To change the MediaPort name, follow the instructions in “Changing the MediaPort Name” in the SystemManager User Guide.

Upgrading MediaPort Firmware

Make sure that the replacement MediaPort is running the same version of firmware as the rest of your Spectrum system. For instructions on upgrading the MediaPort refer to “Upgrading MediaPort Firmware” in the Spectrum Getting Started Guide.

Attaching the MediaPort to the Existing Players

Once you have installed the new MediaPort, use the Attach Devices feature in SystemManager to attach the MediaPort to the existing players.

To attach the new MediaPort to existing players:
1. Open the Player List for the MediaPort, and then click the Edit link for any player that will use the new MediaPort.

   TIP: To open the Player List, click the Player Configuration icon in the left-hand column, and then click the icon for your MediaPort.

2. For each track, click the Attach Devices button (within each track section) to display the Attach Devices page as shown in Figure 12–2.

Figure 12–2: Attach New Devices

3. In the Attach column, click the check box for the device (MediaPort) that you wish to connect, and then click Done.
The **Edit Player** page appears. The ID of the new MediaPort will appear (in the following format: MIP-4NNN_XXXXX) next to the attached tracks.

**NOTE:** For help with modifying settings on either the Edit Player page or the Attach Devices page, refer to “Creating a Player” in the *SystemManager User Guide*.

4. Click **Done** to return to the **Player List** page.
5. Repeat steps 1-4 for each player that uses the new MediaPort.

**Activating Players**

Once you have completed the previous section, activate the players on your MediaPort.

**To activate players:**

1. From SystemManager, click the **Configuration** tab, then click the **Player Configuration** button in the left-hand column to view the **Player Configuration** window.
2. From the **Player Configuration** window, click the icon for the **MediaPort**. The **Player List** window appears, showing a list of players that reside on the selected MediaDeck.
3. Click the check boxes next to the Players you wish to activate and then click the **Activate Selected** button.

**Verifying Functionality**

Harmonic recommends that you verify functionality of the replacement equipment in your Spectrum system before using it on air.
Appendix A
Contacting the Technical Assistance Center

Harmonic Global Service and Support has many Technical Assistance Centers (TAC) located globally but virtually co-located where our customers can obtain technical assistance or request on-site visits from the Regional Field Service Management team. The TAC operates a Follow-The-Sun support model to provide Global Technical Support anytime, anywhere, through a single case management and virtual telephone system. Depending on time of day, anywhere in the world, we will receive and address your calls or emails in one of our global support centers. The Follow-the-Sun model greatly benefits our customers by providing continuous problem resolution and escalation of issues around the clock.

Table A–1: For Distribution and Delivery (Legacy Harmonic) Products

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 or 408.490.6477</td>
<td><a href="mailto:support@harmonicinc.com">support@harmonicinc.com</a></td>
</tr>
<tr>
<td>EME</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+852.3713.9300</td>
<td><a href="mailto:hongkongtechsupport@harmonicinc.com">hongkongtechsupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>India</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Russia</td>
<td>+7.495.926.4608</td>
<td><a href="mailto:rusupport@harmonicinc.com">rusupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Africa</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Mainland China</td>
<td>+86.10.8391.3313</td>
<td><a href="mailto:chinatechsupport@harmonicinc.com">chinatechsupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>

Table A–2: For Production and Playout (Legacy Omneon and Rhozet) Products

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 or 408.490.6477</td>
<td><a href="mailto:omneon.support@harmonicinc.com">omneon.support@harmonicinc.com</a></td>
</tr>
<tr>
<td>EMEA</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:omneonemeasupport@harmonicinc.com">omneonemeasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+65.6542.0050</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Japan</td>
<td>+81.3.5565.6737</td>
<td><a href="mailto:japansupport@harmonicinc.com">japansupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>China - Mainland</td>
<td>+86.10.8391.3313</td>
<td><a href="mailto:chinasupport@harmonicinc.com">chinasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Russia and CIS</td>
<td>+7.495.926.4608</td>
<td><a href="mailto:rusupport@harmonicinc.com">rusupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>
The Harmonic Inc. support website is:
http://www.harmonicinc.com/content/technical-support

The Harmonic Inc. Distribution and Delivery product software downloads site is:
ftp://ftp.harmonicinc.com

The Harmonic Inc. Playout and Production software downloads site is:

The Harmonic Inc. corporate address is:
Harmonic Inc.
4300 North First St.
San Jose, CA 95134, U.S.A.
Attn: Customer Support

The corporate telephone numbers forHarmonic Inc. are:
Tel. 1.800.788.1330 (from the U.S. and Canada)
Tel. +1.408.542.2500 (outside the U.S. and Canada)
Fax. +1.408.542.2511
Appendix B
Safety and Regulatory Compliance Information

Legal Disclaimer: Information in this document is provided in connection with Harmonic products. Unless otherwise agreed in writing Harmonic products are not designed nor intended for any application in which the failure of the product could cause personal injury or death.

NOTE: The information in this appendix may apply to purchased products only.

Important Safety Instructions
This section provides important safety guidelines for operators and service personnel. Specific warnings and cautions are found throughout the guide where they apply, but may not appear here. Please read and follow the important safety information, noting especially those instructions related to risk of fire, electric shock or injury to persons. You must adhere to the guidelines in this document to ensure and maintain compliance with existing product certifications and approvals. In this document, we use “product,” “equipment,” and “unit” interchangeably.

This equipment generates, uses, and can radiate radio frequency energy. It may cause harmful interference to radio communications if it is not installed and used in accordance with the instructions in this manual. Operation of this equipment in a residential area is likely to cause harmful interference. If this occurs, the user will be required to correct the interference at his or her own expense.

In event of conflict between the information in this document and information provided with the product or on our website for a particular product, this product documentation takes precedence.

Safety Symbols & Translated Safety, Warning & Caution Instructions (English)
To avoid personal injury or property damage, before you begin installing or replacing the product, read, observe, and adhere to all the following safety instructions and information. Harmonic products and/or product packaging may be marked with the safety symbols used throughout this document, when it is necessary to alert operators, users, and service providers to pertinent safety instructions in the manuals.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| ![Warning](image) | **Installing or Replacing the Product Unit Warning**  
- Only trained and qualified service personnel should be allowed to install, replace, or service this unit (refer AS/NZS 3260 Clause 1.2.14.3 Service Personnel).  
- Read the installation instructions before connecting the system to the power source.  
- When installing or replacing the unit, always make the ground connection first and disconnect it last.  
- Installation of the unit must comply with local and national electrical codes.  
- This unit is intended for installation in restricted access areas. A restricted access area can be accessed only through the use of special tool, lock and key or other means of security.  
- Use only specified replacement parts.  
- Do not use this unit in or near water. Disconnect all AC power before installing any options or servicing the unit unless instructed to do so by this manual. |
| ![Warning](image) | **Rack Mount Warning**  
- To prevent bodily injury when mounting or servicing this unit in a rack, special precautions must be taken to ensure your safety and stability of system:  
  - Conform to local occupational health and safety requirements when moving and lifting the equipment.  
  - Ensure that mounting of the unit by mechanical loading tools should not induce hazardous conditions.  
  - To avoid risk of potential electric shock, a proper safety ground must be implemented for the rack and each piece of equipment installed on it. |
| ![Warning](image) | **Chassis Warning**  
- Before connecting or disconnecting ground or power wires to the chassis, ensure that power is removed from the DC circuit.  
- To prevent personal injury or damage to the chassis, lift the unit only by using handles that are an integral part of the chassis, or by holding the chassis underneath its lower edge.  
- Any instructions in this guide that require opening the chassis or removing a board should be performed by qualified service personnel only.  
- Slots and openings in the chassis are provided for ventilation. Do not block them. Leave the back of the frame clear for air exhaust cooling and to allow room for cabling - a minimum of 6 inches (15.24 cm) of clearance is recommended. |
### Appendix B Safety and Regulatory Compliance

<table>
<thead>
<tr>
<th>Mark</th>
<th>Electric Shock Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="electric_shock_warning" alt="Warning" /></td>
<td>- This unit might have more than one power cord. To reduce the risk of electric shock, disconnect the two power supply cords before servicing the unit.</td>
</tr>
<tr>
<td></td>
<td>- Before working on a chassis or working near power supplies, unplug the power cord on AC units.</td>
</tr>
<tr>
<td></td>
<td>- Do not work on the system or connect or disconnect cables during periods of lightning activity.</td>
</tr>
<tr>
<td></td>
<td>- This unit is grounded through the power cord grounding conductor. To avoid electric shock, plug the power cord into a properly wired receptacle before connecting the product input or outputs.</td>
</tr>
<tr>
<td></td>
<td>- Route power cords and other cables so that they are not likely to be damaged. Disconnect power input to unit before cleaning. Do not use liquid or aerosol cleaners; use only a damp cloth to clean chassis.</td>
</tr>
<tr>
<td></td>
<td>- Dangerous voltages exist at several points in this product. To avoid personal injury, do not touch exposed connections and components while power is on. Do not insert anything into either of the system's two power supply cavities with power connected.</td>
</tr>
<tr>
<td></td>
<td>- Never install an AC power module and a DC power module in the same chassis.</td>
</tr>
<tr>
<td></td>
<td>- Do not wear hand jewelry or watch when troubleshooting high current circuits, such as the power supplies.</td>
</tr>
<tr>
<td></td>
<td>- To avoid fire hazard, use only the specified correct type voltage and current ratings as referenced in the appropriate parts list for this unit. Always refer fuse replacement to qualified service personnel.</td>
</tr>
<tr>
<td></td>
<td>- This unit relies on the building's installation for short-circuit (overcurrent) protection. Ensure that a fuse or circuit breaker no larger than 120 VAC, 15A U.S. (240 VAC, 10A internationally) is used on the phase conductors (all current-carrying conductors).</td>
</tr>
<tr>
<td></td>
<td>- To avoid electrocution ensure that the rack has been correctly grounded before switching on the unit. When removing the unit remove the grounding connection only after the unit is switched off and unplugged.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mark</th>
<th>Electrostatic Discharge (ESD) Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="esd_caution" alt="Caution" /></td>
<td>- Follow static precaution at all times when handling this unit.</td>
</tr>
<tr>
<td></td>
<td>- Always wear an ESD-preventive wrist or ankle strap when handling electronic components. Connect one end of the strap to an ESD jack or an unpainted metal component on the system.</td>
</tr>
<tr>
<td></td>
<td>- Handle cards by the faceplates and edges only; avoid touching the printed circuit board and connector pins.</td>
</tr>
<tr>
<td></td>
<td>- Place any removed component on an antistatic surface or in a static shielding bag.</td>
</tr>
<tr>
<td></td>
<td>- Avoid contact between the cards and clothing.</td>
</tr>
<tr>
<td></td>
<td>- Periodically check the resistance value of the antistatic strap. Recommended value is between 1 and 10 mega-ohms (Mohms).</td>
</tr>
<tr>
<td>Mark</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td><img src="image" alt="Laser Radiation Warning" /></td>
<td><strong>Laser Radiation Warning</strong>&lt;br&gt;Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into beams or view directly with optical instruments. Never operate a unit with a broken fibre or with a separated fiber connector.</td>
</tr>
<tr>
<td><img src="image" alt="Lithium Battery Handling Safety Instructions" /></td>
<td><strong>Lithium Battery Handling Safety Instructions</strong>&lt;br&gt;¬ CALIFORNIA PERCHLORATE ADVISORY: Some lithium batteries may contain perchlorate material. The following advisory is provided: &quot;Perchlorate Material - special handling may apply, see: <a href="http://www.dtsc.ca.gov/hazardous_waste/perchlorate/">www.dtsc.ca.gov/hazardous_waste/perchlorate/</a> for information&quot;.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>¬ Risk of explosion if battery is replaced incorrectly or with an incorrect type&lt;br&gt;¬ Dispose of used batteries according to the manufacturer’s instructions&lt;br&gt;¬ There are no user-serviceable batteries inside Harmonic products. Refer to Harmonic qualified personnel only to service the replaceable batteries</td>
</tr>
</tbody>
</table>

**Symboles de sécurité et traduits de sécurité, d'avertissement et Attention Instructions (français)**

Pour éviter des blessures ou des dommages matériels, avant de commencer l'installation ou le remplacement du produit, lire, observer, et de respecter toutes les instructions et informations de sécurité suivantes. Produits harmoniques et / ou l'emballage du produit peuvent être marqués avec les symboles de sécurité utilisés dans le présent document, lorsque cela est nécessaire pour alerter les opérateurs, les utilisateurs et les fournisseurs de services de consignes de sécurité pertinentes dans les manuels.
### Avertissement

#### Installation ou remplacement de l'unité de produit

- Il est vivement recommandé de confier l'installation, le remplacement et la maintenance de ces équipements à des personnels qualifiés et expérimentés. (voir AS / NZS 3260 article 1.2.14.3 du personnel de service).
- Avant de brancher le système sur la source d'alimentation, consulter les directives d'installation.
- Lors de l'installation ou le remplacement de l'appareil, la mise à la terre doit toujours être connectée en premier et déconnectée en dernier.
- L'équipement doit être installé conformément aux normes électriques nationales et locales.
- Cet appareil est à installer dans des zones d'accès réservé. Ces dernières sont des zones auxquelles seul le personnel de service peut accéder en utilisant un outil spécial, un mécanisme de verrouillage et une clé, ou tout autre moyen de sécurité.
- Utilisez uniquement des pièces de rechange spécifiées.
- Ne pas utiliser ce produit dans l'eau ni à proximité de l'eau. Débrancher toutes les prises d'alimentation secteur avant d'installer des options ou d'effectuer l'entretien de l'unité, à moins d'instructions contraires dans le présent manuel.

#### Rack Monture

Pour éviter les blessures corporelles lors du montage ou l'entretien de cet appareil dans un rack, des précautions particulières doivent être prises pour assurer votre sécurité et la stabilité du système:

- Conformez-vous aux exigences de médecine du travail et de sécurité lorsque vous déplacez et soulevez le matériel.
- Assurez-vous que le montage de l'appareil par des outils de chargement mécaniques ne doit pas induire des conditions dangereuses.
- Pour éviter tout risque d'électrocution, le rack et chaque élément de l'équipement installé dans le rack doivent être correctement reliés à la terre.

#### Châssis

- Avant de connecter ou de déconnecter les câbles d'alimentation (pôles et terre) du châssis, vérifiez que le circuit de courant continu est hors tension.
- Pour éviter toute blessure ou des dommages au châssis, soulevez l'unité uniquement par les poignées du châssis lui-même ou en portant celui-ci par le bord inférieur.
- Toutes les opérations du présent guide nécessitant l'ouverture du châssis ou le retrait d'une carte doivent être uniquement effectuées par du personnel d'entretien qualifié.
- Le châssis est muni de fentes et d'ouvertures d'aération. Ne pas les bloquer. Dégager l'arrière du cadre pour permettre le refroidissement de l'évacuation d'air et laisser de la place au câblage; un dégagement d'au moins 15.24 cm (6 po) est recommandé.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Avertissement</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning Symbol" /></td>
<td>Choc électrique Avertissement</td>
<td>Il est possible que cette unité soit munie de plusieurs cordons d'alimentation. Pour éviter les risques d'électrocution, débrancher les deux cordons d'alimentation avant de réparer l'unité.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Avant de travailler sur un châssis ou à proximité d'une alimentation électrique, débrancher le cordon d'alimentation des unités en courant alternatif.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ne pas travailler sur le système ni brancher ou débrancher les câbles pendant un orage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ce unité est mis à la terre par le conducteur de protection intégré au cordon d'alimentation. Pour éviter les chocs électriques, brancher le cordon d'alimentation dans une prise correctement cable avant de raccorder les entrées ou sorties du unité.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Installer les cordons d'alimentation et autres cables de sorte qu'ils ne risquent pas d'être endommagés. Couper l'alimentation avant nettoyage. Ne pas utiliser de nettoyant liquide ou en aérosol; utiliser seulement un linge humide.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Des courants électriques dangereux circulent dans cet appareil. Afin d'éviter les lessures, ne pas toucher les connexions et composants exposés lorsque l'appareil est sous tension. Ne rien insérer dans l'une ou l'autre des cavités des prises de courant du système lorsque l'appareil est sous tension.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N'installez jamais un module d'alimentation AC et un module d'alimentation DC dans le même châssis.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ne pas porter de bijoux aux mains ni de montre durant le dépannage des circuits à haute tension, comme les transformateurs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pour prévenir les risques d'incendie, n'utiliser que le type, la tension et le courant nominal spécifiés dans la nomenclature des pièces de ce unité. Toujours confier le remplacement des fusibles à du personnel d'entretien qualifié.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pour ce qui est de la protection contre les courts-circuits (surtension), ce produit dépend de l'installation électrique du local. Vérifier qu'un fusible ou qu'un disjoncteur de 120 V alt., 15 A U.S. maximum (240 V alt., 10 A international) est utilisé sur les conducteurs de phase (conducteurs de charge).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pour éviter l'électrocution, assurez-vous que le rack a bien été mis à la terre avant de mettre l'unité en marche. Lors du retrait de l'unité, retirer le raccordement de terre seulement après avoir mis l'unité à l'arrêt et l'avoir débranchée.</td>
</tr>
<tr>
<td>Mark</td>
<td>Les décharges électrostatiques (ESD) Attention</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Respecter systématiquement les précautions relatives aux charges électrostatiques durant la manipulation de cet unité.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Portez toujours un poignet ou la cheville bracelet antistatique préventive lors de la manipulation des composants électroniques. Branchez une extrémité de la sangle à une prise ESD ou d'un composant métallique non peinte sur le système.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Manipulez les cartes en les faces avant et les bords seulement; éviter de toucher la carte de circuit imprimé et les broches du connecteur.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Placer un composant retiré sur une surface antistatique ou dans un sac de protection statique.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Éviter tout contact entre les cartes et les vêtements.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Vérifier périodiquement la valeur de résistance de la sangle antistatique. Valeur recommandée est comprise entre 1 et 10 mégao-ohms (Mohms).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mark</th>
<th>Rayonnement laser Attention</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Rayonnement laser invisible peut être émis à partir de fibres ou les connecteurs débranchés. Ne pas regarder en faisceaux ou regarder directement avec des instruments optiques. Ne jamais faire fonctionner une unité en cas de bris d'une fibre ou de séparation d’un connecteur de fibre.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mark</th>
<th>Batterie au lithium Manipulation instructions de sécurité</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Perchlorate pour la Californie Consultatif: Certaines batteries au lithium, peuvent contenir du perchlorate. Le texte qui suit consultatif est prévu: “Présence de perchlorate - une manipulation spéciale peut s’appliquer, voir: [<a href="http://www.dtsc.ca.gov/hazardous">www.dtsc.ca.gov/hazardous</a> waste/perchlorate/](<a href="http://www.dtsc.ca.gov/hazardous">http://www.dtsc.ca.gov/hazardous</a> waste/perchlorate/) for information”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mark</th>
<th>Attention</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Il y a danger d’explosion si la batterie est remplacée de manière incorrecte ou par une batterie de type incorrect.</td>
</tr>
<tr>
<td></td>
<td>■ Mettre au rebut les batteries usagées conformément aux instructions du fabricant.</td>
</tr>
<tr>
<td></td>
<td>■ Les batteries des produits Harmonic ne peuvent pas être réparées ni entretenues par l’utilisateur. Ne confier l’entretien des batteries remplaçables qu’à du personnel compétent de Harmonic.</td>
</tr>
</tbody>
</table>

**Sicherheit Symbole und übersetzt Sicherheit, Achtung & Vorsicht Anleitung (Deutsch)**

Um Verletzungen oder Sachschäden zu vermeiden, bevor Sie mit der Installation oder Austausch des Produkts zu beginnen, zu lesen, zu beobachten, und sich an all den folgenden Sicherheitshinweise und Informationen. Harmonic Produkte und / oder Produktverpackungen können mit den Sicherheitssymbole in diesem Dokument verwendet werden, markiert, wenn es notwendig ist für die Betreiber, Anwender und Dienstleister, um relevante Sicherheitsanweisungen in den Handbüchern zu alarmieren.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| ![Warning Symbol] | **Installation oder den Austausch des Produkts Einheit Warnung**  
- Das Installieren, Ersetzen oder Bedienen dieser Ausrüstung sollte nur geschultem, qualifiziertem Personal gestattet werden (siehe AS / NZS 3260 Clause 1.2.4.3 Servicepersonal)  
- Lesen Sie die Installationsanweisungen, bevor Sie das System an die Stromquelle anschließen.  
- Der Erdanschluß muß bei der Installation der Einheit immer zuerst hergestellt und zuletzt abgetrennt werden.  
- Die Installation der Geräte muss den Sicherheitsstandards entsprechen.  
- Verwenden Sie nur die angegebenen Ersatzteile  
| ![Warning Symbol] | **Rack-Montage-Warnung**  
Zur Vermeidung von Körpervorsorgung beim Anbringen oder Warten dieser Einheit in einem Gestell müssen Sie besondere Vorkehrungen treffen, um sicherzustellen, daß das System stabil bleibt:  
- Entspricht den lokalen Arbeitsschutzvorschriften beim Bewegen und Heben der Ausrüstung.  
- Stellen Sie sicher, dass die Montage des Gerätes durch mechanische Belastung Werkzeuge nicht gefährlichen Bedingungen zu induzieren.  
- Um das Risiko von möglichen elektrischen Schlag zu vermeiden, muss mit einer angemessenen Erdung für Rack und jedes Gerät installiert ist implementiert werden. |
| ![Warning Symbol] | **Chassis Warnung**  
- Gleichstrom-Unterbrechung Bevor Sie Erdungs- oder Stromkabel an das Chassis anschließen oder von ihm abtrennen, ist sicherzustellen, daß der Gleichstrom-Stromkreis unterbrochen ist.  
- Um Verletzungen und Beschädigung des Chassis zu vermeiden, sollten Sie das Chassis nicht an den Henkeln auf den Elementen (wie z.B. Stromanschlüsse, Kühlungen oder Karten) heben oder kippen; oder indem Sie es unterhalb der Unterkante packen.  
- Alle Hinweise in diesem Handbuch, die das Öffnen benötigen Sie das Gehäuse oder das Entfernen eines Board sollte nur von qualifiziertem Fachpersonal durchgeführt werden.  
Warnung

**Elektroschock-Warnung**

- Diese Einheit hat möglicherweise mehr als ein Netzkabel. Zur Verringerung der Stromschlaggefahr trennen Sie beide Netzgerätekabel ab, bevor Sie die Einheit warten.
- Vor der Arbeit an einem Chassis für Arbeiten in der Nähe Stromversorgung, ziehen Sie das Netzkabel mit Netzeinheiten.
- Arbeiten Sie nicht am System und schließen Sie keine Kabel an bzw. trennen Sie keine ab, wenn es gewittert.
- Dieses Gerät ist über das Netzkabel Erdungsleiter geerdet. Um einen Stromschlag zu vermeiden, stecken Sie das Netzkabel in eine Steckdose richtig verdrahtet, bevor Sie das Produkt Eingang oder Ausgänge.
- Verlegen Sie Netzkabel und andere Kabel, so dass sie wahrscheinlich nicht beschädigt werden. Trennen Eingangsleistung Einheit vor der Reinigung. Verwenden Sie keine flüssigen oder Aerosolreiniger; nur mit einem feuchten Tuch zu reinigen Chassis.
- Ein Wechselstromsmodul und ein Gleichstrommodul dürfen niemals in demselben Chassis installiert werden.
- Tragen Sie keine Hand Schmuck oder schauen Sie bei der Fehlersuche hohen Stromkreise, wie beispielsweise die Stromversorgung.
- Um die Brandgefahr zu vermeiden, verwenden Sie nur den genannten richtige Art von Spannung und Strom Ratings als in der entsprechenden Stückliste für diese Einheit verwiesen. Beziehen sich immer auf Austausch der Sicherung von qualifiziertem Fachpersonal.
- Um einen Stromschlag zu vermeiden, sicherzustellen, dass die Zahnstange wurde korrekt vor dem Einschalten des Gerätes geerdet. Beim Entfernen der Einheit entfernen Sie die Massverbindung nur, nachdem das Gerät ausgeschaltet und der Netzstecker gezogen.
Appendix B Safety and Regulatory Compliance

Site Preparation Instructions

NOTE: Only trained and qualified service personnel (as defined in IEC 60950 and AS/NZS 3260) should install, replace, or service the equipment. Install the system in accordance with the U.S. National Electric Code if you are in the United States.

1. Preparing & Choosing a Site for Installation
   - To ensure normal system operation, plan your site configuration and prepare the site before installation.
   - Install the unit in a restricted access area.

### Site Preparation Instructions

<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Elektrostatische Entladung (ESD) Vorsicht</strong></td>
<td>Folgen Sie statische vorsorglich zu jeder Zeit beim Umgang mit diesem Gerät.</td>
</tr>
<tr>
<td></td>
<td>Hand Karten nur durch die Faceplates und Kanten; Berühren Sie die bedruckte Leiterplatte und Steckerstifte.</td>
</tr>
<tr>
<td></td>
<td>Legen Sie alle entfernten Komponenten auf eine antistatische Oberfläche oder in einem Statik-Beutel.</td>
</tr>
<tr>
<td></td>
<td>Kontakt zwischen den Karten und Kleidung vermeiden.</td>
</tr>
<tr>
<td></td>
<td>Den Widerstandswert der gegen statische Gurt in regelmäßigen Abständen überprüfen. Empfohlener Wert ist zwischen 1 und 10 Mega-Ohm (MΩ).</td>
</tr>
</tbody>
</table>


| **Vorsich** | **Bei Einsetzen einer falschen Batterie besteht Explosionsgefahr** |
| | **Entsorgen Sie die benutzten Batterien nach den Anweisungen des Herstellers.** |
| | **Es gibt keine zu wartenden Akkus im Harmonic Produkte. Siehe Harmonic qualifiziertes Personal, um die austauschbare Batterien Service** |
1. Site Preparation Instructions

- Choose a site with a dry, clean, well-ventilated and air-conditioned area.
- Choose a site that maintains an ambient temperature of 32 to 104°F (0 to 40°C).

2. Creating a Safe Environment

- Connect AC-powered systems to grounded power outlets or as per local regulations.
- Do not move or ship equipment unless it is correctly packed in its original wrapping and shipping containers.
- Only allow Harmonic trained personnel to undertake equipment service and maintenance. Do not permit unqualified personnel to operate the unit.
- Wear ear protection when working near an NSG Pro platform for a longer period of time.

3. Rack Mounting the Unit

- Install the system in an open rack whenever possible. If installation in an enclosed rack is unavoidable, ensure that the rack has adequate ventilation.
- Reliable earthing of rack-mounted equipment should be maintained. Particular attention should be given to supply connections other than direct connections to the branch circuit (e.g. use of power strips). This unit should be mounted at the bottom of the rack if it is the only unit in the rack.
- When mounting this unit in the partially filled rack, load the rack from the bottom to the top with the heaviest component at the bottom of the rack.
- If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in the rack.
- The rack must be anchored to an immovable support to prevent it from tipping when the unit is mounted on it. The rack must be installed according to the rack manufacturer’s instructions.
- Disconnect all power and external cables before lifting the unit. Depending on the weight of the unit, more than one person might be required to lift it.

4. Power Considerations

a. AC Power

- Adding to the system a UPS (Uninterrupted Power Supply) and an AVR (Automated Voltage Regulator) is highly recommended.
- Installing the main power supply by a qualified electrician, according to power authority regulations. Make sure all powering are wired with an earth leakage, according to local regulations.
- It is recommended to install the encoder within 1.5m (approximately 5 feet) from an easily accessible grounded AC outlet.
- When the encoder is rack-mounted, ensure that the rack is correctly grounded.

b. DC Power

- Ensure a suitable overcurrent device is in-line between the equipment and the power source.
- Connect DC-input power supplies only to a DC power source that complies with the safety extra-low voltage (SELV) requirements in the UL60950-1, CAN/CSA-C22.2 No. 60950-1-03, AS/NZS 60950-1, EN/IEC 60825-1, 21 CFR 1040, EN 60950-1, and IEC 60950-1 standards.
- Ensure that power is removed from the DC circuit before installing or removing power supplies.

5. Handling Fiber Channel Cables

- Always read and comply with the handling instructions on the shipping container.
- Follow all ESD precautions and approved fiber cleaning procedures.
The fiber is made of a very pure, expensive glass and should be treated with great care. Handle fibers only in areas that are very clean and do not contain sharp objects.

Wear finger cots or gloves as dirt and oils can damage the fiber and contaminate connectors.

Do not allow kinks or knots to develop in the fiber. If tangles occur, carefully work out the tangles avoiding pulling or bending the fibre beyond its bend radius.

Always use the correct tools for stripping and cleaving the fiber. It will save time and reduce breakage caused by scratches.

If you must secure a bundle of fiber cables together, avoid plastic and metal tie wraps; secure with velcro instead.

6. Disposing of the Unit
   Dispose of the unit and its components (including batteries) as specified by all national laws and regulations.

Product End-of-Life Disassembly Instructions

For disassembly instructions, please call the technical support in order to remove components requiring selective treatment, as defined by the EU WEEE Directive (2012/19/EU). See Contacting the Technical Assistance Center.

Product Disassembly Process

1. Disassemble equipment at a dedicated area only, gather the needed tools for disassembly.
2. Remove covers, housing, etc.
3. Remove and separate sub-assemblies (i.e. cables, metals, displays, fans, etc.).
4. Separate hazardous materials from the remainder of the material.
   a. Sort hazardous materials into their different types (i.e., batteries, hazardous liquids, hazardous solids, fiberglass, etc.).
   b. Proceed with hazardous waste management processes only.
5. Identify re-usable materials/sub-assemblies and separate these from the rest of the material.
6. Identify and separate recyclable materials as per below examples:
   a. Scrap material to be sent to smelter(s).
   b. E-waste such as displays, CPU’s, cables and wires, hard drives, keyboards, etc.
   c. Metals such as steel, brass, and aluminum.
   d. Plastics such as fan casings, housings, covers, etc.
   e. Fiber optics and plastic tubing not containing electrical or data wiring.

Safety Rules (English)

Recycler personnel are to wear personal protective equipment including proper eye protection, proper hand protection, and proper breathing protection if needed.

Recycler personnel shall be experienced with using the proper tools required for disassembling equipment. Untrained personnel shall not disassemble Harmonic products. Unfamiliarity with tools can cause damage and injury.

Règles de sécurité (French)

Le personnel du recycleur doit porter de l’équipement de protection individuelle, y compris des lunettes, des gants et un masque de protection appropriés au besoin.
Le personnel du recycleur doit avoir de l'expérience des outils de démontage de l'appareil. Les produits Harmonic ne doivent pas être démontés par du personnel non qualifié. Une mauvaise connaissance des outils peut causer des dommages et des blessures.

**EU Manufacturer's Declaration of Conformity**

This equipment is in compliance with the essential requirements and other provisions of Directives 73/23/EEC and 89/336/EEC as amended by Directive 93/68/EEC.

**NOTE:** For specifics, about which standards have been applied, refer to the Declaration of Conformity of the product on Harmonic website at [Product Regulatory Compliance](http://www.harmonicinc.com) or contact Harmonic Compliance Team at regulatory.compliance@harmonicinc.com

**Electromagnetic Compatibility Notices – Class A**

a. **FCC Verification Statement (USA)**

   This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

   This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case users will be required to correct the interference at their own expense.

   Connections between the Harmonic equipment and other equipment must be made in a manner that is consistent with maintaining compliance with FCC radio frequency emission limits. Modifications to this equipment not expressly approved by Harmonic may void the authority granted to the user by the FCC to operate this equipment and you may be required to correct any interference to radio or television communications at your own expense.

b. **ICES–003 Statement (Canada)**

   **English:** This Class A digital apparatus complies with Canadian ICES-003.

   **French:** Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

c. **CE Declaration of Conformity (European Union)**

   This product has been tested in accordance too, and complies with the Low Voltage Directive (2014/30/EU) and EMC Directive (2014/35/EU). The product has been marked with the CE Mark to illustrate its compliance.
Appendix B Safety and Regulatory Compliance

Information

Electromagnetic Compatibility Notices – Class A

d. VCCI Class A Warning (Japan)

この装置は、情報処理装置等電波障害自主規制協議会（VCCI）の基準に基づくクラスA情報技術装置です。この装置を家庭環境で使用すると電波妨害を引き起こすことがあります。この場合には使用者が適切な対策を講ずるよう要求されることがあります。

English translation of the notice above:
This is a Class A product based on the standard of the Voluntary Control Council for Interference (VCCI) from Information Technology Equipment. If this equipment is used in a domestic environment, it may cause radio interference. When such trouble occurs, the user may be required to take corrective actions.

e. BSMI EMC Notice (Taiwan)

警告使用者：
這是甲類的資訊產品，在居住的環境中使用時，
可能會造成射頻干擾，在這種情況下，使用者會
被要求採取某些適當的對策

English translation of the notice above:
This is a Class A Information Product, when used in residential environment, it may cause radio frequency interference, under such circumstances, the user may be requested to take appropriate counter measures.

f. Class A Warning (Korea)

주의 A급 기기 이 기기는 업무용으로 제작되었습니
또한 판매자 또는 사용자는 이 점을 주의하셔기 바라며 만약
 잘못 판매 또는 구입하였을 때에는 가정용으로 교환하시기 바랍니다.

English translation of the notice above:
This is a Class A device and is registered for EMC requirements for industrial use. The seller or buyer should be aware of this. If this was sold or purchased by mistake, it should be replaced with a residential-use type.

g. Class A Statement (China)

中华人民共和国“A类”警告声明

声明
此为A级产品，在生活环境巾，该产品可能会造成无线电干扰，在这种情况下，
可能需要用户对其干扰采取切实可行的措施。

English translation of the notice above:
When labeled with the CCC marking, the product meets the applicable safety and EMC requirements for China. This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures.

h. Class A Warning – CISPR 22 (AS/NZS)

Warning (English)

This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

Attention (French)

Il s’agit d’un produit de classe A. Dans un environnement local, ce produit peut entraîner des perturbations radioélectriques, auquel cas l’utilisateur devra éventuellement prendre des mesures adéquates.

Product Regulatory Compliance

Harmonic products are typically tested to the latest safety and electromagnetic compatibility (EMC) specifications and test methods, and are marked with one or more of the following regulatory/certification markings. Some of the certification markings will vary depending on what certifier was used to obtain a certification.

Please visit Harmonic Product Regulatory Compliance page to view information on applied safety & EMC standards and regulatory marks on Harmonic products. You can also email us at regulatory.compliance@harmonicinc.com for assistance on regulatory compliance for Harmonic products.

Product Regulatory Compliance Markings

Table 12–1: Regulatory Compliance Markings

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Testing Standard/Specification</th>
<th>Certification Type</th>
<th>Regulatory Mark Name</th>
<th>Product Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA/Canada</td>
<td>EN 60950-1:2006+A11:2009+A1:2010+A12:2011; CAN/CSA C22.2 No. 60950-1-07+A1:2011/UL 60950-1:2011</td>
<td>Safety</td>
<td>NRTL (National Recognized Test Laboratory)</td>
<td><img src="image" alt="UL Listed" /> or <img src="image" alt="cTUVus" /></td>
</tr>
<tr>
<td>USA/Canada</td>
<td>FCC CFR 47 Part 15, Class A, ICES-003: Issue 5, 2012; Class A</td>
<td>EMC</td>
<td>FCC Class A Statement</td>
<td><img src="image" alt="This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation." /></td>
</tr>
</tbody>
</table>
### Table 12–1: Regulatory Compliance Markings

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Testing Standard/Specification</th>
<th>Certification Type</th>
<th>Regulatory Mark Name</th>
<th>Product Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>EN 60950-1; EN60825-1 (for laser)</td>
<td>Safety</td>
<td>GS</td>
<td><img src="image" alt="GS" /></td>
</tr>
<tr>
<td>Mexico</td>
<td>NOM-019-SCFI-1998</td>
<td>Safety</td>
<td>NOM</td>
<td><img src="image" alt="NOM" /></td>
</tr>
<tr>
<td>Taiwan</td>
<td>CNS 14336-1:2010 CNS 13438:2006; Class A</td>
<td>Safety and EMC</td>
<td>BSMI Certification (RPC Number &amp; Class A Warning)</td>
<td><img src="image" alt="BSMI" /></td>
</tr>
<tr>
<td>Japan</td>
<td>VCCI V-3/2013.04; CISPR 22:2008, Class A</td>
<td>EMC</td>
<td>VCCI</td>
<td><img src="image" alt="VCCI" /></td>
</tr>
<tr>
<td>Australia and New Zealand</td>
<td>AS/NZS CISPR22:2009+A1:2010; Class A</td>
<td>Safety</td>
<td>C-Tick</td>
<td><img src="image" alt="C-Tick" /></td>
</tr>
<tr>
<td>Korea</td>
<td>KN22 Class A and KN24</td>
<td>EMC</td>
<td>KC</td>
<td><img src="image" alt="KC" /></td>
</tr>
</tbody>
</table>
Appendix B Safety and Regulatory Compliance

Product Environmental Compliance

Harmonic manufactures high quality and innovative IT and telecommunications equipment, video delivery infrastructure solutions and services for its customers worldwide. Harmonic is committed to providing our customers with safe and environmentally friendly products that are compliant with all relevant regulations, customer specifications, and environmental legislation, including the directives described below.

EU RoHS

In July 2006, the European Union’s (EU) Directive (2002/95/EC) on the Restriction of the use of certain Hazardous Substances (RoHS) in Electrical and Electronic Equipment (EEE) went into effect, and in July, 2011, the European Union’s RoHS Recast Directive (2011/65/EU) also known as RoHS II entered into force.

Harmonic understands the environmental risks associated with the substances covered by the RoHS Directive and has committed to eliminating or reducing the use of these, as well as other environmentally sensitive substances in our products. Harmonic also continues to comply with the requirements under RoHS II.

For more information, please visit EU RoHS directive page at official EU website.


Restricted Substance Statement

Harmonic products contain less than the permitted limits for the six restricted substances except where exemptions published in the RoHS2 Directive are applicable. This statement is based on vendor-supplied analysis or material certifications, and/or lab test results of the component raw materials used in the manufacture of Harmonic products.

Table 12–2: Restricted Substances

<table>
<thead>
<tr>
<th>Restricted Substance</th>
<th>Permitted Limit*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadmium (Cd)</td>
<td>( \leq 0.01% )</td>
</tr>
<tr>
<td>Lead (Pb)</td>
<td>( \leq 0.1% )</td>
</tr>
<tr>
<td>Chromium (VI) (Cr (VI))</td>
<td>( \leq 0.1% )</td>
</tr>
<tr>
<td>Mercury (Hg)</td>
<td>( \leq 0.1% )</td>
</tr>
</tbody>
</table>
Appendix B Safety and Regulatory Compliance

Information

EU REACH

REACH (Registration, Evaluation, Authorization and restriction of Chemicals) (EC 1907/2006) is a European Union’s regulation on chemicals and their safe use which came into force in June, 2007. Harmonic supports the basic aim of REACH in improving the protection of human health and environment through the better and earlier identification of intrinsic properties of chemical substances. Harmonic products are considered “articles” under REACH; therefore, we are required to provide recipients of our products with information on Substance of Very High Concern (SVHC) present in concentration above 0.1% (w/w).

Substances in our products are not intended to be released under normal or reasonably foreseeable conditions of use; therefore, the registration requirement in REACH Article 7(1) does not apply to our products.

For more information, please visit REACH regulation page at official EU website.

http://ec.europa.eu/environment/chemicals/reach/reach_en.htm

China RoHS

China’s regulation on restriction of the use of certain hazardous substances commonly (China RoHS), is applicable to all Electronic and Information Products (EIPs) and parts sold in China after March 01, 2007. China RoHS regulation restricts the use of the same six substances as the European Union’s ROHS, but has requirements for product labeling and regulated substance information disclosure.

Harmonic complies with China RoHS Phase I for labeling and information disclosure requirements and continues to monitor new developments in China RoHS Phase II towards substance restriction and certification program.

For more information, please visit China RoHS regulation page at official US export website.

http://www.export.gov/china/doingbizinchina/

---

**Table 12–2: Restricted Substances**

<table>
<thead>
<tr>
<th>Restricted Substance</th>
<th>Permitted Limit*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polybrominated biphenyls (PBBs)</td>
<td>( \leq 0.1% )</td>
</tr>
<tr>
<td>Polybrominated diphenyl ether (PBDE)</td>
<td>( \leq 0.1% )</td>
</tr>
</tbody>
</table>

*Homogeneous material definition as per the EU Directive.
## China RoHS Disclosure Report

Below table shows the presence of hazardous substances, or elements in Harmonic products, if the part is present.

This table shows those components where hazardous substances may be found in Harmonic products based on, among other things, material content information provided by third party suppliers. These components may or may not be part of the product.

除非特殊注明，哈雷公司产品的环保使用期限均为 20 年。该环保使用期限的有效条件为：必须遵循该产品使用手册的规定，对该产品进行使用或储存。

The Environmental Protective Use Period for Harmonic products is 20 years unless displayed otherwise on the product. The EPLP period is valid only when the products are operated or stored as per the conditions specified in the product manual.

<table>
<thead>
<tr>
<th>部件名称 (Part name)</th>
<th>有毒有害物质或元素 (Hazardous Substance)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>钠 (Pb)</td>
</tr>
<tr>
<td>打印电路板 (Printed Circuit Assemblies)</td>
<td>X</td>
</tr>
<tr>
<td>机械组件 (Mechanical Subassemblies)</td>
<td>X</td>
</tr>
<tr>
<td>光学组件 (Optical Subassemblies)</td>
<td>X</td>
</tr>
<tr>
<td>电源 (Power Supplies)</td>
<td>X</td>
</tr>
<tr>
<td>缆线 / 线束 (Cables, harnesses)</td>
<td>X</td>
</tr>
<tr>
<td>屏幕 / 显示器 (Screens, Monitors)</td>
<td>X</td>
</tr>
<tr>
<td>金属零件 (Metal Parts)</td>
<td>X</td>
</tr>
<tr>
<td>塑料 / 发泡材料 (Plastics, foams)</td>
<td>O</td>
</tr>
<tr>
<td>电池 (Batteries)</td>
<td>O</td>
</tr>
</tbody>
</table>

O：表示在该部件的所有均质材料中，此类有毒有害物质的含量均小于 SJ/T11363-2006 标准所规定的限量。

O：Indicates the content of the toxic and hazardous substances at the homogeneous material level of the parts is below the limit defined in SJ/T 11363 2006 standard.

X：表示至少在该部件的某一均质材料中，此类有毒有害物质的含量超出 SJ/T11363-2006 标准规定的限量。

X：Indicates that the content of the toxic and hazardous substances in at least one of the homogeneous materials of the parts is above the limit defined in SJ/T 11363 2006 standard.
Other RoHS and REACH type Regulations

Harmonic will comply with RoHS and REACH type regulations evolving in other countries, if they become relevant to our products or in markets where we sell our products.

Waste Electrical and Electronic Equipment (WEEE)

European Parliament and the Council of the European Union’s WEEE Directive (2002/96/EC) came into force on August, 2005 and, were more recently amended in July, 2012. This directive encourages the reuse, recycling, and recovery of WEEE and to improve the environmental performance of all operators involved in the life cycle of electrical and electronic equipment, especially those dealing with WEEE. Harmonic ensures that all requirements for registration, reporting, design and data tracking are complied with to meet the objectives of the WEEE directive.

For more information, please visit WEEE directive page at official EU website.


Battery Directive

In September 2006, the European Union’s Directive 2006/66/EC (Battery Directive) came into force with an aim to prohibit the sale of batteries and accumulators containing hazardous substances and to set rules and promote collection, treatment, recycling and disposal of waste batteries and accumulators. This directive applies to spent batteries collected together with WEEE and requires their removal and separate collection. Once removed from WEEE, spent batteries are governed by the Battery Directive. Harmonic uses lithium batteries in its products and our responsibility under the Battery Directive is taken care of under our WEEE Take-Back program.

For more information, please visit Batteries and Accumulators directive page at official EU website.

http://ec.europa.eu/environment/waste/batteries/

Harmonic is committed to manufacturing environmentally safe products for the community, and will make reasonable efforts and required adjustments to its practices, if necessary, to comply with various environmental directives and industry initiatives on the elimination of hazardous substances, labeling, marking, certification and registration as required in markets where we sell our products.

Download Harmonic’s Environmental Compliance Statement at the following location:


WEEE Take-Back Request Program

In order to assist EU member states to preserve, protect and improve the quality of the environment, protect human health and utilize natural resources prudently and rationally, Harmonic strives to recycle in compliance with the WEEE Directive any of its products that cannot be re-used.

Harmonic’s customers should:

- Not discard equipment in household or office garbage
- Arrange proper recycling of unneeded equipment. For the take-back of Harmonic equipment, customers must:
  - Collect the information required to complete Harmonic’s WEEE Take-Back Request form
Appendix B Safety and Regulatory Compliance

Compliance with additional country specific environmental, safety and EMC standards:

- Complete and submit the online WEEE Take-Back Request form. Please note that forms must be fully completed in order to prevent process delays
- Receive instant online confirmation indicating the reference number
- Receive the End of Life (EOL) asset return authorization number and instruction for EOL asset return

Not ship EOL product to Harmonic without a Harmonic-provided EOL asset return authorization number

The crossed-out wheeled bin symbol on a Harmonic-branded commercial product indicates that the product should not be disposed of along with municipal waste, but invites our customers to return the product to us under Harmonic’s WEEE Take-Back program for product disposal.

Harmonic will pay for the cost of shipping and will provide a Certificate of Recycling or a Certificate of Destruction upon request. For more information on collection, reuse and recycling or to initiate the WEEE take-back process, please complete the form at [http://www.harmonicinc.com/webform/weee-takeback-request](http://www.harmonicinc.com/webform/weee-takeback-request) or contact Harmonic Technical Assistance Center (TAC) or email RMA team at rma.emea@harmonicinc.com.

Compliance with additional country specific environmental, safety and EMC standards:

In addition to above listed standards and compliance regulations, Harmonic products may also be compliant with other country specific environmental, safety and EMC requirements. Please contact Harmonic Compliance Team at regulatory.compliance@harmonicinc.com or your local sales representative for more information about compliance with particular country or standard.